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Preface 

Introduction 

Welcome to the Hi-Target Hi-Survey Road. This introduction describes how to use this product.

Experience Requirement  

In order to help you use the Hi-Target series’ products better, we suggest you carefully read the 

instructions. If you are unfamiliar with the products, please refer to http://www.hi-target.com.cn/ 

Tips for Safe Use 

 

Notice: The contents here are special operations and need your special 

attention. Please read them carefully.  

The contents here are very important. The wrong operation may damage the 

machine, lose data, break the system and endanger your safety. 

 

Exclusions  

Before using the product, please read these operating instructions carefully: they will help you to use it 

better. Hi-Target Surveying Instrument Co., Ltd will assume no responsibility if you fail to operate the 

product according to the instructions, or operate it wrongly due to misunderstanding the instructions. 

Hi-Target is committed to constantly perfecting product functions and performance, improving service 

quality and we reserve the right to change these operating instructions without notice.  

We have checked the contents of the instructions the software and hardware, without eliminating the 

possibility of error. The pictures in the operating instructions are for reference only. In the case of non-

conformity with products, the products shall prevail. 

Technology and Service 

If you have any technical issues, please refer to Hi-Target’s technology department for help

http://www.hi-target.com.cn/
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Relevant Information 

You can obtain this introduction by: 

1. Purchasing Hi-Target products: you will find this manual in the instrument container to guide you on 

operating the instrument. 

2. Logging onto the Hi-Target official website, download the electronic version introduction at 

Download center → Partners → Partner center. 

Advice 

If you have any comments and suggestions for this product, please email info@hi-target.com.cn. Your 

feedback will help us to improve the product and service. 
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Chapter 1 

Software Introduction 

This chapter contains:  

 

- Introduction 

- Features 

- Installation 

- Quick Start 

- General Collection 
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1.1 Introduction 

Hi-Survey Road is a measurement software with a high degree of accuracy on the Android system of 

Hi-Target. 

Hi-Survey Road should be run on Android 2.3.3 or above, it can be run on a Hi-Target professional 

measure controller, a general phone, tablet, and other Android devices. Just copy the Hi-Survey Road 

APK to the Android device. 

1.1.1 Hi-Survey Road 

Hi-Survey Road is designed for road surveying and staking with strong functions; it can be used for 

staking complex roads, combining road lines, and support three road algorithms (intersection, element, 

coordinate): cross-sections can be defined easily. The linear element method adopts the unified curve 

element model with rigorous theory, and the numerical integration algorithm is used to avoid the 

higher-order errors of traditional algorithms. Generally, the computing result can support all kinds of 

roads, common lines, and multi-type complex lines and connect receivers to measure online via Wi-Fi, 

Bluetooth, and networks. 

1.1.2 Road Function 

- Support for horizontal-section, vertical-section, cross-section, road-staking, slope-staking and visual 

cross-section collection. 

- Calculate line-staking point in real-time, support for adding stake over any mileage, mileage-

projecting in real-time, and displaying the mileage of staking points. 

- Direct and convenient guidance method of staking, with line-staking and mid-level measurements 

working at the same time.  

- The horizontal section line supports the common method (intersection, element, coordinate) and can 

freely define the line of any form. For example: interchange ramp. 

- The cross-section earthwork provides two methods: Mean Area method and Prism method to 

calculate the amount of excavation. 

- Supports multiple cross-section grade-change point-setting, the left and right slope can be edited into 

asymmetric type; it can also edit over-elevation and widening of a slope. 

- Supports DTM surface design, DTM surface-staking, and DTM earthwork calculation. 

1.2 Features 

1) Easy to Use 

- The more reasonable logic, clear and simple operation process and a friendly UI interface; 
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-Text and Graphic measuring interface in Detail Survey can be chosen by the user; 

-Simple design to give a big mapping screen; 

-Station option can be one-key set by configuration file; 

-The defined coordinate system selected by region, convenient to set coordinate parameters; 

-Supports many kinds of angle units, meets the operating habits and demands of business customers: 

good for globalization. 

2) Supports Operating Big Data 

-Supports big raster, vector data in .dxf, .td2, .shp format (geodetic coordinate and plan coordinate); 

-Raw data and coordinate data saved independently to make sure the data primitiveness and realize 

post-processing kinematic, it is more flexible in data storing and processing, and the antenna type and 

height of raw data can be changed, to make sure the data can be recovered (by resetting the 

coordinate parameters, antenna type, and height); 

-More complete antenna parameters management. 

3) Fashionable 

-The software and receiver firmware check the updates online automatically; 

- Hi-Target and profession news is real-time pushed; 

-Beautiful and fashionable interface; 

-Wonderful and rich visual and touch experience, help make users enjoy working. 

1.3 Installation 

1.3.1 Installation 

Copy the Hi-Survey Road program (.apk) to an Android device, click it to start installing, a Hi-Survey 

Road icon will appear on the desktop if the installation is successful.  

  

Figure 1-3-1 Hi-Survey Road 
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1.3.2 Starting Interface 

For the first time running the software, it will show the welcome pages of the software. Sliding left to 

enter the starting interface. The welcome pages will not be displayed in the next time (It can be viewed 

in the About interface). 

        

   Figure 1-3-2 Welcome Page (1)     Figure 1-3-3 Welcome Page (2) 

1.3.3 Start Instruction 

The first time the Hi-Survey Road software is installed, it will prompt you to create a new project, set 

the coordinate system, and connect the device to start the measurement. 

  

Figure 1-3-4 Start Instruction1 Figure 1-3-5 Start Instruction2 
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                             Figure 1-3-6 Start Instruction3             Figure 1-3-7 Start Instruction4                  Figure 1-3-8 Start Instruction5 

1.3.4 Main Interface  

There are 4 pages on the main interface: Project, Device, Survey, COGO (slide or press the Tab 

button to change the page). 

There are 3 themes of the main interface: List, GridView and Simple. The default theme of the UI 

interface is GridView. 

 

    

                                                             Figure 1-3-9 Device-Grid View                     Figure 1-3-10 Device-List 
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                           Figure 1-3-11 Device-Simple                    Figure 1-3-12 Device-More                   Figure 1-3-13 Survey-GridView 

        

                                 Figure 1-3-14 Survey-List                        Figure 1-3-15 Survey-Simple               Figure 1-3-16 Survey-More 

The module can be added and deleted in the simple theme. It also can be deleted and recovered in th

e grid view and list theme. Long press the module to delete it, and the deleted module can be recover

ed in Project → Configure → Module Recovery. 
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                                    Figure 1-3-17 Delete                               1-3-18 Module Restore                            Figure 1-3-19 Select 

The working directory path of Hi-Survey Road is the ZHD folder under the SD card. The project is 

under ZHD/Project/Road folder, and the specific sub-applications are stored in the corresponding 

projects.  

  

Figure 1-3-20 Project 

When starting a new measurement work, create a new project firstly, set the parameters - they are 

saved in the *.prj file; meanwhile, there will be a *.dam file with the same name of the project; the 

coordinate points, stake points, control points will be saved in the map folder. The structure of the new 

project (project name is Unnamed) is shown as the picture below. 

  

Figure 1-3-21 Road Work File 
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1.4 Quick Start 

This process is a simple solution that provides users who are the first time to use the software. The 

practiced users can ignore those steps. 

1.4.1 Create a Project 

1. Open Hi-Survey Road, the main interface of the software is as follows: 

  

Figure 1-4-1 Main Interface 

2. Create a new project. Click Project → Project Info to enter the project name and then click OK. 

Select a code template. If you open the Auto Enter Project Settings switch (which is turned on by 

 

 

 

 

 

Notice: 

1. If you create a new project when the controller does not have an external SD 

card, the project folder will automatically generate a * .bak back-up file 

2. When the controller has the external SD card, the back-up data will be saved in 

the ZHD-Bak folder. The specific project data is stored in the corresponding 

project folder, as shown like the picture below. 

        

Figure 1-3-22 Road Back-up 
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default) in the Project Settings → New Project, it will automatically jump to the Project Settings → 

System interface. If you click the Skip button, the software will select the PRESET_EN template by 

default. 

       

Figure 1-4-2 Project Info                      Figure 1-4-3 New Project                     Figure 1-4-4 Project Code 

3. You can also directly apply the Code List, Coordinate System (coordinate system is ticked by 

default) and Road File of the historical project after entering the project name. 

   

Figure 1-4-5 Template1                   Figure 1-4-6 Template2 

4. Project Settings: select the projection, set the source ellipsoid and projection parameters. 
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Figure 1-4-7 Coordinate System                     Figure 1-4-8 Projection                          Figure 1-4-9 Datum 

1.4.2 Set the Base 

1. Connect the device, click Device → Device Connection → Connect to select the serial number of 

the base station for Bluetooth connection. 

   

Figure 1-4-10 Device            Figure 1-4-11 Connect 
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Figure 1-4-12 Device Number      Figure 1-4-13 Disconnect 

2. Set the base station and receiver position, before setting the Datalink and Other. Tick Save Pos to 

save the coordinates of the base station, and then set the Correction Type, Elevation Mask, Data Link. 

You can also set Pos Frequency, Store GNSS Raw and others by clicking Advance Config. 

 

-Set the base location. 

If the base station is located at a known point and the conversion parameters are known, you can 

choose Set by Point, directly input or select the WGS-84 BLH coordinates of the point from point 

library, or open the conversion parameters in advance, enter the local NEZ coordinates, so that the 

base station takes the WGS-84 BLH coordinates of the point as the reference transmitting the 

differential data.  

     

Figure 1-4-14 Set Base1     Figure 1-4-15 Set Base2 

If the base station is set at an unknown point, choose Set by Average and set the average time. After 
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completing the data link and RTCM format settings, click Set in the upper right corner, the receiver will 

perform Average according to the set number of average times. Finally the average value will be the 

base station coordinates. 

If you tick Save Pos when you choose Set by average, you also need to input the Target H, Measure-

Type and Name.  

     

Figure 1-4-16 Set Base3     Figure 1-4-17 Set Base4 

3. Click Data Link, select the data link type and enter the relevant parameters. 

(for example, when transmitting data with the Hi-Target server, the relevant parameters need to be set. 

When the data link selects the Internal GSM, The Group Type can be selected By City Number or By 

Base Station SN. When the radio station is used for operation, the data link needs to select the 

Internal UHF or External Radio mode, and setting the radio channels.) 

     

Figure 1-4-18 Set Base5     Figure 1-4-19 Set Base6 
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Click Advanced Config to set Pos Frequency, Store GNSS Raw, etc. Then click Set in the upper right 

corner, and the software will prompt that the Base station is ready, do you want to set Rover now? 

  

Figure 1-4-20 Set Base7 

Check whether the differential light of the device is flashing regularly. When using the external radio 

station, the radio will flash once a second, if it is normal, it will prompt Base station is ready, do you 

want to set Rover now? 

Base position 

Datalink 

Radio mode is the traditional data link mode, and the built-in radio mode is taken as an example, to 

illustrate the introduction of radio station mode using simple steps. 

-Internal UHF: built-in radio. 

-Protocol: The radio protocol and baud rate (for example, HI-TARGET19200) of the rover should be 

consistent with the base. 

-Channel: 0 ~ 115 any number, but the rover station settings should be consistent with the base 

station. 
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Figure 1-4-21 Settings of Base 

(The data link parameters of the rover are consistent with the base, so the rover can receive the 

correction signal from the base.) 

Parameter settings 

After setting the relevant parameters of the datalink, you also need to set the Correction Type, 

Elevation Mask, and Pos Frequency, Store GNSS Raw, Power (High/Middle/Low), and Frequency List 

in Advance Config. 

     

Figure 1-4-22 Set Base5     Figure 1-4-23 Set Base6 

 

 

Notice: 

The parameters of the base station must be consistent with the rover station settings. 
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After the parameter is set, click Set and the device will prompt UHF Base with voice, the device light 

will flash twice every second, indicating that the base station is set up successfully and sending the 

differential data. 

When the green light flashes once every second (twice a second in power-saving mode) and the radio 

red light flashes once every second, indicating that the base station is successfully operating, and 

transmitting the signal. If the signal lights do not flash, you can restart the receiver device and re-

operate once again. 

  

Figure 1-4-24 Set Prompt 

1.4.3 Set the Rover 

Connect to the rover by Bluetooth, and confirm that the rover data link and other parameters are 

consistent with the base station. The setting of the rover station is the same as that of the base station. 

The data link parameters of the rover station must be the same as the base station, to receive 

differential data. Then click Set and the device will do a voice prompt UHF Rover. Wait until it shows 

RTK Fixed, and then start the measurement. 



    
Hi-Survey Road User Manual 

 

18 

  

Figure 1-4-25 Set Rover 

1.4.4 Parameter Calculation 

Firstly, set up the control point library in Point Library → Control Point to add control points, enter the 

name and the corresponding coordinates by manual input, Real-Time Collection, point library or map 

selection, and then click OK. 

   

Figure 1-4-26 Point Library   Figure 1-4-27 Control Point  Figure 1-4-28 Edit Point 

Click Parameter Calculation, select Plane + Height Fitting type and Constant Vertical Offset in Height 

(the Height can be selected as Plane Fitting when there are three points above), and then add point 

pairs, select the point as the source point, enter the corresponding control point coordinate in the 

target point, then click Save. 
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Figure 1-4-29 Parameters Calculation   Figure 1-4-30 Add Point 

     

Figure 1-4-31 Save Point       Figure 1-4-32 Result 

After adding more than two points, click Calculate, it will display the calculated Plane + Height Fitting 

results, and mainly to check the rotation and scale. The result of the plane translation is generally 

smaller in the north and east, the rotation is about zero, the scale is between 0.9999 and 1.0000 (in 

general, the closer to 1, the better of the scale), the smaller the plane and elevation residual is, the 

better the result. Click Apply and the software will automatically use the new parameters to update the 

coordinate point library. 

1.4.5 Detail Survey 

In the Detail Survey interface, start the collection when getting fixed. After the rover station is set on 

the unknown point, you can press the collection icon  and enter the Name, Target H and Target-H 

type. Then press OK to record the point. 
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Figure 1-4-33 Detail Survey      Figure 1-4-34 Save Point 

1.4.6 Stake Out 

Click Stake Points to enter the point staking-out interface and click the  button to select the staked-

out point, according to the direction, distance, and tips used to find the staked-out points. There is a 

process to get the current point (blue arrow) close to the target point (a circle with cross sign). The 

staking circle will then turn green, indicating that you are close to the staked point. The staking-out 

circle turns red when it is finished and meets the precision parameters. There is a small red flag for the 

staked points. 

In the process of staking-out, you can also collect detail points, by the Store  on the interface or 

store key on the controller. 

     

Figure 1-4-35 Stake Points1        Figure 1-4-36 Stake Points2 
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1.4.7 Data Transfer 

In the Data Transfer interface, select Raw Data, and select the Exchange Types as Export, select the 

corresponding format export or User-defined export, input the file name, select the file save the path, 

and then click OK to export data. If it’s User-defined export, after clicking OK, you can enter the 

custom format settings to select export content, then click OK to export the data. You can set and 

save the Name, Export Content, and Supported Fields when you choose to export User-defined (*.csv) 

and User-defined (*.txt). 

  

       

                                                                 Figure1-4-37 Data Transfer                            Figure 1-4-38 Export  

       

                              1-4-39 Custom Format                       Figure 1-4-40 Template Manager                Figure 1-4-41 Add Template 
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1.4.8 Connect the Controller to Download Data 

Connect the controller to the computer with the USB data cable. Pull down the hidden window of the 

controller to choose Media Device (MTP). 

 

   Figure 1-4-42 Transfer by USB 

Find the path to export the data file on the controller (default: ZHD\Out), copy it to the computer, and 

then the RTK survey is finished.  

 

Figure 1-4-43 Result 

1.5 General Collection 

There are four common ways to get the coordinates: Average, Select Point in Library, Select point on 

map, Real-time Collection. 
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Notice: When using the controller for data collection, it supports shortcut key 

operation. The shortcut keys are only supported for detailed survey graphic 

collection. To avoid conflict, there are no shortcut keys in the text interface. 

Button 1：  Zoom In              Button 2：  Zoom Out 

Button 3：  Zoom center       Button 4：  Zoom All 

Button 5：  Culture Create    Button 6：  Auto Collection 

Button 7： Average Survey   Button 8：  Indirect Survey 

                Button *：Open the configure  Button Shift： text-map 

1.5.1 Average 

Get the coordinate in single status by average, 10 times by default, including Average, Weighted 

average, Window average, Median filter. 

   

Figure 1-5-1 Average Text                        Figure 1-5-2 Average Graph 
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Figure 1-5-3 Average Parameters                      Figure 1-5-4 Average Method 

1.5.2 Select Point from Library 

The points with NEZ coord can be selected in Coord Point, Stake Point, Control Point, Mapping Data, 

and Cross-section Point library. The points with BLH coord can be selected in Raw Data, Control 

Point , Mapping Data, and Cross-section Point library. 

 

  

Figure 1-5-5 Coord Point 

1.5.3 Select Point on Map 

Click  or  to enter the select point on map mode, click  to frame-to-select the points and click   

for staking points. Click  again to exit the map selection. Click  to click-to-select points, click  

again to exit the mode, then click OK to complete the selection. 
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Figure 1-5-6 Select Point      Figure 1-5-7 Map Selected   Figure 1-5-8 Line Selected 

1.5.4 Real-Time Collection 

Real-Time Collection refers to real-time data collection through the receiver. 

  

Figure 1-5-9 Real-Time Collection 

 

 

Notice: 

1. During real-time collection, select Save to point library (save to Point Library and 

Raw Data library), then click OK for collection. 

2. Connect to devices supporting electronic bubble, they will display the electronic 

bubble view in the Device Collection interface, devices that do not support the 

electronic bubble will not display. 
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Chapter 2 
Project 

This chapter contains:  

- Project Info 

- Project Settings 

- Coordinate System 

- Parameters Calculation 

- Point Library 

- Raw Data 

- Mapping Data 

- Data Transfer 

- PPK 

- Email 

- Project Config 

- Code list 

- Culture Library 

- Software Settings 

- About 
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2.1 Project Info 

Click Project Info on the main interface to manage the project, checking the project information, which 

includes name, points, stakeout points, projection, time, the available space of the storage and history 

project. You can make some operations with the project, including create, open, delete, recover, 

export, view, edit, and add attributes. 

     

Figure 2-1-1 Main Interface    Figure 2-1-2 Project Info  

- OK: Enter a new project name, and the Template bar is displayed below. Click to select the Code 

List, Coordinate System, and Road File of other projects (if Road File is ticked, the new project will 

copy the road data in the selected item to the project's Data/Roadfile). 

 

After inputting the project name, click OK to get a new project and automatically open it for the current 

project. If there is already a project with the same name, click OK to open it; or create a new project as 

the current project. The old project can be opened or deleted by long pressing. 

     

Figure 2-1-3 Project Sort1                         Figure 2-1-4 Project Sort2 

 



    
Hi-Survey Road User Manual 

 

28 

 

- Attribute: Save the title and content of the current project. Long press a project to select Properties in 

the toolbar. The attribute length is not limited, nor supported for writing and deleting in batches; 

attribute titles can be the same when adding attribute names, you can enter different values; the 

attribute name cannot be null, it needs to be digits, Chinese or English characters. 

    

Figure 2-1-5 Enter Attribute      Figure 2-1-6 Edit        Figure 2-1-7 Add Attribute 

- Delete: Delete the selected project. The project can be deleted directly or back-up delete (similar to 

recycle bin), providing the user with a remedial measure after mis-operation. (back-up delete is 

compressing project and then deleting the project). The compressed file is stored at ZHD / Project / 

ROAD directory). 

  

     Figure 2-1-8 Delete     Figure 2-1-9 Prompt to Delete 

- Restore: The Raw Data, Coordinate Parameters, and Project Info can be restored from the ZHD-Bak 

folder of the external SD card of the work folder. When creating a project or collecting the points, the 

raw data file, dam or QR code coordinate parameters file, project information file, and cross-section 

points library in the same project name folder will be backed up on the external SD card ZHD-Bak 

folder. The Restore function can only be used when installing an external SD card. 
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Figure 2-1-10 Restore List   Figure 2-1-11 Back-up Folder 

 

 

 

Notice: 

1. If there is no external SD card, it will prompt every time you start the Hi-Survey 

Road. 

2. The back-up function requires that the controller version must be in V1.0.2 and 

above. 

When you restore the data, long press the project to select, press the selected project again to cancel. 

Click Select All/Cancel All to select all projects or cancel. After selecting, click Start Restore to recover. 

 

Figure 2-1-12 Select All or Cancel All 

The recovered project will be saved at Project Info → Previous Projects. If there is a previous project 

with the same name as the restored project, it will add _1 at the end of the recovered project name. 
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              Figure 2-1-13 Same Name         Figure 2-1-14 the Recovered File 

-Export: Export the current project reports in *.txt format, *.html format of Project Report or Mapping 

Point Report in *.html format. 

                 

Figure 2-1-15 Export Format        Figure 2-1-16 Export 
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2.2 Project Settings 

2.2.1 New Project 

 

Figure 2-2-1 New Project 

-Auto Enter Project Settings: After opening, it will automatically go to Project Settings, and show the 

System interface to set coordinates. 

-Use Last Localization Params: After opening, the current project will use the same coordinate 

parameters as the last project (including the transformation model and parameters of plane conversion 

and elevation fitting). 

-Use Last Control Point File: After opening, the control point of the last project will be copied to the 

current project. 

-Define Project Attributes: Set the note of a new project. It will automatically go to the attribute-

inputting interface to edit the corresponding attribute, after defining the project’s attribute. 

2.2.2 System 

In System interface, coordinate system parameters can be set with the dam file, QR code or in Coord 

Sys Management. If coordinate parameters are changed, the coordinate point library will be updated 

too. 

Project coordinate parameters include Coordinate System, Framework Shifting, Framework Shifting 

Info, Framework Calibration, and Framework Calibration Info. Data Management is used for external 

data management. 
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Figure 2-2-2 System Figure 2-2-3 System  

1. Coordinate Parameters - Dam File Loading 

Each software project corresponds to a separate *.dam file, there will be a new Dam file (the same 

name as the project) when you create a project. In the Project Settings →System interface, the user 

clicks to load a dam file, getting the coordinate parameter of the existing project applied to the 

current project: the coordinate point library will be updated at the same time. 

Figure 2-2-4 Add Dam File 

2. Coordinate Parameters - QR Code 

In the Project Settings → System interface, click  to enter the QR code scanning interface, to get 

coordinate parameters from the QR code, and then create, Encrypt, share and Save the QR code. 
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Figure 2-2-5 Scan QR Code 

Click My QR Code and it will create a QR code of the current project coordinate parameters; the user 

can encrypt, share and save it. The scanned encrypted QR code only can be used, it cannot be 

viewed and edited. 

- Encrypt: The user can choose to encrypt the coordinate parameters first, and then re-generate the 

QR code; the encrypted QR code can be shared and saved; encrypted parameters are not visible and 

cannot be edited, only called. 

- Share: The QR code can be shared by third-party software to other customers; 

- Save: The QR code can be saved as a picture in the controller. If there is a file with the same name 

under the save path, you can tick the coverage or enter a new filename. 

    

Figure 2-2-6 QR Code       Figure 2-2-7 Encrypt 
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Figure 2-2-8 Share         Figure 2-2-9 Save 

    

Figure 2-2-10 Encrypt Prompt     Figure 2-2-11 Encrypted Projection 

3. Coordinate Parameters - Coord Sys Management 
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Figure 2-2-12 Coord Sys Management 

The software coordinate transformation module is CoordLib module, which has been verified for many 

years and provides practical and full coordinate calculation ability. In Projection, it includes Gaussian, 

Mercator, Lambert projection, etc. In Datum conversion, it provides Bursa-Wolf Transformation, 

Molodensky, Ten Params, and others. In Plane conversion, it provides 2D Helbert, TGO, Planar 

Transformation Grid, FreeSurvey, Polynomial Fitting and other conversion methods. In Height Fitting 

conversion, it provides Mathematical Models, TGO, FreeSurvey and Geoid-Ellipsoid Separation Grid. 

In the Project Settings → System interface, users can click  to enter the Coord Sys Management 

interface. Common coordinate systems can be added to system lists for easy use. 

   

Figure 2-2-13 Pre-defined List     Figure 2-2-14 Pre-defined Coord 

- Pre-defined: Support for loading the Pre-defined coordinate systems, which are classified by 

continent and country, for convenient selection. 

- User Defined: Add User Defined coordinate system according to the local situation. 
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Figure 2-2-15 Select Coord      Figure 2-2-16 Apply Coord 

- Delete/Edit: Long press the coordinate system on a Pre-defined List to delete and edit. Editing 

coordinate system parameters in the system list do not affect the coordinate system parameters in the 

project unless you click the Apply after editing the coordinate system. 

 

- Apply: Update the projection parameters used by the project. There will pop up a dialog to prompt 

whether the selected coordinate system should be applied to the current project. Click OK and the 

parameters are used successfully. The software converts the WGS84 geodetic coordinate BLH, 

measured by the receiver, to the plane coordinate NEZ of the selected coordinate system parameters. 

 

4. Coordinate System 

Click Coordinate System to go to the Coord Sys Management interface; you can edit the current 

project coordinate parameters and the created coordinate system is just used for the current project. 

Whether to update the parameters to the corresponding projection list can be chosen when saving. If 

OK, coordinate system parameters will be applied to the project according to current settings; if you 

select Cancel, coordinate system parameters will not be updated. 

 

Figure 2-2-17 Warning 
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5. Framework Shifting 

For computing the horizontal and vertical translation between two coordinate systems.  

The user can transfer the collected GNSS coordinates to local NEZ by one point. For example, give 

the top-left point as (0, 0, 0), then other points are translated to an independent coordinate system, 

according to the point. Generally, the translation value is too large, if you translate BLH and NEZ, 

there will be a big projection error, so after framework-shifting, the saved BLH is still the original BLH, 

while the NEZ is the local one. 

Compute 

- Compute: Compute the dN, dE, dZ from the current point and known point.  

First: Users need to obtain the source point (the current point) coordinates. 

Second: and the coordinates of the known point first. The known point can be input directly or selected 

from the library. 

The source point can be got from average collection , real-time collection  , library  , and map . 

   

Figure 2-2-18 Compute               Figure 2-2-19 Result 

Result 

- Apply: Check it to apply the correct value to the project. 

- Load: Load the existing translation file. 

- Save as: Save the translation parameters as a .txt file, so it can be used by other projects. 

- OK: Save the translation parameters and update the project. 

The calculated point translation parameter can be selected in the Project Settings→ System interface. 
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Figure 2-2-20 Framework Shifting 

6. Framework Calibration 

This is for computing the horizontal and vertical translation between two coordinate systems, generally 

used for situations as below: 

Only one BJ-54, XIAN-80 point or only one point of a coordinate system which is a little rotated from 

WGS-84. Set the Base, then take the Rover to a known point, click Framework Calibration → 

Compute, collect the NEZ coordinate, input the known point, click Compute to get the Correction dN, 

dE, dZ of the known point and source point, press Apply to apply the parameters and the collected 

points will be corrected to the coordinate system of the known point. 

You created a project, it worked, but you don’t want to set the base at the same place, so now you can 

set the base at any place, by using the Framework Calibration function. Open the first-used project to 

a known point to correct the coordinates. The correction method is the same as the first situation. 

 

- Compute: Calculate the coordinate correction dN, dE, dZ according to the current point and the 

known point. Users need to obtain the source point (the current point) coordinates and the coordinates 

of the known point first. The known points can be entered in three ways: select from the point library 

, select from the map  or enter the coordinates directly. Select / : the resulting known point 

coordinates will correspond to the NEZ/BLH format. 
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Figure 2-2-21 Compute                          Figure 2-2-22 Result1                                 Figure 2-2-23 Result2 

- Apply: Apply the calculated correction to the project. 

- OK: Select Apply after computing, and click OK to apply the framework calculation parameters 

(notice: it is different from the OK that appears after pressing the return key). 

- Cancel/OK: Select Apply, and click the return key to pop up the prompt dialog, click Cancel to return 

the framework calculation parameters; click OK to give up modifying the parameters. 

- Load: Load the stored parameters. 

- Save as: Store the calculated calibration parameters. 

The calculated calibration parameters can be selected in the Project Settings → System interface. 

 

 

Figure 2-2-24 Framework Calibration 

After using the framework calculation parameter to collect points, the parameters are automatically 

recorded in the raw data of each point, so that the geodetic coordinates of WGS-84 coordinates are 

restored when errors occur. In the Raw Data → Edit RawData interface, the framework calculation 

parameters of the original data can be viewed. 
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7. External Data Management 

Enter External data management, click Add to load layer file *.td2, *.dxf and *.shp (when the external 

data format is incorrect, the file can’t be imported) as the map background. Support for arc, circle and 

spiral curve. The imported DXF can be viewed on the map in colors. The color can be switched in 

Configuration → Display → Display color. Switch on to display all kinds of colors in *.dxf; switch off to 

display the default black. After loading point, line, and polygon in *.td2 format, the raster layer is 

always at the bottom, followed by polygon, line, and point. 

    

Figure 2-2-25 External Data Management   Figure 2-2-26 External data 

    

 Figure 2-2-27 Add External Data           Figure 2-2-28 Edit External Data 
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Figure 2-2-29 Display External Data 

8. GIS Map Data Management 

When the third map is the GIS map, the software will display Layer Management and Network Map 

Service Manager. The external data will then create the related layer and display the survey interface. 

The user can add the file to the layer management. The supported file format contains DXF, SHP, 

GPX, KML, KMZ, MIF, DWG, TIF. 

       

Figure 2-2-30 External Data Format Figure 2-2-31 External Data Path 

 

 

Notice: 

 External data management: opens all layers by default when adding the base map. 

Click the icon in front of the list, to switch layer visibility (on or off), which corresponds 

to that the base map of measurement interface display or not. Long press the added 

layer to open/close/delete the operation. 
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The software can select the WMS /WMTS service to load the online map service in addition to the 

general files in the Network Map Service Management. You can do the overlay operation when the 

WMS and WMTS are both in the same coordinate system. 

     

Figure 2-2-32 WMS Manager1            Figure 2-2-33 WMS Manager2 

9. Code Data Management 

Click Code Data Management to set the code template. The code contains the point, line, and polygon. 

You can create a Group, and Add, Edit and Delete them. 

      

Figure 2-2-34 CodeData Management1   Figure 2-2-35 CodeData Management2 

Before creating the code template, you should determine the type (point, line, and polygon), and then 

determine the group of the related type. Finally, add, edit and delete the operation of the name, code, 

color and style of this group. 

-Add: Setting the name, code, group, color, and style. Click OK to create the new code. 
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Figure 2-2-36 Code Info1                   Figure 2-2-37 Code Info2 

    

Figure 2-2-38 Code Style                   Figure 2-2-39 Code Info3 

-Edit: Editing the existed code. It is similar to the Add function. But it can’t edit the name of code. 
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Figure 2-2-40 Code Info4 

-Delete: Delete the selected code (It can be deleted by batches). 

 

 

Figure 2-2-41 Code Delete 

Click Group to Add, Edit and Delete the group. 
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Figure 2-2-42 Group Manage1            Figure 2-2-43 Group Manage2 

      

Figure 2-2-44 Group Manage3          Figure 2-2-45 Group Manage4 

2.2.3 Option 

Do some other configurations, including Angle, Distance, Apply Unit to Data Output, Time Stamp, 

Store GNSS Precision and Auto Load Last Road File. 
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Figure 2-2-46 Option 

- Angle: Confirm the angle unit, including DMS, Gons and mil. 
- Distance: Confirm the distance unit, including m, Foot and U.S.Foot. 
- Apply Unit to Data Output: Export data according to the set angle and distance format. 
- Time Stamp: Record the real-time of each collecting point. 
- Store GNSS Precision: Record the precision of each point collection. 

2.3 Coordinate System 

There are 3 methods to get into the coordinate system setting interface: 

1. Main Interface Project → Coordinate System; 
2. Main Interface Project → Project Settings → System → Coordinate System; 
3. Main Interface Project → Project Settings → System → Coord Sys Management, long press the 

Coordinate system on the list to edit and enter the interface. Click Save after setting all the parameters, 

the system will prompt whether to update the parameters to the corresponding projection list, click OK 

to finish setting parameters. 

           

                                    Figure 2-3-1 System                                Figure 2-3-2 Projection                              Figure 2-3-3 Save 
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2.3.1 Projection 

Frequently-used projections built-in: Gauss, Mercator, Lambert, etc. (notice: when using  
Gauss-3 or Gauss-6, the device can automatically compute the origin longitude after  
It is connected, other custom projections are not supported. 

     

Figure 2-3-4 Obtain Origin Longitude        Figure 2-3-5 Other Parameters 

 

 

 

2.3.2 Datum 

Users can set source ellipsoid, local ellipsoid and datum transfer model (including Bursa-Wolf 

Transformation, Molodensky, One-touch, Polynomial Regression and Ten Params). 

 

 

Notice: 

All the tabs in the software can be swiped by gestures, or click the tab page title bar to 

switch the page and make the tab page title bar automatically centered. 

 

 

Notice: 

1. Coordinate system-Projection-Zone+ to set whether to add the number. 

2. After opening Zone+, all coordinate E input boxes will be carried out with the 

number detection, if the number does not match, the input box will display the red font 

indicating that the number does not match the data confirmation. 
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Figure 2-3-6 Datum Settings      Figure 2-3-7 Datum Model 

- Save: Click Save to save the parameters in a dam file after settings, the set parameters are invalid 

without clicking Save. 

- Source Ellipsoid: Generally using WGS-84, a means semi-major axis, 1/f means the inverse of 

flattening, and there are many frequently-used ellipsoids built-in. 

- Local Ellipsoid: Local used ellipsoid. 

 

 

 

Notice: 

1. Customize the ellipsoid:  

2. Edit the name of the source ellipsoid or target ellipsoid, long axis an (m) and the 

inverse of flattening (1/f) into the two lines to be input, the user input, the 

corresponding parameters and save it. Then the custom ellipsoid parameters will be 

saved in the file ZHD / Ellipse.csv. 
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Figure 2-3-8 Datum-Source Ellipsoid       Figure 2-3-9 Datum-Local Ellipsoid 

1. Bursa-Wolf 

Including translation, rotation, scale parameters between two ellipsoids, the rotating angle should be 

very small. Bursa-Wolf needs at least three points to compute, it’s suitable for conversion between 

different ellipsoidal coordinates. 

2. Molodensky 

A simplified model of Bursa-Wolf, only space translation parameters, it is a low accuracy mode and 

just needs one point to compute: suitable for the transformation of WGS-84 to a national coordinate 

system. 

3. Polynomial Regression 

Express the transfer relations of each space vector between two ellipsoids by a polynomial. 

2.3.3 Plan 

Include 2D Helmert, TGO, Planar Transformation Grid, FreeSurvey, and Polynomial Fitting. 
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Figure 2-3-10 Plan Method 

1. 2D Helmert 
Includes translation, rotation, and scale parameters between two plane coordinate systems, it just 
needs two points in any coordinate system to compute. 

 

Figure 2-3-11 Plan Configure 

2. TGO 

A plane coordinate system transfer method of TGO software, more North Origin, East Origin than 2D 

Helmert. 

3. Planar Transformation Grid 

Select an existing grid file to transfer WGS-84 to the grid coordinate. The grid file (*.grd) needs to be 

copied to the GeoPath folder in ZHD. 

4. FreeSurvey 

A transfer method of THALES Company, more North Origin, East Origin than 2D Helmert. 
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5. Polynomial Fitting 

Transfer the place by a polynomial model. In some projects, when the known points involved in 

calculating plane transformation and elevation fitting parameters are different points, use 2D Helmert 

and Height Fitting to individually calculate parameters. 

The 2D Helmert is used in the calculation part of the plane, and the method is similar to the datum 

conversion model. 

- When using four-parameters, the scale parameter is generally very close to 1, about 1.0000x or 

0.9999x. 

- When using three-parameters, the parameters generally need to be less than 120. 

- When using seven-parameters, the parameters are required to be smaller, preferably less than 1000. 

2.3.4 Height 

Include Mathematical Models, TGO, Geoid-Ellipsoid Separation Grid, and FreeSurvey. 

1. Mathematical Models 

- Constant Vertical Offset: Translation needs one starting point at least.  

- Planar Fitting: Needs three starting points at least. 

- Quadratic Surface: Needs six starting points at least. 

- Zonal: Needs three starting points at least. 

2. TGO 

A height transfer model includes five parameters: H0 (constant adjustment), Kb (north slope), Kl (east 

slope), North Origin and East Origin. 

3. Geoid-Ellipsoid Separation Grid 

Select an existing grid file to fit height. The grid file (*.grd) needs to be copied to the GeoPath folder in 

the ZHD path. 

4. FreeSurvey 

A transfer method includes five parameters: H0 (constant), Kb (north slope), Kl (east slope), B0 (origin 

latitude) and L0 (origin longitude).  
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                                      Figure 2-3-12 Height                         Figure 2-3-13 Parameters                           Figure 2-3-14 Result 

The calculation of the individual height-fitting parameters includes Constant Vertical Offset, Planar 

Fitting, Quadratic Surface, and Zonal, which correspondingly require one, three, six and three starting 

points, at least, to be used. Enter the Name, N, E, the original H and the target H of the point involved 

in the height fitting parameter calculation, then click Add. After adding all points, click Compute to see 

the residual values, the maximum residual value is generally required to be less than 3 cm. If the value 

meets the requirements, click Apply. If not, click Cancel, remove the points with a big error and have a 

re-solution.  

Set the height fitting mode: 

- Constant Vertical Offset refers to the receiver measured height plus a fixed constant as the use of 

elevation: the constant can be negative. 

- Planar Fitting refers to the height anomaly corresponding to multiple leveling points to produce an 

optimal fitting plane. When the plane is parallel to the horizontal plane, the planar fitting is equal to the 

constant vertical offset. 

- Quadratic Surface refers to the height anomaly corresponding to multiple leveling points to produce 

an optimal fitting paraboloid. Quadratic Surface is relatively high for the starting data, and if the fitting 

is too poor, it may cause a height correction value divergence in the work area. 

- Zonal: two known benchmarks to create a virtual mark, used to make the planar fitting. 

- Grid Fitting needs to select the grid fitting file, it supports Trimble (ggf), HI-Target (zgf), Geoid99 (bin) 

formats, compatible with the egm-96 model. Grid fitting files are often large, the reading may take 

some time, please be patient. Grid Fitting is rarely used. If Grid Fitting and the other four kinds of 

elevation method are selected at the same time, Grid Fitting will be taken first, and then the other 

fittings. 
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Figure 2-3-15 Height Fitting Plane Simulation 

Notice: When importing parameters from the computer, the parameters can be edited into * .txt, 

parameter formats are as follows: 

Table 2-3-1 Built-in Network Parameter Settings 

Four-parameters Seven-parameters 

// The first line is skipped and just written 

DX:9847.12172733449 

DY:-200265.017483647 

R:0.0162640727776042 

m:0.000162436743812444 

// The first line is skipped and just written 

DX:511.755584317388 

DY:-674.430387295999 

DZ:-656.294939762613 

RX:-0.000126577363609681 

RY:-1.44916763174951E-05 

RZ:0.0261524898234588 

m:0.000168070284370492 

 

2.3.5 Grid 

Open the Grid needed and select the grid file. The grid file (*.grd) needs to be copied to the GeoPath 

folder in ZHD/GeoPath. 
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   Figure 2-3-16 Plane Grid              Figure 2-3-17 Plane Grid File 

2.3.6 Option 

To apply the parameters computed by HD-Power to Hi-Survey Road, just input the parameters, select 

Simplified in Helmert Formula and the first in 2nd Eccentricity Formula. 

- Encrypt: To display the file encryption, the settings cannot be changed; if the dam parameter file is 

encrypted, you can see if the coordinate system date is expired. 

- Plane Correction Grid: Bilinear Interpolation/Dual-quadratic Spline Interpolation. The default is dual-

quadratic spline interpolation. 

- Plane Correction Grid: It is hidden by default, and it can be seen only if the model in the Plane 

interface is either Planar Transformation Grid or the NE Grid or NEZ Grid in Plane Grid interface is 

opened.  

- Range: You can set the working range of the coordinate system. It contains Lat Limit and Lon Limit. 

The default is closed. After changing the coordinate system or connecting the device, if the current 

position is not located in the range, there will be a prompt that Current position is out of the valid area 

of the coordinate system. 
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Figure 2-3-18 Range1               Figure 2-3-19 Range2 

After modifying the values above, click Save, the software will modify the dam file under the current 

project, with the same name as the project; if the reference ellipsoid has been transformed, the 

coordinates will change. 

2.4 Parameters Calculation 

This function is for computing the transfer relation between two coordinate systems, including Bursa-

wolf Transformation, Modensky, Plane + Height Fitting, 2D Helmert Transformation, Height Fitting and 

One Touch. 

     

                                                      Figure 2-4-1 Parameters Calculation                   Figure 2-4-2 Add Point 

- Add: Add the source point and local point; the source point can be input from manual, Real-Time 

Collection, library and selecting on map (BLH by default), the local point can be input from manual and 

library. The single or average collection is used for parameter calculation and data storage is 

supported (save to the Coord Point and Raw Data). After input, click Save. If you need to manipulate 

the existing point information long press it to edit or delete. 
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In addition, the points list will not display the point that has been added. 

   

                                  Figure 2-4-3 Add Points1                         Figure 2-4-4 Add Points2                        Figure 2-4-5 Add Points3 

- Open: Support for Point pairs (*.txt), Carlson Loc File (*.loc), User-defined (*.txt). 

- Save: Save the point pairs coordinate information, support for Point pairs (*.txt) and User-defined 

(*.txt). The angle format and exported file can be set in User-defined (*.txt) 

- Compute: Compute the transfer parameters from source point to local point, it will compute the 

parameters and HRMS, VRMS of each point (HRMS: the horizontal RMS of the current point; VRMS: 

the vertical RMS of the current point). 

 

 

 

 

 

 

 

Figure 2-4-6 HRMS and VRMS 

- Apply: Apply to corresponding coordinate parameters, and the result will be updated to the Coord 

point library. 

- Cancel: Cancel the parameter computing result and go back to the calculation interface. 
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Figure 2-4-7 Edit Point            Figure 2-4-8 Result 

      

                                                          Figure 2-4-9 Plan + Height Fitting                    Figure 2-4-10 Add Point 

The coordinate information input of point pairs by Plane + Height Fitting calculation can be set with 

specific types: 

- Tick Plane: Use the plane coordinate NE of the point. 

- Tick Height: Use the elevation coordinate Z of the point. 

- Tick Plane and Height: Use the plane coordinate NE and elevation coordinate Z of the point, to 

compute plane and height fitting. 

The color description of point pairs in Plane + Height Fitting: 

- Blue: Use plane coordinate information of point pairs only. 

- Yellow: Use elevation coordinate information of point pairs only. 

- Green: Use plane and elevation coordinate information of point pairs. 
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2.5 Point Library 

All of the coordinate point, stake point, and control point data will be saved here, including Name, N, E, 

Z, and Description. The list can be viewed by the left and right slipping. You can search and add 

points, or change the display settings. Long press to enter select mode, tick  to select all/ cancel all; 

the selected points can be deleted or edited, you can delete many points, but only edit one point. 

     

Figure 2-5-1 Coord Point                    Figure 2-5-2 Coord Point 

 

 

 

 

Notice: 

1. From the Project Settings → System → Coord Sys Management, enter the Edit or 

Define Project Attributes coordinate parameter interface to do the parameter 

calculation, which is the calculation for parameters’ conversion corresponding to 

current custom or edited coordinate system type (you can’t change the parameter 

calculation type); 

2. From the Project → Parameter calculation or Project → Coordinate system 

→Parameter calculation or Project → Project Setting → System → Parameter 

calculation to calculate the current project coordinate conversion parameters. The 

parameters’ calculation type can be selected independently, and the default is the 

Plane + Height Fitting. The height-fitting type is the currently selected type for 

parameter fitting by default. 

 

 

Notice: 
1. In the Coord Point and Raw Data, the coordinate point list is a positive sequence 

display, the latest collection points shown in the last. 

2. Coord Point - only for viewing, showing and editing the description, it does not allow 

add or delete. 
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- New: Create the new stakeout document in the same project. Click Stake Point, the current list will 

be cleared, at the same time, the file system will be in a fixed file directory (map folder under project) 

new a blank Stake Point as the current staking points file. 

- Open: Open other stakeout documents at the same project; if you need to open the A project 

stakeout point, you must first copy the *.td2 and *.tdb file of A to the same project directory. 

- Search: Search the corresponding point by name and description. 

- Set: Set the NEZ display order of the coordinate points, the decimal number of the coordinates, and 

the number of coordinate points 

 

Figure 2-5-3 Display Settings 

- Upload: Upload raw data to the private cloud. 

- Process: Apply the current parameters to point library and get the result.  

-Tick Use coordinate system of the current project, the project coord system is used by default, do not 

tick Use coordinate system of the current project if you need to update the coordinate system, just go 

to Coord Sys Management to set it.  

- Average points: Long press the Average points, then click Average Points to check the selected data 

information. Reminder: if you need to save the average data, you will need to open the Store Average 

Points button in the Configuration → Data. 

- Batch: Support to add numerous stake and control points from the point library. 

- Add: Add coord point information, including name, coordinate and description; the coordinate can be 

from the real-time collection , select point  and select on the map . 

- Edit: Only edits description of coord points. All data of the stake point and control point can be edited. 

You can edit the point information. It contains Name, Groudcode, Station, Target H, H type and 

Antenna type, etc. 
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- Delete: Delete the selected stake point and control point; points can be deleted en asse, or tick  in 

front of a name to select all to delete.  

     

Figure 2-5-4 Delete                            Figure 2-5-5 Delete All 

 

2.6 Raw Data 

Raw Data is to record BLH, Target H RMSE and description under WGS-84 ellipsoid collection, it can 

be transferred to get plane coordinates by using the coordinate transfer system. 

 

 

Notice: 

1. Edit operations can only choose one edit at a time. 

2. Edit and Delete will be displayed after long press the point. 

 

 

Notice: 

Long press to enter the selection mode, click to select multiple points, check the  

button to select the all / cancel all operation; you can delete one or more selected 

points, but each time only one point to edit. 
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Figure 2-6-1 Coord Point                           Figure 2-6-2 Coord Point 

- New: Create a raw data file (*.raw). 

- Open: Open an existing raw data file. 

- Search: Search the coordinate point by name or description. 

- Edit: Edit the raw data point name, code, station, target height, height type, and antenna type; it 

supports batch edit; the corresponding coordinate point name will be changed after editing raw data. 

View other information of point, including solution type, coordinate information, number of average, 

difference ages, PDOP, satellite, the recording time, station coordinates, the vertical Angle, azimuth of 

tilt vector and points calibration information, etc.. 

      

    Figure 2-6-3 Edit Raw data            Figure 2-6-4 Batch Edit RawData 
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-Average points: Long press the average points, then click Average Points to check the data 

information selected. 

      

    Figure 2-6-5 Raw Data                      Figure 2-6-6 Average Points 

 

 

Notice: 

1. Turn on Surveying Configure → Data → Allow Same PtName function, raw data 

supports the same name point collection. If you close it, the name of the re-entry will 

be prompted to repeat that Duplicate name: please enter it again. 

2. In the Edit RawData → Other Info can check Framework Calibration information. If 

the project does not open using the Framework Calibration, the Framework 

Calibration value is 0. 
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- Upload: Upload raw data to the private cloud. 

- Set: Set the loading sequence and display. 

- Process: Apply the current parameters to point library and get the result.  

Tick Use coordinate system of the current project, the project coord system is used by default, do not 

tick Use coordinate system of the current project if you need to update the coordinate system, just go 

to Coord Sys Management to set it.  

 

 

 

 

 

Notice: 

1. Slide to the right to read the BLH of the raw data. 

2. All the geodetic coordinates are ground point geodetic coordinate. 

3. Reminding, if you need to save the average data, then you have to open the Store 

Average Points button in the Configuration → Data. 

Figure 2-6-7 Average Points 

 

 

Notice: 

Data after the handle will update the coordinate point library by default, the 

measurement interface will display the new point coordinates after opening the new 

coordinates system. 
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Figure 2-6-8 Average Points1                  Figure 2-6-9 Average Points2 

       

Figure 2-6-10 Average Points3           Figure 2-6-11 Average Points4 

Processed data can be exported and export content can be selected in the optional field of the custom 

format setting. If there is the same file name, then it will prompt The same file name already exists, 

you can check to Cover the original data or enter a new file name, then click OK to export. 

Optional fields include ID, Name, N, E, Z, B, L, H, Tilt N, Tilt E, Tilt Z, Tilt B, Tilt L, Tilt H,  

Antenna H, σN, σE, Plane HRMS, σZ, Target H, Ave Times, Status, StartLocal time, EndLocal time, 

StartUTC time, EndUTC time, Desc, Latency, Sats, Shared Sats, PDOP, Elevation (°), VRS Name, 

Base B, Base L, Base H, Station, Tilt Angel, Tilt Azi, Tilt X, Tilt Y, TiltX Azi, Local B, Local L, Local H, 

Baseline Length, Azimuth, Offset, Audios, Images and Null. 

2.7 Mapping Data 

Mapping Data can show all mapping survey points and supports New, Open, Search, Delete and Edit 

via long-pressing one item. 
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Figure 2-7-1 Mapping Data        Figure 2-7-2 Edit Mapping Data 

2.8 Data Transfer 

Export or import Raw Data, Stake Point, Control Point and Mapping Data of the current project, for 

convenient searching and using. If there is a file with the same name as the exporting one, it will 

prompt A file with the same name already exists, tick Cover to export it, and it will not delete the old 

one. 

Click the Batches button to enter the raw data select interface. Select the raw data, and then click OK 

to return to the main interface.  The OK button can’t be clicked if any raw data file is selected in the 

raw data select interface. In addition, if the Batches button isn’t selected, the default exported data is 

the current data. 

        

Figure 2-8-1 Raw Data export                Figure 2-8-2 Raw Data export 

Raw data export format includes: 
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User-defined (*.txt), User-defined (*.csv), DXF File(*.dxf), SHP File (*.shp), Excel File (*.csv), South 

cass7.0 (*.dat), Scsg2000 (*.dat), PREGEO (*.dat), ASC File (*.asc), KML (*.kml), NETCAD (*.NCN). 

GeoJSON (*.geojson),User Defined GIS (*.txt). 

If you select the CASS model when creating a new project, select South CASS GIS (*dat). If you 

select the EPS model when creating a new project, select the EPS GIS (*txt). If you select Hi-Data 

model, select Hi-Data GIS (*hdx). If you select another template, select the User-Defined (*txt).  

        

Figure 2-8-3 Format-CSV                   Figure 2-8-4 Format List 

The coordinate point, stake point, and control point are saved as Survey.td2, Stake.td2, Control.td2 in 

the Map folder. 

The import and export operation of custom format file method is: 

        

                                                                   Figure 2-8-5 Data Import                       Figure 2-8-6 Custom Format 
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1. In the Supported Fields list, select the fields that need to be exported. The Selected Fields are 

automatically filled in the Selected Fields list click the button  to select the full or full cancellation 

fields. The Export Contents will show the heads of the parts in proper order; 

2. Select one item of Selected Field, clicking Delete will not export the field. If you move Up or Down to 

adjust the export order, the Export Contents field order will change altogether; 

3. Click the Template Manager to define (*csv) export, you can select the template that you have 

configured. Template Manager can set and store name, Import content, etc. 

4. Click the Set button to set the Angle, Splitter and Format Header, etc. 

 

Figure 2-8-7 Custom Format 

5. After setting, click OK to import or export the file; when the software is reintroduced into the staking 

point interface, the import format will default to be the data format of the last import, as long as the 

user does not do data cleaning or uninstall the software. 

6. Project tilt measurement, Data Transfer → Raw Data custom export, supports the export of non-tilt 

correction of the plane coordinates. 

7. If the item PPK function is ticked, when therover station is set, the PPK correction prompt box will 
pop up when the original data is exported in Raw Data → Data Processing or Data Exchange. Click 
Yes to enter the PPK correction file selection box, then select the file to correct the processing or 
exported point. 
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    Figure 2-8-8 Prompt PPK      Figure 2-8-9 Select PPK File 

 

When Surveying Configure → Display → Online Map → GIS Map, you can select to export GIS Map 

in the Data Transfer. 

GIS map supports export format: DXF (*.dxf), SHP (*.shp), GPX (*.gpx), KML (*.kml), KMZ (*.kmz), 

MIF (*.mif), DWG (*.dwg). The shapefile has a point, line and polygon file. The other formats only have 

one file. 

 

 

 

Notice: 

1. All the import and export methods involved in the file custom format are the same as 

this step. 

2. The file import data needs to do the number and coordinate range detection 

(including parameter Calculation Loading, Data Exchange  Stake Point / Control 

Point import, Stake Line → Stake Line Library loading, Road Stake/Cross-section 

Collection → Road Design File the choice of loading, Road Design → Plane → 

Section Design Line intersection, line element, coordinate method of loading. If the test 

data is not within the range of the value, or the E coordinate band number does not 

match, the Input import error prompt box is displayed. 
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Figure 2-8-10 GIS Map1                             Figure 2-8-11 GIS Map2                                Figure 2-8-12 GIS Map3 

2.9 PPK File 

There is a PPK file when you do the PPK survey. You can check the PPK file information via the list. It 
contains the file name, device SN, device module, etc.  

 

Figure 2-9-1 PPK File 

If you long press the PPK file, it will show you the delete button. Click and delete the file. (Only delete 

the file in the software record file, do not delete the PPK file of the receiver.) 
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Figure 2-9-2 PPK File Delete1                  Figure 2-9-3 PPK File Delete2 

Tick the  ahead of the file name to delete batches. 

 

Figure 2-9-4 PPK File Delete3 

2.10 Email 

As an Android email client, the user can send project files by email to realize for remote uploading of 

data. 
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Figure 2-10-1 Email- From Hi-Survey Road 

Tick Email-From Hi-Survey Road to make Hi-Target send mail as the sender.  

Otherwise, users can switch to the mail type and enter the address, it supports most email systems. 

 

 

 

 

 

 

 

Figure 2-10-2 Email-Enter Address 

Tick Feedback to give the feedback to Hi-Target - the default address is Hi-Target enterprise mail. 
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Figure 2-10-3 Feedback 

File browser operation method (all operations involved in the file browsing options are applicable to 

this method in this software): 

Press and hold an item; when the bottom right corner of the current item  appears, put all items into 

selection mode, press the BACK button to exit the selection mode; 

2. In the selection mode, you can select or deselect, or select multiple options; 

3. In non-selection mode, click  on each page, to return to the upper directory, until you reach the 

root directory of SD card; 

4. Click OK to complete the file selection; 

 

Figure 2-10-4 File Manager 

File transfer network status test; enter the file transfer interface initially, without displaying the network 

status test button. When clicking Send and the message fails to send, it will show the Test Network 

button; click it to Test Network status, and display the test results. 
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Figure 2-10-5 Check the Network 

2.11 Project Config 

This new function of the software is convenient to change the configuration parameters. It can define 

the parameter of the average survey, mapping survey, and survey precision. Click one touch to apply it 

after creating the new project. Click New, Edit, Import and Export to set the configuration parameter 

file. Project config manager is synced with (*.plc) of (ZHD/Template/config). 

 

Figure 2-11-1 Check the Network 

- New: Create a new project configuration template to change the parameters of the average survey, 

mapping survey, and survey precision. Click New to input the template name and enter the 

configuration interface. You can set the detailed content by adding, editing, deleting. After the project 

template has finished, click the Return button and you will get the prompt Do you want to save data? 
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Click Yes to finish the project configuration template. 

    

Figure 2-11-2 New Template Figure 2-11-3 New Template 

-Edit: Select the template, then click the Edit button to change the project configuration interface. You 

can edit the detail content. Finally, click Save. 

     

Figure 2-11-4 Project Config Manage Figure 2-11-5 Project Config Manage 

-Import: Select the related project configuration file (*.plc) to import. 
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 Figure 2-11-6 Import Figure 2-11-7 Import 

-Export: Select the project configuration file in the list. Click Export and select the format (Project 
Config File(*.plc), then input the name to export the template. 

     

Figure 2-11-8 Export Figure 2-11-9 Export 

-Delete: Long press the template, then click the delete button to delete the template. 
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Figure 2-11-10 Template 

2.12 Code List 

This is a new function of the software. You can use the short letter to replace the complicated 

description. Import the points into the mapping software (such as CASS). This will create the polygon 

automatically. You can now enter the code list from the project, and then add, edit, delete, import and 

export. The code file is synced with (*.xml) of (ZHD/out). 

 

 

Figure 2-12-1 Code List 

-Add: Setting the name, code, group, color, and style. Click OK to create the new code. 
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Figure 2-12-2 New Template                       Figure 2-12-3 Add Point                            Figure 2-12-4 Save 

Before creating the code template, you should determine the type (point, line, and polygon), and then 

determine the group of the related type. Finally, do the adding, editing and deleting operation of the 

name, code, color, and style of this group. 

-Edit: Editing the existing code. It is similar to the Add function. But it can’t edit the name of code. 

       

Figure 2-12-5 Add Template1     Figure 2-12-6 Add Template2 
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Figure 2-12-7 Add Template3     Figure 2-12-8 Add Template4 

-Delete: Delete the selected code (You can delete it by batches). 

 

Figure 2-12-9 Delete Batches 

Click Group to Add, Edit and Delete the group. 
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Figure 2-12-10 Group Manage1           Figure 2-12-11 Group Manage2 

       

Figure 2-12-12 Group Manage3                Figure 2-12-13 Group Manage4 

CASS, EPS, and PRESET is the default template, and it cannot be deleted. 

      

Figure 2-12-14 Group Manage5          Figure 2-12-15 Group Manage6 
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-Import: Select the related the code file format (*xml), code template file(*txt), code template file (*,csc) 

to import. 

-Export: Select the template in the list. Click Export and select the export format (*.xml, and .txt, *.csv). 

Then click OK. 

          

   Figure 2-12-16 Export                         Figure 2-12-17 Code List Format                Figure 2-12-18 Export Directory 

2.13 Culture Library 

You can check the line, polygon from the list. The line list will display the name, length, ground code 

information. Polygon will display Surface Name, Perimeter, Max Area, etc. 

       

Figure 2-13-1 Culture Library Figure 2-13-2 Culture Library 

-Delete: Select the line or polygon and click Delete to delete them (can delete them by batches). 

-Search: Click Search, and input the name or the code description to find the line/polygon data. 
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-Edit: Select the line or polygon and click the Edit button to enter the attribute interface (no batches), 

Check the selection information. Contain the line/polygon point coordinates. Meanwhile, and preview 

the line/polygon finished. 

        

Figure 2-13-3 Culture Library 1                   Figure 2-13-4 Culture Library2 

Enter the attribute interface, long press the coordinate of the line and polygon to delete, up, down, 

insert and edit. Then add the coordinate information of the insert and edit by using the list selection, 

mapping selection, and real-time survey method. 

            

Figure 2-13-5 Edit Attribute1                  Figure 2-13-6 Edit Attribute2                  Figure 2-13-7 Edit Attribute3 

2.14 Software Settings 

- Auto Connect Device: Once opened, it will auto prompt whether to connect to the last device 

automatically when in the connecting, station setting and survey interface. 
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- Check Correction Transmitting: Once opened, it will check difference sending status in Base mode 

and check difference receiving status in Rover mode, and will show it in a floating window. : close 

check correction transmitting; : send no difference message; : sending difference message. 

When in the handle difference mode, there is a difference detection function, so there is no Check 

Correction Transmitting option. 

- Check Network Status: Once opened, it can detect the network status of the device, or support 

iRTK5 series device. In the built-in network mode, open the software Settings → Check Network 

Status switch and open the floating window to view the current network signal strength directly. 

 

- Check Base Position: Once opened, when the rover is first getting the difference, if the Base position 

is different from before, it will prompt whether to calculate a point. During operation, if a base station 

change is detected, it will prompt the user base station location to change, and the user can judge the 

problem according to the actual situation. 

        

Figure 2-14-1 Software Settings1             Figure 2-14-2 Software Settings2 

- Keep Screen Light On: The shutdown status indicates that the power-saving mode is selected and 

the screen is not in light status. 

- Soft Input: You can use soft input (screen input method) if opened; if closed, only via the keyboard. 

- Floating Window: The floating window is set to display in the non-survey interface. The fixed position 

of the floating window in the survey interface shows no shrinkage; when in a non-survey interface, you 

can hold the floating window and drag it to any position in the screen, after 5 seconds, it automatically 

shrinks 
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Figure 2-14-3 Floating Window    2-14-4 Floating Window Display 

 

 

Figure 2-14-5 Floating Window 

 

 

 

Description of working mode mark of the Floating Window: 

 Rover Station (close Check Correction Transmitting) 

 Rover Station (send no difference)   

 Rover Station (sending difference) 

 Base Station (close check correction transmitting)  

 Base Station (send no difference)    

 Base Station (sending difference)   

 Built-in GPS  

 Demo Mode   

 No Connection   

 Unknown Device  

 Static Mode 

 

Description of the Floating Window data link: 

No data link      

With data link   

Built-in network 

External network (3G) 

Built-in radio   

① 

 ② 

③ 

④ 

 ①. Public satellites and Visible satellites   ②. PDOP 

③. Solution state                                        ④. Differential age 
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 External radio 

Handle difference (sending difference)    

Handle difference (no difference) 

Handle difference (non-normal difference)  

WIFI data link 

When the data link is handled differently, click  on the floating window to enter the Data Collector 

Internet Status interface and check the network status. Click Connect server to achieve the handle 

difference forwarding; if the user has connected to the receiver for the rover station difference, click 

Disconnect server to stop forwarding difference. 

     

Figure 2-14-6 Connecting                                2-14-7 Connected 

- Solution state: mainly includes the following modes (except for the fixed coordinates, the precision 

ranges from high to low): the known points refer to the fixed (base station) → Fix Pos  → RTK Fix  

→ Float  → DGPS  → SDGPS → Auto →None (no GNSS Data). 

- Differential Age: This refers to the time when a rover station receives a base station signal for a 

solution. 

- PDOP: The spatial geometrical intensity factor of satellite distribution; the better the satellite 

distribution, the smaller the PDOP value; generally less than 3 is the ideal state. 

- Visible satellites: The number of satellites received by the receiver, and 5 at least in RTK works. 

- Public satellites: There is no public satellite in the Base station, only when the rover station receives 

the difference data. Public satellites refer to the calculated used satellites, when the base and rover 

station participate in whole cycles and search at the same time, generally, it needs more than 5 to 

work properly. 

- Time Zone: Select the work time zone, correct the UTC time input by GNSS receiver to the local time 

in the user’s area. 

 

 

 

Notice: 

For the iRTK5 device, after the time zone is selected, the handle is connected to the 

receiver, and the software pops up the waiting box to set the receiver time zone. The 

handle sets the time zone of the receiver each time the device is connected. After the 

software has set the time zone, the device needs to be restarted, which can be 

verified by static file creation time. 
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- Theme: Three themes, including List, Style Box and Simple. 

     

Figure 2-14-8 Simple      Figure 2-14-9 Gridview       Figure 2-14-10 List 

- Screen Orientation: Can be either landscape or portrait. (the function applies to QpadX5). 

- Module Restore: Long press to delete a module, press return key to exit delete mode, software 

settings module cannot be deleted. After deletion, module recovery can restore the deleted module to 

its original location. 

- One-key reset: Select whether to reset the surveying configuration and software settings (note: 

unconnected and expired device will not be able to tick this option). Click OK when you get a prompt 

to reset the software settings and surveying configuration. If you click Cancel, it will keep the original 

configuration. 

- User Guide: The user guide can be viewed through a third-party PDF reader. When viewing the user 

guide, you need to have a PDF document in the ZHD directory or the handle on the Internet, and a 

PDF reader installed. 

 

2.14.1 Location Information 

Click the position icon on the floating window to quickly view the location details. 

 

Figure 2-14-11 Floating Window - Location Information 

Display the location information of the current point, including NEZ, Velocity, solution state,  

Local time, and so on. 
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Figure 2-14-12 Location Info               Figure 2-14-13 Base Station 

- Reset RTK: Rover station will calculate the received difference from the base station again, usually 

under the condition of poor satellite status, you can calculate it many times, save the coordinates, to 

rule out an incorrect solution with multipath interference. 

- Enable internet connection: Check whether the network is disconnected; after connecting, it is 

convenient to direct reconnect. 

- Disable the internet connection: Disconnect the network after connecting. 

- Clear Ephemeris: When the rover station is out of the lock, floating and unable to achieve the fixed 

location, and cannot find Beidou or GLONASS, then click the Clear the ephemeris button. Reset the 

main board after clearing. 

- Base Station Information: Display base station coordinates, distance, horizontal distance, and 

azimuth. 

2.14.2 Satellite Information 

Click the satellite icon on the floating window to quickly view the satellite details. 

 

Figure 2-14-14 Floating Window-Satellite Information 

1. SATView 

View the projected location of the satellite, the national flags represent their satellites, and the 

corresponding number below each satellite is the number of the locked satellites. 

- GPS: The Prn range is 1-33 
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- GLONASS: The Prn range is 65-96 

- SBAS: The Prn range is 120-151(EGNOS: Prm values: 120,124,126; SDCM: Prm values: 

125,140,141; GAGAN: Prm values: 127,128; MSAS: Prm values: 129,137; WAAS: Prm values: 

133,135,138) 

- BDS: The Prn range is 161-195 

- GALILEO: The Prn range is E1-E52 

- QZSS: The Prn range is J191-J195 

View and set GNSS satellite elevation mask, click Set to set the elevation mask. 

 

Figure 2-14-15 SATView 

Set the color according to the L1 carrier signal-to-noise ratio of satellite, colour: red <= 31, 31 < 

orange <=41, green >41. 

 

Figure 2-14-16 Status 
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2. Satellite Signal-to-Noise Ratio Map 

PRN is the satellite number, Azi is the azimuth of the satellite, Ele is the elevation mask, L1 is the 

signal-to-noise ratio of the L1 band, L2 is the signal-to-noise ratio of L2 band, and Type is the satellite 

type. 

 

Figure 2-14-17 SAT Info 

2.15 About 

Here are the related instructions for the software version and upgrade. 
Open the application in the networked state, and when a new version of the software is detected, the 

system will display the popup, according to the configuration information on the server. If the current 

link is a non-WIFI data link, the user will be prompted whether to download. 

    

Figure 2-15-1 Update    Figure 2-15-2 QR Code 

The interface added the QR code of Hi-Target Facebook and Youtube, which can be accessed by 

scanning. 
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Notice: 
The information above is virtual information, the factual operations are based on 

actual information. 
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Chapter 3 
Device 

This chapter contains:  

- Device 

- Base 

- Rover 

- GNSS Demo Mode 

- Controller 

- Additional Settings 

- Console 

- Static 

- RangeFinder 

- Device Check  
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3.1 Device 

3.1.1 Device Connection 

To connect the controller controller to GNSS receivers set the device connection method and antenna 

type (can be modified after connection), and then click Connect. 

 

     

        Figure 3-1-1 Device                           Figure 3-1-2 Bluetooth Connect 

There are 4 methods of connection, Bluetooth, network, Wi-Fi, NMEA STREAM(Bluetooth). In addition, 

the built-in GPS and demo modes can be set independently with the controller controller. 

In Bluetooth connection mode, it’s necessary to turn on the Bluetooth function of the receiver and 

controller controller at the same time and click Connect to enter the Bluetooth connection interface. 

Click Search device to search for the device that needs to be connected, choose it in the list by the 

S/N and there will be a Bluetooth pairing prompt. Enter the pairing password (default password is 

1234) to connect the device, and paired devices do not need to enter the pairing password again. If no 

device is found, please click Search device to search again. 

In Network connection mode, click Connect to enter the network settings interface, and set the ID and 

password to connect the device (NB only supported on specific modes). If it’s the first time of 

connection, please connect the receiver by Bluetooth first. Set the IP and port in Additional Settings→ 

Receiver Settings → Remote Connection, then use the network connection to do wireless remote 

operation easily. 

The Network mode is for the specific device connection. You can use this mode when the device 

opens the remote connection. This mode can remotely operate the device easily. 
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Figure 3-1-3 Network 

1. In the Wi-Fi connection mode, if there is no Wi-Fi connection to the current controller, it will 

automatically enter the system Wi-Fi connection interface. Please choose the Wi-Fi that is needed, 

then click Connect. If it is already Wi-Fi-connected, users can choose Cancel, Other or OK, according 

to the situation. The method of making other Wi-Fi connections is the same as the above method. If 

you need to input the password for the first time, the password is 12345678. Once you have 

connected to the device, you don’t need to enter the password again. 

       

Figure 3-1-4 Wi-Fi               Figure 3-1-5 Wi-Fi Prompt 

2. In Built-in GPS connection mode, it will display the S/N of the controller, when using the Hi-Target 

controller, otherwise, it will be blank. Working mode, receiver FW and expiration will be blank too. The 

connection mode displays Built-in-GPS.  

 



    
Hi-Survey Road User Manual 

 

93 

 

Figure 3-1-6 Built-in GPS 

3. In Demo connection mode, the working mode, receiver FW and expiration will be blank too. S/N will 

display as a demo mode. 

 

       

Figure 3-1-7 Demo Mode        Figure 3-1-8 Mode Prompt 

4. In the NMEA STREAM (Bluetooth) mode, the Bluetooth of the receiver and controller need to open. 

Click the Connect button to enter the Bluetooth Connect interface. Click Search device to search for 

the device. Select the device on the Bluetooth list. It will display the connection prompt. Input the 

password, which is 1234. You don’t need to input the password if this device has been connected 

before. You don’t need to input the password for V90Plus and IRTK5. If you can’t find the device, 

please click the Search device again. 
The current receiver's connection status will be displayed after the device is connected successfully, 

including the S/N, Check Update, Working Mode, Receiver FW, Expiration, Method and Antenna. 
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Figure 3-1-9 Device Info 

- Check Update: Check and upgrade the connected device and motherboard firmware. After 

connecting the receiver by Bluetooth or Wi-Fi, click Check update to enter the firmware update 

interface. If there is a new firmware, there will be a prompt, and users can click the Update button to 

upgrade. 

 

Figure 3-1-10 Firmware Update 

- Working Mode: Display the current receiver's operating status, generally base mode, rover mode or 

static mode. 

- Receiver FW: Receiver firmware version number and receiver type. 

- Expiration: Deadline for registration code use. 

- Antenna: Set the antenna type. Enter the antenna manage interface to choose it, according to the 

model; if there is no matching antenna type, you can click Add to add the custom antenna type by 

inputting the Model, Desc, Radius, L1 Phase Offset, L2 Phase Offset, and SHMP Offset in the Add 

Antenna interface. 
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Figure 3-1-11 Antenna Manage         Figure 3-1-12 Add Antenna 

3.1.2 Register 

Registering the receiver. Connect the GNSS receiver, input the receiver registration code, or scan the 

receiver QR code to register (please ask the Hi-Target service person for the registration code or QR 

code). The code for the 7-digit S/N receiver is 21-digits, with a 24-digit code for the 8-digit S/N receiver. 

 

Figure 3-1-13 Register 

3.1.3 NFC Connection 

Users can scan the NFC-enabled receiver's NFC tag, with the NFC-enabled controller, to connect the 

device. 

The current receiver's connection status will be displayed after the device is connected successfully, 

including Working Mode, Receiver FW, Expiration, Method, Antenna, etc. 
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3.2 Base 

The base settings mainly set the working parameters of the base station, including the base 

coordinates, data link, and other parameters. 

3.2.1 Base Configuration 

Users can save all the parameters, set in the base station, as a configuration file, or load the 

parameters directly from the configuration file. 

                                               

Figure 3-2-1 Configure            Figure 3-2-2 Delete or Load 

-Template: Click Template to enter the setting interface. The template information can be Load, View 

and Delete. 

- Save: Input the configuration name and click to save the current set parameters. 

- Delete: Delete the selected configuration file. 

- Load: Load parameters of the selected configuration file. 

- : Generate the parameters of the current settings as a QR code. 

-View: View the parameters of the template. 

-Delete: Delete the template selected. 

3.2.2 Receiver Position 

Set the coordinates of the base station to the latitude and longitude coordinates in the WGS-84 

coordinate system (requires the GNSS to be measurable to get the height anomalous value, because 

the H of the base position is the ellipsoid height and the motherboard needs the geoidal height of the 

internal mode). 
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Figure 3-2-3 Set Base1                               Figure 3-2-4 Set Base2                              Figure 3-2-5 Set Base3 

When setting up the base station at an unknown point, point coordinates can be obtained by average 

collection. (the more coordinates in the average collection, the higher the reliability). 

When setting up the base station on a known point, users can input the coordinates directly, or select 

data from the point library by clicking the point library icon. 

- : Average collection. To enter the average collection interface, the default number of smoothing is 

10 times. This function will not display average information in the new version. 

-Name: Set the base name. 

- Target H: Input the instrument height and height type of the base station. 

- Position: The ground reference point of the base station, it can be manually-set or obtained by 

average collection, or from the point library. 

- : Point library. It is used to get points in the coordinate library to the current interface.  

3.2.3 Datalink 

Datalink settings are used to set the communication mode and parameters between the base and 

rover, including the Internal UHF, Internal GSM, External Radio, Wi-Fi （The device needs the Wi-Fi 

module）and Data Collector Internet. 
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Figure 3-2-6 Set Base4                                      Figure 3-2-7 Set Base5                         Figure 3-2-8 Set Base6 

1. In the Internal UHF mode, users can set the Channel, Power, and protocol. 

      

Figure 3-2-9 Set Base7                               Figure 3-2-10 Set Base8 

- Power: There are three options, including high, middle and low options. 

- Frequency: Click to enter the interface to get the most suitable channel (for specific models). 
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Figure 3-2-11 Channel List        Figure 3-2-12 Frequency 

Click the frequency of a channel to modify the frequency of the channel, within the frequency range 

specified by the channel. 

- Refresh: If the result of the current search is not a suitable channel, users can change the starting 

channel to continue a new round of searches. 

- Reset: Click to restore the list to the default state. 

- Save: After modifying the frequency table, please click to complete the modification. 

 

2. In Internal GSM mode, you need to set the data link as Internal GSM, Sever, IP, Port, Group type.  

  

Figure 3-2-13 Internal GSM  

-Server/IP: Select server, input IP and port or click Select to display the server address list. 
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Figure 3-2-14 Server                   Figure 3-2-15 Server List 

-Group Type: It contains By City Number and By Base Station SN. 

  

Figure 3-2-16 Type 

- By City Number: The Area ID and Group ID are 7 and 3 digits respectively. The group ID needs to be 

less than 255. The base and rover need the same parameter settings to work properly. 

- By Base Station SN: Input the base S/N, and set the same number in the same way with the rover. 

When you use the CORS mode, please set the right IP, port, mount point, etc. Then click Set to save 

the settings. The username and password are SN and zhdgps, which can’t be changed. When you set 

the rover, the username is 8 bits’ number (it is suggested you use the SN to login), but it must not be 

the same as the base username. The other parameters are the same as the base. 

2. In the External Radio mode, the device can connect to the external radio to transmit data. iRTK5 

series allow setting the external radio parameters. 
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Figure 3-2-17 External Radio 

3. For the Wi-Fi mode, after the controller is connected to a WiFi-enabled receiver, through a non-WiFi 

connection, the data link will add the Wi-Fi mode. In this mode, the receiver can be set to connect to a 

third-party Wi-Fi and send differential data. 

    

  Figure 3-2-18 Wi-Fi Mode           Figure 3-2-19 Wi-Fi Mode Settings 

Click the Wi-Fi option to enter the Wi-Fi Parameter interface. When the Wi-Fi hotspot is turned on, the 

connection to the Wi-Fi of the controller is supported; otherwise, a third-party Wi-Fi hotspot will be 

connected. 
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Figure 3-2-20 Wi-Fi Mode Settings 

1. In Data Collector Internet mode, it supports ZHD and CORS mode to connect the server (for 

specific models).  

 

      

Figure 3-2-21 Data Collector Internet1      Figure 3-2-22 Data Collector Internet2 

It uses the controller network to connect the server as the RTK, dial-up internet access by the network 

module of the controller. Send the received differential data to the device by Bluetooth after 

connecting to the server, so that the device can do network RTK without the SIM card. 

3.2.4 Other Options 

Set the Diff Mode, Correction Type, Elevation Mask, and other parameters. 
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Figure 3-2-23 Other1           Figure 3-2-24 Other2 

- Correction Type: Including RTCM(3.2), RTCM(3.0), CMR and RTCM(2.x). 

- Elevation Mask: Adjustable from 0 to 30 degrees. 

- Pos Frequency: Software update positioning data frequency, supports 1Hz and 2Hz. 

- PPK Mode: Connect to a receiver that supports PPK function; the receiver will start a temporary 

static collection synchronously after the base turns on the PPK mode. 

Click Set after all the base parameters are set, and there will be a prompt to indicate the success or 

failure of the settings. If the setting is successful, check the correction signal of the base to find out 

whether it has been sent. If it has failed, please check whether there has been a parameter error and 

try again several times. 

3.3 Rover 

The rover settings mainly set the working parameters of the rover, including Configure, Datalink, etc.. 

3.3.1 Rover Configuration 

Users can save all the parameters set in the rover as a configuration file, or load the parameters 

directly from the configuration file. 

In the configure interface, users can click the QR code icon to read the QR code shared by the base 

station, to obtain the configuration parameters quickly.  

 
 

Notice: 

If use the receiver with 3 type satellites, the correction type is RTCM 3.2. It can 

support multiple brands' correction positioning and navigation. 



    
Hi-Survey Road User Manual 

 

104 

 

Figure 3-3-1 QR Code 

3.3.2 Datalink 

Rover data link settings are used to set communication types and parameters between the base and 

rover, including the Internal UHF, Internal GSM, External Radio, Data Collector Internet, External 

Network (3G), PPP Service (for specific models), etc. The Internal GSM and External GSM (3G) 

contain GPRS, GSM and CDMA.  

In addition, the External Network (3G) can only be supported by English version software. Data 

Collector Internet is supported when the receiver connects the controller via Bluetooth or Wi-Fi. When 

the Qpad X5 connects the Build-in GPS, it can also use the Data Collector Internet. The PPP Service 

needs the special version receiver to support it. 

 

Figure 3-3-2 Datalink 
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1. In the Internal UHF mode, users can set the Channel, Protocol, etc.. The channel must be 

consistent with the channel of the base. 

- Radio Relay: When you set the rover as the Internal UHF, you can use this function. (At present, only 

the IRTK5 series support this function, and the radio module is ZHD46005MD. The protocol is 

TRIMTALK450S, TRIMMARK 3, HI-TARGET 19200). After the channel and power are inputted, it can 

support the relay function for the other rovers. 

2. In the Internal GSM mode, users can click Network to choose the network type (GPRS, GSM, 

CDMA). 

Click the Advance Config set the network type and other parameters. 

     

Figure 3-3-3 Advance Config1          Figure 3-3-4 Advance Config2 

 

- APN: Different networks will have different settings. It’s the parameters of the device SIM card. 

- Server: Choose the model, including ZHD, CORS and TCP/IP. Input the IP and port manually, or 

click Select to enter the server list and choose a suitable server. 

-IP: Input the server IP, port, or click select to select the server from the server list. 
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Figure 3-3-5 IP and Port1         Figure 3-3-6 IP and Port2 

-Group Type: It can be selected By City Number or By Base Station SN. 

- By City Number: The Area ID and Group ID are 7 and 3 digits respectively. The group ID needs to be 

less than 255. The base and rover need the same parameter settings to work properly. 

-APN: When Network is GPRS, input CMNET. When Network is CDMA, Input User Name and 

Password as card, card. 

- Net Relay: Click to open the net relay option (for specific models), and set the Relay Channel, 

Protocol, Power, etc. Then it can relay to other rovers while working. 

When you use the CORS mode, please set the right IP, port, mount point, etc. 

Click Set to enter the CORS Parameters interface, and click Get Mountpoints to choose the suitable 

Mountpoints and input the User Name and Password to finish the settings. 

 

 
 

Notice: 

In the CORS connection interface, you can compare the practical coordinate with the 

output coordinate to ensure the right correction by tick RTCM1021-RTCM1027. 



    
Hi-Survey Road User Manual 

 

107 

     

          Figure 3-3-7 Set Rover                     Figure 3-3-8 CORS Parameters 

- Open: Load existing CORS parameters. 

- Save: Save the current CORS parameters. 

- OK: Complete the settings and return to the previous screen. 

3. In the External Radio mode, the controller controller needs to be connected to a device that 

supports external radio. 

4. In the Data Collector Internet mode, go to the rover setting interface, select Data Collector Internet 

of the data link, and select Sever, IP, Port, Group parameters, etc. Click Set to finish the station setting. 

5. In the PPP Service mode, users can set the Diff Mode (satellite or network). 

      

 
 

Notice: 

1. When the data link is Internal GSM, the APN is SIM card parameters. 

2. The APN of the data collector internet mode is the parameters of the controller. If 

the Wi-Fi is not connected, the controller must be installed with the SIM card to do 

APN settings, otherwise, there will be a prompt. 

3. The controller APN parameter setting follows: controller and application → APN  

setting. 
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Figure 3-3-9 APN1             Figure 3-3-10 APN Parameters 

3.3.3 Other Options 

Set the Pos Frequency, Elevation Mask and PPK. 

- Elevation Mask: Adjustable from 0 to 30 degrees. 

- Pos Frequency: Software update positioning data frequency, supports 1Hz and 2Hz. 

- PPK Mode: The receiver will start a temporary static collection synchronously after the rover turns on 

the PPK mode. It will record the RSP file in the Detail Survey, Stake Points, Stake Line when using the 

average collection. The file name will be consistent with the static collection file name. 

- Click the Long baseline survey button. You can get a fixed solution when the baseline is 150 

kilometers. (Notice, this function is only supported by OEM and the motherboard.) 

- Click Set after all the base parameters are set, and there will be a prompt to indicate the success or 

failure of the settings. If the setting is successful, check the correction signal of the base to see 

whether it has been sent normally. If the signal has failed, check whether the parameter is right. If it 

isn’t, then reset it again. 
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Notice: 

If the project was turned on in PPK Mode, when setting up the rover, there will be a 

PPK correction prompt when the original data is exported. 

 

Figure 3-3-11 PPK 

 

 

3.4 GNSS Demo Mode 

The receiver can simulate measurement data in the demo mode to make it easy to learn the software. 

 

Figure 3-4-1 Demo Mode 

-Choose the Direction according to demand, including Random, Input, Map, and Line. 

- Random: The current point direction is displayed randomly. 

- Input: Specify the traveling azimuth. 
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- Map: Specify the direction as the direction of the map. There are four options, East, South, West, 

and North. 

- Line: Specify the line in the Stake Line or Stake Road. 

-Velocity is the moving speed of the current point, it can be a specified speed or random.  

-Precision is the precision limitation of the current point, it can be input or given randomly.  

-Start Point can be specified with any coordinate. The coordinate can be input, or selected from the 

point library or map directly. 

After completing the settings, click Start to start the demo mode. If the GNSS receiver or built-in GPS 

is connected, it will prompt whether to disconnect to start the demo mode. After the demo mode is 

started, the interface will automatically jump to the main software interface. 

 

Figure 3-4-2 Demo Mode 

3.5 Controller 

In this interface, users can check the current controller type, Bluetooth support status, network, serial 

port, etc. It will display the corresponding mode with the Hi-Target controller, and display General for 

others (all non-Hi Target Android devices). The software only opens the encryption permission in the 

Hi-Target controller. If the controller is not a Hi-Target device, it will prompt Non-certified device, don’t 

support RTK survey.  
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Figure 3-5-1 Controller  

3.6 Additional Settings 

The additional settings include module-info, registration info, 5-pin port data output, satellite tracking 

switch, receiver settings, service info, restore system, electronic bubble calibration, orientation sensor 

calibration, magnetic calibration, Wi-Fi hotspot password set, update firmware, network diagnostics. 

 Different types of devices or connections support different functions. 

 

     

Figure 3-6-1 Additional Settings1           Figure 3-6-2 Additional Settings2 
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Figure 3-6-3 Additional Settings3          Figure 3-6-4 Additional Settings4   

 

3.6.1 Module Info 

Check the radio module type and network module type. The viewing of module information only 

supports some modes. 

- Radio Module Type: Displays the type information of the device radio module. 

- Network Module Type: Displays the type of information of the current network module. 

 

Figure 3-6-5 Module Info 

3.6.2 Registration Info 

In the registration info interface, check the device registration code and expiration time. 

 

Figure 3-6-6 Registration Info 
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3.6.3 5-pin Port Data Output 

Open 5-pin Port Data Output, users can select the corresponding port's baud rate, commands that 

need to be sent and the corresponding frequency (1Hz, 2Hz, and 5Hz). 

After turning on the settings, the static collection will be stopped and it will not be allowed to open. If 

users try to open this option, when using the static collection or the base model, the software will 

prompt that the current mode does not support this operation. 

      

         Figure 3-6-7 Warning                Figure 3-6-8 5-pin Port Data Output 

Checking the static file and do the related operation. 

-5-pin Port Data Output: ON/OFF 

-Baud rate: 19200/115200. 

GGA/RMC/ZDA/GSV/VTG/GSA/GLL/GST/GGK/VGK/HDT：Set output frequency of GGA/RMC/ZDA/

GSV/VTG/GSA/GLL/GST/GGK/VGK/HDT, such as 1Hz, 2Hz, 5Hz, V90Plus with above 5.6 firmware o

r IRTK5 with V1.5 firmware can support 10Hz, 20Hz output.  

3.6.4 Receiver Settings 

Set the store RINEX data, stop and go, firmware upgrade prompt, remote connection, USB virtual 

serial port, store static data in receiver SD card, sound type, volume, one-step set station, quasi 

dynamic RTK, etc. Different devices have different settings. 
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Figure 3-6-9 Receiver Settings 

- Store RINEX Data: After turning on, the RINEX format data will be recorded synchronously with the 

static collection. 

- Stop and Go: Support the function to collect temporary static data after turning on. 

- Firmware Upgrade Prompt: After turning on, there will be a prompt when there is upgradeable 

firmware. 

- Remote Connection: The device will automatically connect to the corresponding server after turning 

on. Remote connection IP and port do not need to be changed, the default value is OK. 

- USB Virtual Serial Port: After turning on, users can connect the USB debugging virtual serial port. 

- Store Static Data in Receiver SD Card: Set static files to save to SD card. 

- Sound Type: Switch the voice announcement (None, default and user-defined). 

- One-step set a station: After turning on, the base can be set automatically after power on. 

- Quasi dynamic RTK: Users can star the Quasi-dynamic collection in the Detail survey after turning 

on. 

 

 
 

Notice: 

The remote connection address and port don’t need to be changed and set the default 

setting (IP: rtk.zhdgps.com Port: 8999) to escape setting failure. 
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3.6.5 Service Info 

The service info interface will display the current receiver version type and its corresponding function 

rights. 

 

Figure 3-6-10 Service Info 

-PPP Service Authority: Check the PPP Service Authority information. If the PPP Service Authority 

expired, it will display red. On the contrary, it will display black. You can click Register, and get the 

registration code or QR code from the technician. This function only supports the receiver that has the 

PPP Service Authority. 

         

Figure 3-6-11 PPP Service Register1     Figure 3-6-12 PPP Service Register2 

- RTK XTRa Authority: check the RTK XTRa Authority information. If the PPP Service Authority has 

expired, it will be displayed in red. Otherwise, it will be displayed in black. At present, only iRTK5 

supports this function and the satellite type authority. 

0 
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Figure 3-6-13 RTK XTRs Register1         Figure 3-6-14 RTK XTRs Register2  

3.6.6 Restore System 

Restore the firmware to its original state. 

 

Figure 3-6-15 Restore 

3.6.7 Electronic Bubble Calibration 

Tilt survey → Electronic Bubble Calibration 

3.6.8 Orientation Sensor Calibration 

Tilt survey → Orientation Sensor Calibration 

3.6.9 Magnetic Sensor Calibration 

Tilt survey → Magnetic Sensor Calibration 
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3.6.10 Wi-Fi Hotspot Password Set 

To modify the connection password for the receiver's Wi-Fi hotspot, please connect the receiver by 

Bluetooth first. Then enter the old password and new password twice correctly, and click Set to 

complete the operation.  

 

Figure 3-6-16 Wi-Fi Password Config 

3.6.11 Update Firmware 

Connect the receiver by Wi-Fi first, and choose the file to upgrade the firmware of the device and 

motherboard. The corresponding motherboard can only select the corresponding file to upgrade. If the 

wrong BRD file is imported, the device will prompt upgrade failed during the upgrade process. This 

function only works on some models. 

3.6.12 Network Diagnosis 

Check the state of the network module, SIM card, network signal, network registration, dial-up, and 

server connection. And this function only supports some specific models. 

 
 

Notice: 

1. The default Wi-Fi password is 12345678; 

2. If you forgot the Wi-Fi password, you can use the GNSS Receiver Manager → Wi-

Fi Password Settings to set a new password. 
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Figure 3-6-17 Network Diagnosis 

- : Normal. 

- : Abnormal. 

- : Not checked. 

3.7 Console 

It’s mainly used to debug data and detect the GPRS signal strength. It can save the received 

debugging data as files. 

 

Figure 3-7-1 Console 

- Hex: Select to display data in hexadecimal format. 

- Refresh: Select to refresh the output. 

- Save: Select to save the output data. 
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- New Line: Select to send the new line, select it when sending commands normally. 

- Send: Click to send the command after entering the command. 

- GPRS Signal Test: When using the internal GSM mode (for some specific models), select and click 

OK to enter the signal test. The current GPRS signal strength will be displayed in the text box in the 

pass-through mode. +CSQ: 6,2 means that the signal strength is 6. 

     

Figure 3-7-2 Warning          Figure 3-7-3 Pass-through Mode 

 

The software presets commonly-used data types and can receive data without selecting the command. 

Select data types, it supports multi-selection combination sending. Users can select Clear to clear the 

receiver's current data and request the selected data again and then click Send to send the data. 

There will be sensor values output when using the demo mode or built-in GPS mode. 

 

 
 

Notice: 

The two numbers behind the CSQ represent the GPRS signal strength value and the 

signal symbol error rate. The larger the previous value, the better the signal. The last 

value is 0 normally. 
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Figure 3-7-4 Sensor Values 

3.8 Static 

3.8.1 Static Settings 

   

Figure 3-8-1 Device Interface        Figure 3-8-2 Static 

In RTK mode, if users need to do static collection at the same time, please click to enter the static 

settings interface to input the interval, file name, pole and elevation mask. Users can view the GDOP, 

start time and recording time. Click Start to start recording. 
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Figure 3-8-3 Set Duration       Figure 3-8-4 Static Mode 

The Set Duration function can be enabled only when the Static Mode option is selected (for some 

specific models). After the specified collection time is enabled, the current collection will stop and the 

receiver will automatically shut down. 

 

3.8.2 Static Data Management 

View static files in the current receiver and do some related operations. 

      

Figure 3-8-5 Static Data Management     Figure 3-8-6 Download or Delete 

 
 

Notice: 

The height limit (antenna height) cannot be greater than 65m. If the height exceeds 

65m, the HGO display antenna will be inconsistent. The software will fail and prompt 

when users input a value that exceeds 65m. The elevation mask limit must also not 

exceed 30 degrees. 
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- Format: Format static data, data is not recoverable. 

- Refresh: Refresh the current file list interface. 

- Download: Connect the receiver by Wi-Fi, it supports the FTP static files download to the local store. 

Long press to choose files, and it will prompt the save path after the download is successful. 

- Delete: Long press a record to delete the selected static data, allowing multiple files to be selected 

and deleted. 

3.9 RangeFinder 

3.9.1 RangeFinder Connection 

Select the type of the rangefinder to be connected, including the Leica Disto D8/D5/D3 and Trupulse 

360B, and click Connect to connect. The rangefinder choice is not available if already connected. 

     

Figure 3-9-1 Device Interface   Figure 3-9-2 Choose the RangeFinder 

3.9.2 RangeFinder Intersection 

Click COGO→ Intersection in the main interface to enter the intersection interface. 
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Figure 3-9-3 COGO Interface      Figure 3-9-4 Azimuth Interface 

When the rangefinder device is not connected, users can click the Bluetooth button  in the 2Pt2L, 

2Pt1L, 2Pt1A1L and Azimuth interface to enter the rangefinder interface to connect the rangefinder. 

After entering the rangefinder interface, click Connect to connect the rangefinder by Bluetooth and use 

the rangefinder to measure the corresponding value.  

3.10 Device Check  

The Device Check is a new function that is used to check whether the coordinate is precise. 

Click Device Check in the Device interface to enter this function. Users can input or select the 

corresponding points. It will then display its NEZ. Next, click the Start Check button to process the 

data and display the list. The content contains N, N Limit, E, E Limit, Z, Z Limit. If the check is a 

success, it will prompt Current device meets inspection. 

 
 

Notice: 

The height limit (antenna height) cannot be greater than 65m. If the height exceeds 

When using the software to read the rangefinder ranging value, make sure that the 

rangefinder is in the initialized state and not in the waiting state. 
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Figure 3-10-1Device Check1               Figure 3-10-2 Device Check2                     Figure 3-10-3 Device Check3 
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Chapter 4 
Survey 

This chapter contains:  

 

 -  Detail Survey 

 -  Stake Points 

 -  Stake Line 

 -  Mapping Survey 

 -  Menu 
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4.1 Detail Survey 

Click the Detail Survey icon in the Survey interface to enter the Detail survey; text interface and the 

graphical interface can be switched via the Text / Graph button. 

         

Figure 4-1-1 Detail Survey    Figure 4-1-2 Graph Interface      Figure 4-1-3 Text Interface 

 Navigation               Zoom in                 Zoom out                       PPK collection 

 Zoom center             Zoom All               Attribute Info                 Select Point 

 Intersection               Auto Survey           Turn off Auto Survey     Average Survey 

 Store                      Expand Tools         Hide Tools                     Culture Create 

Angle of View 

4.1.1 Quick code 

In the Detail Survey interface, click the icon  in the upper left corner to enter the Quick code page. 

In the Q-code interface, you can set the point name, video, photo and target height, etc. Long press a 

code (1-9) to delete or edit the code information. For the edited code, you can directly collect and save 

the point with the corresponding quick code (1-9) by clicking the controller’s physical button (1-9). 

Then the set quick code information will be automatically applied to the current collected point. 
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Figure 4-1-4 Quick Code          Figure 4-1-5 Edit                    Figure 4-1-6 Code Info 

4.1.2 Map Navigation   

Enter the Survey interface; the map navigation  is shown when the left toolbar is hidden. It allows 

users to view the current position, or search for a point position more intuitively, and the navigation 

tool provides three types of a walk, driver and bus for route searching. 

     

Figure 4-1-7 Navigation    Figure 4-1-8 Map Navigation 

 

Notice:  

In the Survey interface, you can enter the map interface by clicking the  icon. 

Map navigation function doesn’t display the points collected during measurement; 

the third party map in the configuration can display the points of the 

measurement. 
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After entering the Map navigation interface, the same tools as the survey interface will not repeat the 

introduction; add the following functions: 

 

Satellite Imagery  ：Layer General  ：Route Search  ：Point Search  

 

Click and tools, the loaded map can be switched between satellite image and layer general. 

      

Figure 4-1-9 Map    Figure 4-1-10 Satellite 

During the survey, you can use the function point search  if you search for the position of a point, 

used  for route search. The coordinates of the search point can be obtained by real-time collection, 

point library, graphic selection, and manual input, and then clicking Search. Back to the map interface, 

the red icon on the map is the position of the search point. If you want to search the route to the point, 

click Go Here, then it will display route mileage at the bottom of the screen; you can select three 

methods of walking, driving, and bus. Click Details to view the detailed route of starting to endpoints. 

   

Figure 4-1-11 Search    Figure 4-1-12 Go Here 
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Figure 4-1-13 Route    Figure 4-1-14 Details 

If you know the start and endpoints, you can use the route search . After entering its interface, 

select the route type, input coordinates of the start point and endpoint, and then click Search. 

4.1.3 Manual Collection 

In general, you reach the measurement position, decide whether to collect points according to the 

survey coordinates, accuracy, and solution-state displayed on the interface. General RTK Fix solution; 

click for manual collection, the software checks the accuracy firstly (accuracy settings is in 

Surveying Configure → Data). If accuracy is not required, the software will be prompted. 

 

It will pop up the Save Point interface before collection completed, you can check the reliability of the 

point; at the same time, the software automatically records data cumulatively according to the global 

point number and the prefix of point name is the one used last use. You can directly input Target H, 

and also click Pole for detailed settings of target height configuration and antenna type. Input mark 

information in GroundCode and you can also select commonly used types; then set Station in the 

Save Point interface. 
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Figure 4-1-15 Bubble Prompt    Figure 4-1-16 Point Info 

4.1.4 PPK Collection 

PPK (Post Processing Kinematic) technology was the earliest GPS dynamic differential technology. It 

is also known as the stop and go. The main difference between PPK and RTK technology is that it is 

not necessary to establish a real-time data transmission between the base and rover. After the 

positioning observation, the positioning data is collected by the two receivers. This is then jointly 

processed to calculate the coordinates of the rover at the corresponding position. The distance 

between the base and rover is not strictly limited. 

 

The PPK function can be either used alone or in combination with RTK. When using the PPK function 

alone, the base station only needs to keep track of the satellites and record the static data. When used 

in combination with the RTK, the base station needs to send differential data while recording static 

data. Hi-Survey Road has the PPK switch in the setting interface of the base. When it is set to On, the 

base station can record static data and transmit the differential data. 

 

After setting up the rover, click the PPK button on the right side of the graphic interface of the Detail 

survey for the PPK collection settings. 

      

Figure 4-1-17 PPK    Figure 4-1-18 PPK Record 

Click Turn on record, the rover station starts to record static data. When you arrive endpoints 

measurement position, you can click Start mark to proceed collection after inputting the corresponding 

Name, Target H, GroundCode, select the average count (generally recommended more than 200 

times). 

 

Slide the screen to the left during the collection to view the coordinates of each average data. When 

the setting of the average times is reached or click Finish mark, the software automatically saves the 

coordinate points. Click Turn off the record and the rover will stop recording static data. 
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Figure 4-1-19 Start Mark    Figure 4-1-20 Mark Data 

Each time PPK collection is performed, a PPK file is recorded correspondingly, and you can view the 

file information and delete the file in the Project  PPK File. 

 

Notice: The data and tag information of the PPK function of the rover are 

recorded in the Rinex folder of the receiver, and the Rinex file should be used for 

post-processing. For related operations on PPK post-processing, please refer to 

the HGO V2.0.0 Software User's Guide. 

4.1.5 Culture Create 

Click Culture Create and select the real-time collected points to create a line. After finishing Culture 

Create, the software will prompt a line collection in a pop-up window, which will display whether the 

culture should be closed or not. If not, it will create a line. If this is ticked, it will create the surface, 

marked on the map. 

 

A hidden bar at the bottom displays WGS-84 BLH, local NEZ, and BLH coordinates, with left-right 

sliding to select to display coordinate types. 
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Figure 4-1-21 Culture Create 

1-Culture create switch:  off,  on 2-Collected culture 3-Coordinate display 

    

Figure 4-1-22 Line Collection   Figure 4-1-23 Collected Line 

   

Figure 4-1-24 Polygon Collection    Figure 4-1-25 Collected Polygon 

2 

3 

1 
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4.1.6 Collect Input Method 

In demo mode, built-in GPS or connecting device, Hi-Survey Road can support the electronic bubble 

survey. It will display the diagram of the electronic bubble position in the software interface, you can 

select Auto → Bubble Is Centered to collect points according to the state of the electronic bubble. The 

electronic bubble has the following states: 

 

Center: Bubble is within the set limits, centered well. 

Wait Center: Waiting for the user to adjust the pole to center the bubble. 

Wait Survey: Waiting 2 seconds after center, enter the survey state, and collect points in this state. 

Wait Move: After the last collection point is finished, it waits for you to move the pole; after moving a 

distance it will start the next survey. 

Out of Range: In the set limits, the bubble deviates from the center position. 

 

Figure 4-1-26 Bubble Center 

When collecting coordinate points, it supports audio and photo attributes. In the Save Point or Text 

interface, click  to input and view audio and photo information; the pictures displaying the current 

point coordinates and time in the upper right corner are saved in the file after point collection. It 

supports audio and photo file import by clicking Add File, audio file format can be *.amr, *.wav, *.mp3 

and photo formats are *.jpg, *.png, *.bmp. 
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Figure 4-1-27 Audio Record      Figure 4-1-28 Audio Record Prompt        Figure 4-1-29 Add Audio File 

     

Figure 4-1-30 Photograph    Figure 4-1-31 Add Photo File 

After returning to the parent interface, once the user has input audio or photo information, the interface 

icon is changed to . 

 

When you select code information, you can directly select the common code, or manually edit the 

property.txt file (SDcard/ZHD) according to the actual work situation. The edited code information will 

be displayed in the list. Long press one file in the list to delete the file. 

4.1.7 Automatic Collection 

Click the Auto icon to enter automatic collection interface, select collection mode (including Time 

Distance (change value of N or E direction), Slant Distance, Bubble Is centered), input the prefix, ID, 

GroundCode, etc. Click OK, the software will enter automatic collection mode. Accuracy will be 

checked during automatic collection (accuracy is set in Surveying Configure → Data has a detailed 

description. If it meets the accuracy requirements, it will automatically collect and prompt to save 

points; if it does not meet the accuracy requirements, there will be no prompts until the accuracy 
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meets the requirements to continue to automatically collect and save), click  to finish automatic 

collection. 

 

     

Figure 4-1-32 Auto Collection Method    Figure 4-1-33 Auto Collection by Time 

When the automatic collection mode is Time, the interval(s) value can be set, and it will start automatic 

collection according to the set time interval. 

When the automatic collection mode is Distance, the interval(s) value can be set, and it will start 

automatic collection according to the set plane interval. 

When the automatic collection mode is Slant Distance, the interval(s) value can be set, and it will start 

automatic collection according to the set slant interval. 

When the automatic collection mode is Bubble is centered, hold it straight for automatic collection, and 

take away immediately after collection, with no further human intervention. Clicking on the upper-right 

corner of the interface Configure → Data → Bubble Precision to set the bubble precision. 

 

When the data quality is not good (the solution, precision, and the bubble do not meet the 

requirements), automatic collection stops, and a specific red font prompt will be given by the software, 

according to the current unsatisfied conditions. 

4.1.8 Average Collection 

Average Collection is a simple way to improve measurement accuracy; according to the error theory, 

the error occurs in any direction, so if there are a large number of observed quantities, accidental 

errors will be offset (but it’s just theory, it doesn’t mean that the more observed quantities, the higher 

the precision). In the Average Collection interface, click Start, the software will collect points, and 

display the current point position at the same time. The software automatically analyzes the quality of 

the data, then calculates and displays a standard deviation (root mean square error). 

 

Average Collection supports text and graphic displays. After the average collection reaches the set 

number and stops, in the Text interface, you can delete some scattered points in the average list to 

improve the collection accuracy (long press average list, display Delete toolbar), and then the software 
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will automatically redo the average calculation. In the graphic display interface, click the average 

collection point to display the point coordinates. 

      

Figure 4-1-34 Average Text Interface   Figure 4-1-35 Average Graph Interface 

The calculated error is the same as the error of the measurement. However, because the average 

process is from a small quantities collection, the estimated error may be less than the actual 

measurement error. 

 

Configuration can be done before average collection; click Configure in the upper right of the Average 

interface to set the Average Method, Status, Ave Times and Ave Precision. Each time you exit the 

software, the Status of the average collection configuration is set to the Fix solution. It cannot be 

configured during the average collection. If it fails to achieve the average accuracy, as well as 

configuration over-limit, it will prompt Unable to start average due to low precision. Then you need to 

re-configure the average precision. 

     

Figure 4-1-36 Configure   Figure 4-1-37 Configure Parameters 
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4.1.9 Indirect Survey 

Intersection collection is designed for places where we cannot reach or there is no GNSS signal. 

Usually, only plane coordinates can be obtained by intersection, and the elevation data should be 

obtained by other measurements. The principle of intersection is a simple graphical intersection 

calculation; there are many intersection ways, with different required quantity, you can choose 

according to your measurement tools (please refer to chapter 5 of this book for specific usage: Tools 

→ Intersection). 

 

Notice: The points calculated by intersection are saved in Coordinate Data and 

Raw Data. 

 

4.1.10 Attribute Querying 

Click  to open Attribute Querying, to enter the Attribute Querying state. 

It supports query point, line, and surface. Click and select point, line, and face on the map to show the 

attribute information, and you can delete, modify the attribute; click  again to exit the attribute 

querying state. 

 

To edit the selected data, you can also click the Attribute Info → More to jump to the Edit RawData 

interface. After editing, click OK to save the modified data and return to the Detail Survey interface. If 

you click Cancel, it will cancel saving the edited data and return to the Detail Survey interface. 

     

Figure 4-1-38 Attribute   Figure 4-1-39 Attribute Info 
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4.2 Stake Points 

 

Figure 4-2-1 Stake Points interface 

1- Stake instructions: Southward and Eastward to 0 mean it has reached the staked point. DeltaH 

represents the Verticals difference between the staked point and the current point. 

 

 Choose node on line   Select Point         Nearest Stake Point   Angle Of View 

 Average Collection     Select Stake Point    Single Collection       AR Stake 

 

Select Stake Point: In the Stake Point interface, click  to enter Select Stake Point interface; it 

provides three ways to define a point:  

 

1) Manual input. 

2) Select from the Coordinate Library. 

Input the point name, click the search button  to search from the Coordinate Point Library, Stake 

Point Library, and Control Point Library, Mapping Data Point Library, Cross-section Point Library. The 

searched results are displayed in the interface for user selection, and it will give a prompt if there is no 

result. 

 

1 
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Figure 4-2-2 Search from Point Lib   Figure 4-2-3 Search Results 

3. Advanced Search 

Click Advanced Search to enter the search interface. You can then search according to three 

conditions: Name, GroundCode, and Code, and search the points in the library (the code is only for 

coordinate points). 

      

Figure 4-2-4 Advanced Search   Figure 4-2-5 Advanced Search Interface 

4. Select from the map (Choose node online  and select a point on the map ) 

Choose node online: Click the icon to select line, then it will jump to the Select Point From Line 

interface, showing all nodes on the line. The map interface is displayed by default, and the map 

selection button is turned on .you can choose the node from the map or list. After selecting the 

node point, click OK in the upper right corner to perform staking points. 
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Figure 4-2-6 Map Interface    Figure 4-2-7 List Interface 

While choosing the node online, you can set the node through Configure. 

          

Figure 4-2-8 Select Point Config    Figure 4-2-9 Calculate Method    Figure 4-2-10 Configure Result 

Central Point: The map interface will display a gravity point of the polygon named C. 

 

Milestone: The default is 0. After setting the milestone value in the range, the starting point milestone 

in the map interface is the setting value. 

 

Calculate Method: It includes By Key Points and By Interval. The default is By Key Points. When the 

calculation method is By Interval, the default interval value is 10, but the line range value should not 

be exceeded. After the calculation mode is set, the map interface generates the corresponding feature 

points and key nodes and displays them on the map and in the list. 

 

When staking point, click  , it will automatically extract the coordinates of Stake Point Library, 

according to the positive sequence or reverse order to stake out. In Select Stake Point interface, tick 

Save to Stake Pts Lib: corresponding points can be saved to the Stake Point Library.  
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Offset stake: After the user inputs HD(horizontal distance) and Azi (azimuth), click OK, the software 

calculates the offset point and uses it as the current staked point. 

 

Figure 4-2-11 Offset Stake 

Nearest Stake Point: End-users click  icon, you can set the nearest point as the current stake point; 

in the process of approaching the nearest stake point, if you configure options such as voice prompts, 

precision, and prompt on approaching point, etc., the software will make a prompt, according to the 

distance, such as icons, voice, and words. 

4.2.1 Attribute info 

In the Stake Points interface, click the Attribute Query button  and select a point on the map. The 

software prompts with a pop-up window, which displays the Name, Desc, NEZ, and other information. 

The selected point can then be used for the stakeout. If the current point is being staked out, the Stake 

button only shows when the Offset Stake switch is open. Set the HD and Azi to stakeout. If the current 

point is not being staked out, it will show the Stake button. 

    

Figure 4-2-12 Attribute Info    Figure 4-2-13 Offset Stake Settings 
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4.2.2 AR Stake 

In the Stake Points interface, click the AR  to enter the AR Stakeout interface. This function is only 

supported by iHand30 (firmware V1.1.0 or above) or other Android 5.0 or above devices. 

 

The indication arrow on the AR stakeout interface shows the current stakeout direction, the distance, 

the height difference from the current point to the staked point, the Azimuth radar, 3D view, and 2D 

view. 

 

When it is staked out to the prompt distance, the interface automatically jumps to the Point stake (3D) 

interface, providing you with a more accurate stakeout indication. 

 

When the staked point exceeds the visible range of the stakeout, it will show a left, right, or backward 

prompt in the staking interface. 

           

Figure 4-2-14 AR Stake    Figure 4-2-15 AR Stake Interface    Figure 4-2-16 Point Stake(3D) 

4.2.3 Prompt of Closing to the Stakeout Point 

When the distance from the current point to the staked point is less than the prompt distance you set, 

the stakeout area will be reduced to the range of the set cue distance, and the software will display the 

zoom button  and center the staked point. The stakeout interface will now display two concentric 

circles with the center of the staked point. The larger radius indicates the prompt range that you set, 

and the smaller radius indicates the precision range you set. 
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Figure 4-2-17 Zoom Prompt1    Figure 4-2-18 Zoom Prompt2 

When you click , the map will revert to the size before the stakeout area is reduced, and the button 

changes to  . 

When the distance from the current position to the staked point is greater than the prompt distance +1, 

the map will revert to the size it was before the stakeout area was reduced, and the buttons  or 

 will disappear. 

    

Figure 4-2-19 Prompt within Distance    Figure 4-2-20 Out of Prompt Distance 

4.2.4 Angle of View 

In the Stake Points interface, click Configure → Display → Tool Display, after adding the Angle of 

View function button. You can use the Angle of View function on the Point Stakeout interface. 

 

When you click , it changes to  (in the open status). The blue pointing arrow  is fixed to the 

top of the screen. When you rotate the controller, the map rotates but the direction of the blue arrow 
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 does not change. When you click , it will change to  (in the off status), but the staked point 

does not change. The blue arrow  changes according to the azimuth of the controller. 

         

Figure 4-2-21 Angle of View1    Figure 4-2-22 Angle of View2    Figure 4-2-23 Angle of View3 

4.3 Stake Line 

The Stake Line is a simple local staking tool for the local line. There are four basic lines: Line, Arc, 

Spiral curve and Circle. The line can be defined by 2 Points and Point+Azi for the 2D-line or 3D-line. 

The arc can be defined by 2 Points and a unified curve metamodel with Point+Azi, and the spiral curve 

can be defined by a unified curve metamodel with Point+Azi. The circle can be defined by the center 

and radius. (Note: in order to unify the concept, we consider that the staking of one line is the stake of 

a circuit for each staking point. Its position is only indexed by the mileage.) 

Usually, the first step is to select the line type. 

Click  to enter Stake Line Library to define a line, including four types: Line, Arc, Spiral Curve, and 

Circle. You can add, edit, delete, create, load, save, save as, and open data for the data of Stake Line 

Library.  
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Figure 4-3-1 Stake Line Interface    Figure 4-3-2 Stake Line Lib 

     

Figure 4-3-3 Four Line Types     Figure 4-3-4 Add Arc 

-Add: Add the relevant parameter information of Line, Arc, Spiral Curve, and Circle according to your 

requirement.  

-Edit: Edit selected existing line elements. 

-Delete: Delete the selected stake line. 

-Create: New *.line file. 

-Load: Accumulate line metafiles, the software will select the line element in the file and then switch to 

other projects and switch back. The loaded line element will be displayed in the Stake Line Library. 

 

Line library file (*.line) is the internal format of the software; which is generated after added, edited and 

saved by software. Two-point-line file (*.2pt) is a public format, it can be edited by the user, choose to 

load Two-point-line to the Stake Library in the software.  

-Save as: Save current line element information. 

-Open: Open the *.line file saved in /ZHD/Project/ROAD/Unnamed. 

The following are the descriptions of each line type. 

4.3.1 Define Line 

Click Add → Line to select the line type, Line and 3D-line. Two methods can be used to define the line: 

2 Points and Point + Azi. If you select the 2 Points method, there will be an option Named from the 

start point-the endpoint. After ticking the option, the line will be automatically named after the start and 

endpoint. The users cannot edit the line name. When you cancel this option, the software stops 

automatically naming the line after the start and endpoint, without modifying the original line name. 
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Figure 4-3-5 Add Line    Figure 4-3-6 Add 2D Line    Figure 4-3-7 Add 3D Line 

Click Sample Point , input the mileage of point to be staked. Among them, the Milestone and Offset 

will automatically accumulate according to the Step value. You can also add, edit and import the 

Station Offset File. Click OK to enter the stake interface. (For example, if you are currently in the 

Sample Point interface, the point with the set milestone and offset that you input will be staked when 

you click OK in the upper right corner. If you are currently in the Station Offset file interface, the point 

with the mileage and offset of the Station Offset File will be staked when you click OK,) 

     

Figure 4-3-8 Instruction of Stake    Figure 4-3-9 Real-time Mileage 

1- Miles of current stake point K0+0.00 

2- Stake tips 

3- Display real-time mileage, real-time display the distance from the current point to the line segment  

Sample Point 

Calculate the position of the stake point and input mileage (if necessary, calculate the side pile), the 

Up and Down icons in the interface help to quickly adjust the mileage value, unit adjustments are the 

3 

1 

2 
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steps, the data is recorded in global variables. So each time you enter the interface, the software 

automatically calculates a mileage/offset as the default value to save time. For example, to stake a 

pile every 10 meters set the step to 10, the mileage of the starting staked point is 1850. After the end 

of the first point to be staked, enter this interface again, the software will automatically calculate the 

mileage as 1860, click OK and continue to work. 

    

Figure 4-3-10 Sample Point    Figure 4-3-11 Set Sample Point 

1- Manually increase the Milestone, automatically increase Step each time clicking Mileage. 

2- Manually increase the Offset, automatically increase Step each time clicking Offset. 

- Ignore the Key Point: When ticked, the feature points will be automatically skipped during the 

stakeout, and the stakeout will be performed according to the set mileage. 

-Milestone: Mileage of current staked points. 

-Offset: In the direction of increasing mileage, the distance from the current point to the vertical line of 

the defined line (left is negative and right is positive). 

-Step: Each time you enter the interface, the added value of the mileage. 

-Direction: Taking a defined line as the reference, set the direction to the left or to the right. 

-Save to Stake Pts Lib: When ticked, the staked points will be automatically saved to the Stake Point 

Lib. 

Station Offset 

You can set the Station and Offset by manually adding or editing, or you can directly import the edited 

Station Offset File (*.csv) for stakeout by directly operating Add, Edit, Delete and Clear for the 

contents. 

Add: Add mileage and offset under the current Station Offset File list. 

Edit: Click to select a station offset point to modify the data. 

Delete: Click to select a station offset point to delete the data. 

Clear: Clear all content under the Station Offset File list. 

2 

1 
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Figure 4-3-12 Import Offset File    Figure 4-3-13 Add Station Offset 

Stake the point in the specified milestone, according to the prompt. Place the current point (triangle) 

close to the target point (circle with cross). 

 

Notice:  

1. Offset is generally used when the roadside pile; Left or Right in Deflection 

represents the left and right of the line, respectively; input distance from the 

centerline to the edge line, in increments of zero, to stake a specific mileage. 

2. When opening the real-time mileage function, the software will project the 

current position point on the line and display the mileage of the projection point, 

which is helpful to determine the walking direction. 

3. if currently in the Sample Point interface, after clicking OK in the upper right 

corner, the point with the set milestone and offset your input will be staked; if 

currently in the Station Offset file interface, click OK, the point with the mileage 

and offset of the Station Offset File will be staked 

 

Select the 3D-line to define a three-dimensional line, defined in two types: 2 Points and Point + Azi + 

Slope. 

When the 3D-line is staked, the defined stake milestone is the 3D length, not the traditional 2D 

projected length. 

 

In order to guide the destination, the software draws a connecting line, just make sure that the current 

walking direction coincides with the connecting line, the walking direction is correct. At the same time, 

there are some guidelines below, for some areas with a strong sense of direction and clear pointing, 

you can follow the instructions guide. 

 

 



    
Hi-Survey Road User Manual 

 

149 

 

 

 

Notice: Blue arrow is the position and velocity direction of the current point, the 

circular icon is the target point, the dotted line is the line connecting the current 

point and the target point. As long as the walking direction coincides with the 

connecting line, it is possible to ensure that the stake direction is correct, so that 

the target point can be easily found. The following information box is the staking 

information, indicating the difference between the walking direction and the 

vertical direction. 

 

Stake instructions can be selected in two types: Front-Back, North-South. You can set in Configure → 

Stake → Line Stake Guide Type. 

If you turn on Real-time Mileage HT Diff, the current mileage will be displayed on the interface, and its 

connection with the current point will be drawn. Draw a small dot on the line to indicate the position of 

the projection; Real-time Mileage is also used to determine whether the direction of walking is correct 

(compare real-time mileage with stake point mileage, and increase direction).  

         

Figure 4-3-14 Stake Configure    Figure 4-3-15 Reach the prompt range    Figure 4-3-16 Reach the set precision 

- Green: When close to the stake point it prompts Reach the prompt range. 

- Red: Stake success prompts Reach the set precision. 

 

You can also turn on the staking voice prompt in Configure → Stake → Voice Prompts. When you 

reach the preset prompt range, and reach the lofting accuracy, the controller will give you different 

voice prompts. 

4.3.2 Define Arcs and Spiral Curves 

Click the Arc or Spiral Curve to define the line type; after defining the line style, the stakeout function 

will be similar to Line. You only need to click the Stake Point  to input the mileage of point that is to 



    
Hi-Survey Road User Manual 

 

150 

be staked. The Milestone and Offset will automatically accumulate according to the Step. Click OK to 

enter the stake interface. 

         

Figure 4-3-17 Add Arc    Figure 4-3-18 Add Spiral Curve    Figure 4-3-19 Radius of Spiral Curve 

If you select the 2 Points method to define Arc, there will be an option Named from the start point-the 

endpoint. After ticking the option, the line will be automatically named after the start and endpoint by 

the software. The user cannot edit the line name. When you cancel this option, the software stops 

naming the line after the start and endpoint automatically, without modifying the original line name. 

 

-2 Points: Input Line Name, Start and Endpoint coordinates, Start Station, Radius and Direction; 

-Point + Azi: Input Line Name, Start Point coordinates, Start Station, Radius, Azi and Direction. 

 

-Radius of Start: Radius of the start point of the Spiral curve, tick ∞ to indicate straight line.  

-Radius of End: Radius of the endpoint of the Spiral curve, tick ∞ to indicate straight line.  

4.3.3 Attribute Info 

In the Stake Line interface, click the attribute query icon , select an existing line on the map, and 

the software will prompt with a pop-up window to display the Name, Length, NEZ, and other 

information. If the current line is being staked out, the Stake button will not be shown; if the current line 

is not now being staked out, it will show the Stake button directly. 
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Figure 4-3-20 Current Stake Line Info    Figure 4-3-21 Line Info 

4.3.4 Prompt of Closing to the Stakeout Point 

When the distance from the current point to the staked point on the line is less than the prompt 

distance that you set, the stakeout area will be reduced to the range of the set cue distance, and the 

software will display the zoom button  and center the staked point. The stakeout interface will now 

display two concentric circles with the center of the staked point. The larger radius indicates the 

prompt range that you set, and the smaller radius indicates the precision range you set. 

     

Figure 4-3-22 Zoom Prompt1    Figure 4-3-23 Zoom Prompt2 

When you click , the map will revert to the size before the stakeout area is reduced, and the button 

changes to  . 

 

When the distance from the current position to the staked point is greater than the prompt distance +1, 
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the map will revert to the size before the stakeout area is reduced, and the buttons  or  will 

disappear. 

     

Figure 4-3-24 Prompt within distance    Figure 4-3-25 Out of Prompt distance 

4.4 Mapping Survey 

Mapping Survey is the work of measuring the plane coordinates and elevation of the control points 

needed for the mapping. 

 

Figure 4-4-1 Mapping Survey 

The accuracy of the mapping data, relative to the RMS of the adjacent level control point, should not 

be greater than 0.1mm on the mapping; the RMS of elevation should not be greater than 1/10 of the 

basic contour distance.  

Enter the Mapping Survey interface to view the mapping survey progress, click Configuration setting 

parameters, the configuration page can automatically record the last input, and the name of the 

mapping point can be increased automatically. 

-HRMS: The horizontal RMS of the current point;  
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-VRMS: The vertical RMS of the current point. 

    

Figure 4-4-2 Mapping Survey Interface    Figure 4-4-3 Start Mapping Survey 

    

Figure 4-4-4 Mapping Survey Configure1    Figure 4-4-5 Mapping Survey Configure2 

1-Edit point’s name or it will automatically add by default 

2-Input code of map point      

3-Motherboard reset interval (s) 

4-Average Progress per round   

5-Motherboard reset progress 

6-After the parameters are set, click Start 

7-Click to select target high type, input target height 

8-Measurement rounds and progress 
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9-Stop or pause during mapping data collection 

10-Select Plane Limit Type 

11-When the plane limit typed is selected as the integrating, then the integrate is set here, conversely, 

it is each component 

12-Press to open, you need to set Σn, σe, Σz precision. 

During the collection process, swipe to the right in the Mapping Survey interface to view the detailed 

average data of the currently collected mapping data. 

   

Figure 4-4-6 Stake Configure    Figure 4-4-7 Add Station Offset 

4.4.1 Mapping Data 

Project interface → Mapping Data; you can view all mapping points, and you can also create, open, or 

search for data. Long press the mapping points to delete and edit. 

       

Figure 4-4-8 Mapping Data    Figure 4-4-9 Check Data    Figure 4-4-10 Edit Data 
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4.4.2 Mapping Survey Report export 

Project interface → Data Transfer; click Mapping Data to export MappingPoint Report(*.html) or 

MappingPoint Report 2.0(*.html). The report shows Antenna HT, Storetime, and XYZ and BLH values 

the mapping point (the optimal value in 3 rounds, the optimal value of total data, and the average 

value of these 4 data), DX, DY, DH of each average point, Xrms, Yrms, Hrms, Dp-max, Dh-MAX, 

according to the Qualified rate(%) you can judge whether the point is available. 

     

Figure 4-4-11 Mapping Data Export    Figure 4-4-12 Mapping Point Report 

Notice: Mapping Point Report is derived from the software's existing mapping 

survey calculation, and the result is consistent with the mapping data library. 

Mapping Point Report 2.0 is based on the averaging method and is inconsistent with 

the mapping data library. 

4.5 Menu 

Click the menu button  of the controller in the Detail Survey/Stake Point/Stake Line/Store 

Cross-section interface; it will pop up a menu button for quickly jumping or data viewing between 

associated interfaces. 
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Figure 4-5-1 Connection Interface1    Figure 4-5-2 Connection Interface2 

Click the menu button  of the controller in the Base/Rover interface, to pop up the device icon 

to quickly jump to the device connection interface. 

 

Figure 4-5-3 Connection Interface3 
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Road 

This chapter contains:  

 

 -  Operation procedure 

 -  Stake road 

 -  Road design 

 -  Store cross-section 

 -  Cross section Point 

 -  Surface 

 -  Elevation difference 

 -  Surveying configure 
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5.1 Operation Procedure 

The road engineering survey contains the route reconnaissance and design survey and road 

construction survey. 

1. Route reconnaissance and design survey 

Preliminary measurement: Control measurement. Measure the strip topographic map and profile 

diagram, collect geological hydrological data along the line, do the paper location or site location and 

make comparison plans to provide a basis for the preliminary design. 

Decided measurement: Route centerline survey on the route of the selected design. Measure the 

profile diagram, cross-sectional profile, bridges and culverts, route crossing and facilities along the 

route to provide information for the construction design. 

2. Road construction survey 

Follow the design drawings to restore the road, measure the subgrade side piles and vertical curve, 

and do the project completion acceptance measurement. 

5.2 Stake Road 

Stake road is the key function of Hi-Survey Road. The excellent working mode will make the surveying 

more efficient and systematic. 

 

Stake roads and lines are mostly the same. The definition of the road is more complicated than the 

definition of the line, it will use the profile and cross-section to design the line, so the calculation is 

more complicated. But, relatively speaking, the difference between the stake road and stake line is 

only the operation of defining the line; point collection and staking-out operation are the same. 

5.2.1 Load in the Road Data 

The operation is as follows: 

1. Click  to enter the Road Lib interface. You can click More → Import to load the road or .xml file. 

You can also click Add to add the road manually. 

     

Figure 5-2-1 Stake Road    Figure 5-2-2 Road Lib 
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2. When you add a new road, you can import the Broken Chainage, Centerline, Profile, Cross-

section, Side-section or Construction design files. After each file has been imported, click 

Apply on the corresponding file interface.

Figure 5-2-3 New Road    Figure 5-2-4 Road Design    Figure 5-2-5 Intersection 

3. After successfully applying the design file, the interface will prompt that the Road Alignment data

has been updated! Click OK to return to the Road Lib interface, which will prompt Success. To view

whether the design file has been added click Start Station, End Station and File Path for easy

verification.

4. Finally, select the road to be staked in the list, and click OK on the Stake Road interface for the

stakeout.

Figure 5-2-6 Road Alignment Updated    Figure 5-2-7 Road Information    Figure 5-2-8 Road Path 

Click  to switch the perspective (top view or cross-section view of the road), and there will be the 

Side-section for users to choose if the side-section and cross-section are enabled. If there is no 

elevation for the profile, cross-section elevation collection and side-section staking-out can’t be done. 

Because the elevation is unknown, it’s impossible to get the height of filling and cutting. 
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In the cross-section view, the red dot indicates the corresponding position of the current position in the 

cross-section. In the upper left of the interface, the current real-time mileage and the offset from the 

centerline are displayed. At the bottom left of the interface, the height of filling and cutting is displayed. 

     

Figure 5-2-9 Top View    Figure 5-2-10 Cross-section View 

5.2.2 Confirm the location of Stakeout Points 

Click Sample Point icon , input the mileage of point to be the staked. Among them, the Milestone 

and Offset will automatically accumulate according to the Step. Also, you can do the operation Add, 

Edit and Import for Station Offset File. Click OK to enter the stakeout interface. (For example, if you 

are currently in the Sample Point interface, the point with the set milestone and offset that you input 

will be staked when you click OK in the upper right corner. If you are currently in the Station Offset file 

interface, the point with the mileage and offset of the Station Offset File will be staked when you click 

OK.) 
 

    

Figure 5-2-11 Sample Point    Figure 5-2-12 Station Offset 

1- Manually increase the Milestone, automatically increase Step each time clicking Mileage. 

1 

2 
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2- Manually increase the Offset, automatically increase Step each time clicking Offset.

Sample Point 

Each time you enter this interface, the Milestone and Offset are automatically incremented by the Step. 

You only need to enter this interface to confirm the reduced data input negative value, and you can 

perform the stakeout work. If you need to make an adjustment, click the icon  to reduce or click 

to increase it. Or you can manually input to complete the data input work. 

Station Offset 

You can set the Station and Offset by manually adding or editing, or you can directly import the edited 

Station Offset File (*.csv) for stakeout by directly operating Add, Edit, Delete and Clear for the 

contents. 

-Apply: Stake out the sample point; the Stake Road interface will display the dashed line connection 
between the current point and the staked point, as well as the stakeout indication.

5.2.3 Stakeout 

This process is the same as the stake line operation. 

5.3 Road Design 

You can directly click the Road Design or Road Designer File in the Stake Road interface to enter the 

Road Lib interface, and then import, add or edit the road file (*.road). Each road file includes the Road 

Name, Broken Chainage, Centerline, Profile, Cross-section, Side-section, and Construction design file. 

You can load the corresponding design files according to your needs. 

Figure 5-3-1 Import Road File    Figure 5-3-2 Road Design 

Broken Chainage: Only support the Broken Chainage File(*.BCP) file. 
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Centerline: Intersection method supports Point of intersection(*.PHI), Poling Data(*.CSV); Element 

methos supports Line Element File(*.sec), HDPM(*.pm), WDPM(*.pm), LandXML(*.xml) and Poling 

Data(*.CSV); Coord method supports Coord File(*.zline). 

Profile: Support PVI file(*.PVI) and LandXML(*.xml). 

Cross-section: Support Template File(*.TPL) and LandXML(*.xml). 

Side section: Only support the BPI file(*.BPI). 

Construction design file: Only support Construction File(*.BCI). 

After the corresponding design file is loaded, click More → View to enter the line preview interface; 

click Apply to return to the Road Design interface and prompt that RoadAlignment data was updated!  

The Profile is taken as an example for the explanation below. 

 

Figure 5-3-3 Profile Editor 

Add: Input the Station, Height, and Radius manually to add the Slope point data. 

 

Figure 5-3-4 Slope Point Data 

Load: Load the edited or saved slope point data. 
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View: View the slope point data in the list. Click the icon  on the right to display the detailed slope 

point information. Then input the mileage in the box below, and click Check Station to view the height 

value of the point which corresponds to the input mileage. 

 

Figure 5-3-5 Profile Preview 

Apply: After the profile design data has been loaded and edited, click Apply to update the latest 

current data. When the required design files are all completed, click OK to complete the design of the 

road file. 

 

Figure 5-3-6 Profile updated 

Save: After the profile design data has been loaded and edited, click Save to save the current data as 

a PVI file (*.PVI). The default save path is in the data/road profile folder under the current project file. 

 

Long press data in the Profile Editor interface to Delete, Insert (insert a new slope point data before 

the point) or Edit. 
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Figure 5-3-7 Profile Editor 

Notice: 

1.It’s not possible to do the next mileage collection and stakeout without the

centerline, and the slope cannot be staked out without the cross-section design

line.

2.If there is no road when the user enter the road stake out interface from the

main interface, the software will jump the road file list automatically. The user will

can create or select road of the list to stake out. Meanwhile， it will prompt “Road

data has not been defined, please set it first”

3.If the user return without any operation in the road files list, the software will

return the road stake out interface and there is no road data to stake out.

5.3.1 Broken Chainage refers to when the station number is discontinuous due to local rerouting or 

segmentation measurement. The overlap of the stations is called a long chain, and the discontinuity of 

the station is called short-chain. Normally, the Broken Chainage will be marked directly on the 

Straight line, curve and corner table. 

Click Broken Chainage to enter the Broken Chainage Pile interface. You can then add the Broken 
Chainage pile. Long press one date to delete and edit the pile. You can also Load, Apply and Save 

the Broken Chainage File (*.BCP). 
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Figure 5-3-8 Broken Chainage Pile    Figure 5-3-9 Add Broken Chainage    Figure 5-3-10 Edit Broken Chainage 

-Add: Click Add to add the Broken Chainage pile. Input the Name, Front Mileage, and Back Mileage, 

then click OK.

-Edit: Long press one data, click Edit to modify Name, Front Mileage and Back Mileage of the pile 
point, then click OK.

-Delete: Long press one data, click Delete to delete the selected Broken Chainage pile. The selected 

data can be deleted in batches.

-Load: Click Load to directly import an existing Broken Chainage File (*.BCP).

-Apply: After Broken Chainage pile has been loaded and edited, click Apply, it will return to the Road 

Design interface and prompt Broken Chainage data was updated!

-Save: Click Save to save the current Broken Chainage file in (*.BCP) format. The default saves path 

is ZHD/Project/ROAD/Unnamed/data/road profile. 

5.3.2 Centerline 

There are many methods for centerline, including Intersection, Element, and Coordinate. The 

intersection method is based on certain conventions (for example, a single intersection line defines the 

combination of line elements in the intersection point as Spiral CurveArcSpiral Curve), which has 

certain restrictions on the type of lines. The element method can combine line shapes arbitrarily, 

supporting complex curves, including oval lines, multi-intersection curves, and imaginary intersection 

points, etc.. And it supports for polyline but .sec file will lose polyline corner information. The 

coordinate method is similar to the Element method, but the definition of each line element is 

determined by defining coordinates of the start and endpoint. The line element format (*.sec) files 

won’t contain the polyline corner information, so if the polyline corner information is needed, please 

save the file as the Coord File (*.Zline) format. 

Hi-Survey Road supports the Intersection, Element and Coordinate methods and the default line 

element combination within the intersection is the straight line → the first spiral curve → arc → the 

second spiral curve.  

It supports the smooth spiral curve, and the non-smooth spiral curve supports the transverse import. 



    
Hi-Survey Road User Manual 

 

166 

 

Notice:  

1. Two spiral curves can be asymmetrical. 

2. The reverse loop needs to be treated as a non-reverse loop, such as adding an 

intersection. 

3. It supports the imaginary intersection point. 

4. It supports the local curve, and the spiral curve length can be zero. 

 

1. Intersection method 

 

Figure 5-3-11 Intersection Graph 

-Intersection JD1/JD2: The intersection of two adjacent lines. 

-ZH: The point where the straight line intersects with the first spiral curve, that is, the start point of the 

first spiral curve. 

-HY: The point where the first spiral curve intersects with the circular curve, that is, the endpoint of the 

first spiral curve. 

-YH: The point where the circular curve intersects with the second spiral curve, that is, the start point 

of the second spiral curve. 

-HZ: The point where the second spiral curve intersects with the straight line, that is, the endpoint of 

the second spiral curve. 

-ZH-HY: The first spiral curve. 

-YH-HZ: The second spiral curve. 

-HZ-ZH: The straight line. 

-HY-YH: The arc. 

 

Click Intersection to enter the intersection table data-editing interface.  
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Figure 5-3-12 Intersection    Figure 5-3-13 Intersection Parameters Figure 5-3-14 Virtual Point 

 

-Add: Add intersection data, input the Name, N, E, Station (only need to input the mileage of the first 

two points), Radius, L of Spiral in and L of Spiral out, according to the Straight line, curve and corner 

table. If the radius and spiral length are known, input the value; if none, no need to input. 

-Load: The user clicks “load” and selects the corresponding design data of the following format data 

Points of intersection(*.PHI), Poling Data(*.CSV), XY File (*. XY), HYDL File(*.hjd), Road design Table 

(*.xls, *.xlsx), Surveyor Table (*.xls, *.xlsx). 

When select the intersection method, can load in Poling Data(*.CSV), Surveyor Table (*.xls, *.xlsx) to 

initialize intersection. 

When select the element method, can load in the element file as Line Element File(*.sec), 

HDPM(*.pm), WDPM(*.pm), Poling Data(*.sec), Elcad(*.ICD), Road design Table (*.xls, *.xlsx), 

Surveyor Table (*.xls, *.xlsx). 

-View: Check whether the centerline is right. 

-Compute: Input Station and Offset; it can check the coordinates; input the coordinates, calculate the 

station and offset. 

-Detail: Click to enter the interface to check the detail parameters, including the Intersection Points, 

Line Element and Key Pts. 

-Input Limit Point: Click  to input the limit point manually. Users can also select it from the point list 

or do a real-time collection to get the point. 

-Change Line: Click  to choose the point to be changed (start and endpoints are not selectable), 

and change it by Manual input or Select from map. 

- Road Export Setting Transition Point: Click  to view corresponding auxiliary points and auxiliary 

dashes in the figure. 
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Figure 5-3-15 Centerline Preview 

-Apply: The intersection file is saved in (*.PHI) format. The default save path is in the data/road profile 

folder under the current project file. 

-Insert: Insert intersection data above the selected point. 

-Edit: Edit the intersection data that has been entered 

 

When the software encounters the data of the suspected oval curve, it will automatically recognize it. 

After manually changing the red marked data according to the prompt, click OK to apply the check. 

     

Figure 5-3-16 Warning    Figure 5-3-17 Modify Wrong Data in Red 

When involving the virtual intersection, return curve (turning over 180 degrees), the Element method 

can support, in addition, the Intersection method supports Virtual Point switch. 

The first point of the virtual cross combination is normally entered, and after the second point is input, 

open the Virtual Point switch. 
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Figure 5-3-18 Intersection Points   Figure 5-3-19 Add Intersection Point 

-Delete: Delete the existing intersection point. 

 

Figure 5-3-20 Edit Intersection Points 

2. Element method 

Element alignment decomposes the combination of complex route lines into several linear units. If 

there is information (coordinates, tangential direction, the radius of curvature, etc) about the starting 

point of the route plane curve, the unit that extends in any direction can be set from the start point, and 

the endpoint information of the unit can be calculated. Then the end of this unit can be used as the 

starting point for the next unit. 

Common lines contain the straight line, arc and spiral curve. Users can input the line manually or load 

files directly, including the Line Element File (*.sec), HDPM (*.pm), WDPM (*.pm), LandXml File (*.xml) 

and Poling Data (*.CSV) formats. 

In the general working process, users need to input the coordinates of the starting point, Station and 

Azimuth. Click Add to choose the line type and input the information. 

-Line: Expressed by L, input the Length, Start Offset, and Start Azimuth. 
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-Arc: Expressed by A, input the Start Radius, Length, Direction, Start Offset, and Start Azimuth. 

-Spiral Curve: Expressed by S, input the Start Radius, End Radius, Length, Direction, etc.. 

 

In the online element method, the radius of the start and endpoint should be specially treated for the 

oval shape (the common palliative curve). To solve the correct radius of the start and the graph for 

incomplete gentle bending: 

A×A÷[A×A÷R－Ls] 

It is suggested that you use Poling Data (*.CSV) for fast-import. Just add two columns of slow bending 

parameters, A1 and A2, behind Poling Data (*.CSV), and click load to build the oval curve line. 

Click Start to enter the element interface to edit the start point. 

         

Figure 5-3-21 Start Point    Figure 5-3-22 Start Point Information    Figure 5-3-23 Add Element 

Click View to preview and edit the centerline, enter the mileage in the box at the bottom right corner. 

-Calculate: Input mileage and offset, check the coordinates; input coordinates, you can calculate back-

projection distance and offset. 

-Details: It can display detailed curve elements of the line, including line segment type, feature point 

coordinates, starting distance, starting position and other parameters. 
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Figure 5-3-24 Centerline Preview    Figure 5-3-25 Element 

3. Coordinate method 

The coordinate method is similar to the element method, but the definition of each line element is 

determined by defining coordinates of the start and endpoint. It can only load the Coord File (*.Zline) 

format. 

In the general working process, users need to input coordinates of the start and endpoint.  

Click Start to input the station and coordinate manually 

Click End to input the station and coordinate manually, or select from the point list.  

Click Add to choose the line type to input the line information. 

 

-Line: Input the coordinates of the start and endpoint. 

-Arc: Input coordinates of the start and endpoint, radius (∞ represents infinity, means Line), direction 

(the previous direction is the reference direction of deflection). 

     

Figure 5-3-26 Add Coordinate Data    Figure 5-3-27 Input Coordinate 
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5.3.3 Profile 

The profile is an expression of the vertical movement of the road (the line fluctuates). It can be added 

manually, and users also can load the file in the PVI file (*.PVI) or LandXml File (*.xml) format. 

     

Figure 5-3-28 Profile Editor    Figure 5-3-29 Slope Point Data 

In the general working process, click add slope to change point data, including Station, Height, and 

Radius (radius of the vertical curve). All slope change point elements of the line are added in the 

sequence of mileage. 

Click Add to add the slope point data and Long press the record to delete, insert or edit it. Click View 

to check the profile preview, and click Check Station to input the station value to check the height of 

the station. 

5.3.4 Cross-section 

The cross-section interface contains three options, including Standard, SuperEle, and WidePlus. 

Users can add, edit and delete the cross-section data. Here are two types of slope ratio inputs, 

percentage or ratio. 

1. Standard 
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Figure 5-3-30 Standard      Figure 5-3-31 Template Editor 

-Name: The name of the current plate. 

-Grade: From the middle of the road, uphill is positive and downhill is negative. The slope value is the 

ratio of the height difference between the two ends of the plate and the width of the plate. 

-Wide: The width of the current plate. 

-Curb: Click to input the height difference of the curb. 

-Left-right Identity: The selection indicates that the left and right slopes are consistent, and the right 

slope data will be covered with data symmetrical to the left slope (the original right slope data will be 

covered and cannot be recovered). 

In the general working process, click Add to define the cross-section, select slope ratio input mode, 

slope ratio, and width, and click display to check whether the graph is correct after editing. 

-Check station: Enter station value to view the specified mileage profile 

-Cross Line Info: Click  to view the detail cross line information. 
 

 

Figure 5-3-32 Template Preview 
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Notice: There is only one cross-section in memory. A road has different cross-

sections at different road sections. Users can predefine several typical cross-

sections according to their needs, and then transfer the cross-sections suitable for 

the terrain in different sections to stake out. 

 

2. SuperEle 

This is a way to make the road a lateral high-internal one-way cross slope in order to reduce the 

centrifugal force generated by a vehicle driving on the curve road. 

Select the cross-sectional block corresponding to the SuperEle.  

     

Figure 5-3-33 Standard      Figure 5-3-34 SuperEle 

The motor vehicle is set to be SuperEle as an example. 

     

Figure 5-3-35 SuperEle      Figure 5-3-36 Add SuperEle 

If the SuperEle change points on the drawing are read as follows: 
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SuperEle change point 1: Milestone 20 Grade -1.5% 

SuperEle change point 2: Milestone 30 Grade 2% 

SuperEle change point 3: Milestone 40 Grade 2% 

SuperEle change point 4: Milestone 50 Grade -1.5% 

     

Figure 5-3-37 Edit SuperEle      Figure 5-3-38 View SuperEle 

Click View to check it after adding SuperEle points. 

Enter the Milestone in the lower right box and click Check Station to view the cross-section in the 

corresponding milestone. 

   

Figure 5-3-39 Template Preview      Figure 5-3-40 Check Station 

3. WidePlus 

In order to change the road surface from the normal width to a curve, a widened width is set, so a 

transition zone of curve widening needs to be set. In the transition zone of curve widening, the road 

surface gradually varies in width. There are different setting methods of different road properties and 

levels. 
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In the WidePlus interface, users can input the widening change point information, according to the 

design drawings. 

If the WidePlus change points on the drawing are read as follows: 

     

Figure 5-3-41 WidePlus   Figure 5-3-42 Add WidePlus 

WidePlus change point 1: Milestone 20 Wide 4.5 

WidePlus change point 2: Milestone 30 Wide 5.2 

WidePlus change point 3: Milestone 40 Wide 6 

WidePlus change point 4: Milestone 50 Wide 5.2 

WidePlus change point 5: Milestone 60 Wide 4.5 

     

Figure 5-3-43 Edit WidePlus   Figure 5-3-44 View WidePlus 

Click View to check the template preview, and input the station value to check it. 

Enter the mileage in the lower right box and click Check Station to view the cross-section in 

corresponding mileage. 
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Figure 5-3-45 Template Preview       Figure 5-3-46 Check Station 

 

 

 

 

 

5.3.5 Side-section 

In the Side-section interface, users can add, load, apply, and save the side-section. 

-Add: Click to choose and add the Fill or Cut. Input the side-section name, and edit the side-section 

features. 

      

Figure 5-3-47 Side-section       Figure 5-3-48 Add Side-section 

Notice: Users can switch Standard, SuperEle and WidePlus interfaces to view 

road data, and click Apply on any of the three interfaces to apply the current 

cross-section (Standard + SuperEle + WidePlus) to the road after confirmation. 

Users can also click More → Save to save it as the Template File (*.TPL) for 

subsequent loading and reuse. 
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-Load: Click to load the BPI File (*.BPI), and the side-section list will show all the section information in 

the current file. 

 

Figure 5-3-49 Load BPI File 

-Apply: Click to apply the slope in the current side-section list to the current project road, and it will 

prompt Use data successfully. 

-Save: Click to save the file in the BPI File (*.BPI) format. And the saved *.BPI file can be loaded 

successfully. 

 

-Delete or Edit: Long press the record to delete or edit the side-section information. Click Delete to 

delete the selected side-section data. Click Edit to do the operation Add, Edit, View and Delete for the 

information such as Factor name, Start deltaH and so on. In the interface, click Add on the bottom, 

Hillslope, Platform, and Ditch will be displayed. 

        

Figure 5-3-50 Side-section       Figure 5-3-51 Cut       Figure 5-3-52 Side Preview 
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5.3.6 Construction Design 

Click Construction design to enter the editing interface. Hi-Survey Road supports four types of Cover 

culverts, Circular culverts, Passageway and Footbridge, and supports two methods: Slanting and 

Straight.  

      

Figure 5-3-53 Construction Editor       Figure 5-3-54 Construct Info       Figure 5-3-55 Preview Construct 

-Add: Click Add to select the construction type and construction practice on the Construct Info 

interface, input the Station, Angle, Front width, Back width, Left length, Right length, Center height, 

and Slope, click OK. 

-View: Click View to enter the construction preview interface, you can view the designed construction 

graphic. Click the selection bar below to switch the multiple construction graphic display. 

-Apply: Click Apply to refresh the data. 

-More: Click More to load the construction design file or save the designed construction. 

5.3.7 Road Data Export 

The road data will export in the road library. 

The steps as below: 

(1) Select the road in the road list, click “more     export” to export the road file. 
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Figure 5-3-56 Export interface 

 (2) The default export format is Center Station File (*.csv). Click the Set button to enter the Road 

Export Setting interface and display the information of Start Sta, End Sta, Station Interval, Sequence 

Rule. Set and export the contents of each center station by customizing the relevant configuration. 

Then click OK to return to the Export interface, and export the data according to the settings. 

 

     

Figure 5-3-57 Center Station Data Export       Figure 5-3-58 Road Export Setting 

(3) Click the bottom enter the Line Element File(*.sec) export. The Set button of left corner will not be 

displayed.  
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Figure 5-3-59 Line Elements Data Export  

(4) Input the name of the data in the box and click “OK” to export the data. 

 

Figure 5-3-60 Name interface 
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5.4 Store Cross-section 

  

Figure 5-4-1 Store Cross-section 

Click Road Designer File  to load existing files, then input the mileage, it will automatically calculate 

the cross-sectional position at that mileage, and display a dashed line as a reference line on the graph. 

When approaching this reference line, the software will calculate the distance between the current 

position and the reference line. If the distance is less than the setting value of the cross-sectional 

tolerance (the value can be set in Configure → Data → Cross-section Precision), users can do the 

cross-section point collection. 

 

-Define: Click  to define a specified mileage of the cross-section and input other settings. It will 

automatically calculate the cross-sectional position, at that distance, and display a dashed line as a 

reference line on the graph. 
 

-Store: Click  to collect points and input the cross-section information. If the Center Point is selected, 

the point will be used as the reference point of the cross-section. The cross-section point library will 

store the horizontal elevation of other points on the cross-section relative to the center point (each 

section must define a section mileage and collect the center point, otherwise the section points 

collected in this section will be invalid, or users need to add the center point manually afterward). 

-Road Designer File: Click  to load existing files 

-Switch View: Click  to switch to the cross-sectional view and check it. 

-Intersection: Click  to jump to intersection survey interface, please refer to Tool Chapter. 



    
Hi-Survey Road User Manual 

 

183 

     

Figure 5-4-2 Cross-section Info1      Figure 5-4-3 Cross-section Info2 

     

Figure 5-4-4 Define      Figure 5-4-5 Road Lib 

     

Figure 5-4-6 Top View      Figure 5-4-7 Cross-section View 

When adding or 

subtracting mileage 

for the next sample 

point during cross-

section collection, 
add feature point 

for judgments. 
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Notice: The mileage prompt and feature point judgment function makes it easy 

for you to check whether the current section has been collected to prevent missed 

measurement when collected the current mileage section and entering the next 

mileage collection. 

 

 

 

5.5 Cross-section Points 

Cross-section data can be edited and managed in the Cross-section Points interface. 

     

Figure 5-5-1 Cross-section Points   Figure 5-5-2 Output Directory 

    

Figure 5-5-3 Format1      Figure 5-5-4 Format2 

-Center Point: Click to add the center point. 

-Open: Open other point files in the project. 
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-Export: Export files to other data formats, including HDMX (*.DMX), CRECG (*.txt), HDM (*.hdm), 

WDMX (*.dmx), BGHN (*bghn), HDMG (*.DMG), South CASS7.0 (*.dat), South CASS7.0 (*.hdm), 

Defined (*.txt) and EICAD (*.HDX). 

-Load: Load and merge cross-section data in current or other projects. 

-New: Create a new cross-section points file in the project. 

-Work Cal: Click to enter the Earthwork Calculation interface. 

In the Earthwork Calculation interface, it will load all the cross-section points by default to the 

calculation list.  

 

Figure 5-5-5 WorkCal 

Click the point name to choose whether to participate in the calculation. 

 

The earthwork calculation requires at least two cross-section points and corresponding center points 

within the range of start and end mileage. If the Multi-transect mode is selected, please input the 

projection distance limit in the input box. The result of the calculation is the amount of earthwork 

between the two cross-sections that are closest to the start and end mileage. 

    

Figure 5-5-6 Earthwork Calculation      Figure 5-5-7 Multi-transect 
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The earthwork calculation provides two methods, the Average Method and Pyramid Method.  

 

 

The average method is simple and practical, but accuracy is not good. When the adjacent cross-

sectional areas have a large difference, the pyramid method is more accurate. 

5.6 Surface 

This function is to design the DTM surface. Users can manage, add, delete, edit, import and preview 

the DTM surface. 

 

Figure 5-6-1 Surface 

-Add: Click to add the surface. Set the surface name, point name and coordinate. The point 

information can be obtained from real-time acquisition, point library or map selection. A DTM surface 

should contain no less than three points. 

      

Figure 5-6-2 Add Surface Point      Figure 5-6-3 Delete      Figure 5-6-4 Delete Prompt 
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-Delete: Delete existing surfaces. Long press the surface in the library list to delete it. When the 

selected surface is being staked out, it cannot be deleted. 

-Edit: Edit existing surfaces. Long press the selected surface point to delete or edit it. 

-Import: Import the surface file which will be added to the list. You can import surface files across 

projects. The file format supports the Hi-Target file (*ttin), CASS file (*.sjw), and LandXml file (*.xml). 

-Export: Click to export the surface file in the CASS Format (*.sjw) format saved in ZHD/OUT by 

default. 

-View: Select or create a new surface, and then check it in the Surface Preview. 

-Check Surface Point: Calculate the elevation of the input point. If the point is not on the surface, it 

can’t be calculated. If the point is on the surface, click OK, the point will be saved in the Stake Point 

library and the GroundCode will be Check Surface Point. 

       

Figure 5-6-5 List Surface      Figure 5-6-6 Surface Preview      Figure 5-6-7 Check Surface Point 

-Batch: Add points from the point library in batches, check the box in the front of the point name to 

select all the points. 

5.7 Elevation Difference 

This function is to calculate the elevation difference between the current point and the fitted point of 

the selected surface. 

Click Stake Surface Lib to choose the surface to stake out, then it will display the TIN grid information 

in real-time. The Fill value will be displayed on the top left, and the coordinates and detailed height will 

be displayed on the bottom slide bar. 
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Figure 5-7-1 Choose Surface      Figure 5-7-2 Elevation Difference 

The upper left corner of the interface displays the Real H and Design H in real-time. If the current point 

is not in the selected surface range, it prompts Out of design surface. 

     

Figure 5-7-3 Out of Surface      Figure 5-7-4 Within Surface 

At the same time, you can click the List Surface  to enter the surface library interface (you can also 

click the Surface module to enter the surface library interface), manually add surface or import known 

surface (support file import in specific directories), quickly edit the design surface information. 
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Figure 5-7-5 Surface List      Figure 5-7-6 Surface Point      Figure 5-7-7 Edit Surface Point 

5.8 Surveying Configure 

The surveying configuration is a common menu that is used to configure the graphical display of the 

work interface, including the road and general survey configuration of the Detail Survey, Stake Points, 

Stake Line, Stake Road, Store Cross-section and Road Design. 

(Common functions also include: Zoom In, Zoom Out, Zoom Center, Zoom All, Single Record, 

Average Record, unified introduction in this chapter, other chapters will not be introduced). 

     

Figure 5-8-1 Surveying Configure        Figure 5-8-2 Configure 

5.8.1 Display 

Surveying Configure → Display: set the display item of the general survey to turn on or off. 

Store Cross-section interface → Configure: includes Road Survey Config and General Survey Config. 

-Road Survey Config: includes Cross-section Point and Roadline Transition Point. 
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Figure 5-8-3 Display Configure of Cross-section 

-Cross-section Point: Select whether to display the point name of the cross-section point during the 

road collection. 

-Roadline Transition Point: Turn on this button, the Cross-section stakeout interface will display the 

slope and width information while the road stakeout interface will display the boundary line of road of 

the sample points combination. The positive offset points will connect to the right boundary line 

according to the mileage order while the negative offset points will connect to the left boundary line 

according to the mileage order. Otherwise, it will not display.  

-General Survey Config: Coord Point, Stake Point, Control Point, Stake Line Lib, Voice Prompts, 

Optimize Scale, Centered Display GPS, Keep GPS Centering, Display Name, Electronic Bubble, Real-

time Mileage, Dis to last Coord Pt, Fix Direction, Controller Dir, Display Color and Online Map. 

      

Figure 5-8-4 Display Configure1      Figure 5-8-5 Display Configure2      Figure 5-8-6 Display Configure3 

-Coord Point: Choose whether to display the coordinate point name. 

-Group Display: The points with the same description code can be displayed with one group. There 

are many groups to display all the coordinates. 

 



    
Hi-Survey Road User Manual 

 

191 

-Tool Display: The Tool Display can show or hide icons of the Detail Survey, Stake Points, Stake Line, 

and Elevation Difference in the left and right toolbar. Entering the Tool Display configuration, the user 

can select to display or hide the module and the location of the module. 

The left side of the tool menu is an optional display, and the right side is the selected display. Click the 

icon on the left side to add the tool to the selected display on the right, and you can delete or move the 

selected display tool. If the resident box is checked, the tool will not be hidden by the shrink in the 

corresponding interface. 

 

Click Tool Reset to restore the default display configuration of the software and click OK to complete 

the tool display configuration. 

 

Figure 5-8-7 Tool Display 

-Stake Point: Choose whether to display the stake point name. 

-Control Point: Choose whether to display the control point name. 

-Stake Line Lib: Choose whether to display the stake line library. 

-Voice Prompts: Choose whether to open the voice prompts. Users can record user-defined voice 

prompts in the *.wav format: the file storage path is ZHD/Sounds.  

    

Figure 5-8-8 Voice Prompt      Figure 5-8-9 Sound File 
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Customized file names have prescribed formats, including fixed.wav, losefix.wav, savedone.wav, 

stakereminder.wav and stakedone.wav. 

 

-Optimize Scale: Choose whether to automatically adjust the scale to the right size. When enabled, it 

will automatically adjust the screen display based on the coordinate range in the coordinate data, and 

the Centered Display GPS and Keep GPS Centering will be invalid. 

-Centered Display GPS: When the current point is not in the screen display range, the current point 

will be automatically centered. 

-Keep GPS Centering: The current point is always in the middle of the screen. 

-Display Name: Choose whether to display the point name. 

-Display Desc: Choose whether to display the description code (name should be displayed first). 

 

-Display Elevation: Choose whether display the elevation (name should be displayed first). 

 

-Electronic Bubble: Choose whether to display the electronic bubble. When it’s not displayed, the 

inclination won’t participate in the acquisition accuracy judgment. 

-Real-time Mileage: Select whether to display the current real-time mileage value in the Stake Line 

and Stake Road interface. 

-Dis to last Coord Pt: Select whether to display the distance to the last point. 

 

-Fix Direction: Smooth the sample over a period of time, and the calculated direction value will be 

relatively stable to reduce the irregular beats in direction. 

-Controller Dir: After selecting, click OK as prompted to keep the controller screen upward, and move 

the controller according to the prompt to complete the calibration. Then return to the survey interface; 

the direction of the current point will be the direction of the controller. 

 

-Display Color: Select whether the map is displayed in the feature color. 

-Online Map: Select Google map as the base map for surveying or stakeout. Make sure the network is 

connected and it has updated to the latest Google service. 

5.8.2 Data 

The data configuration contains the Road Survey Config and General Survey Config. 

-Road Survey Config: includes Cross-section Precision and Store Cross Without Centerline. 

-Cross-section Precision: the default value is 0.0500m. 

-Store Cross-section without centerline: Turn on the switch to directly capture the mid-pile and cross-

section points in the cross-section without centerline file. 

-General Survey Config: Required Solution, Working Area, Physical Record Button, Point Info Dialog, 

Auto Start Average, Auto Store After Average, Store Average Points, Allow Same PtName, Tilt Survey, 

Bubble Precision (<2.0000), HRMS Tolerance, VRMS Tolerance, Stake Tolerance, Stake Prompt in, 

Mileage Tolerance, PtName Increasing by and No Fixed Prompt in(s). 
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Figure 5-8-10 Data Configure1        Figure 5-8-11 Data Configure2             Figure 5-8-12 Data Configure3 

-Required Solution: Limit the solution type, including the Auto, SDGPS, DGPS, Float, and Fix. When 

the solution type is limited to the Fix, the accuracy prompt box will not pop up if the solution is acquired 

in the fixed solution state. 

-Physical Record Button: Set the collection key  on the physical keyboard as the Single Record or 

Average Record shortcut key. 

-Point Info Dialog: Choose whether to display the point information confirmation box after collection. 

 

-Working Area: Users can draw the range of the survey area and select over range tips. 

 

Figure 5-8-13 Working Area 

-Auto Start Average: Check this option and click the average button, to enter the average collection 

interface, to automatically start smoothing. If this option is not checked, the smoothing won’t start 

automatically, users need to click the start button in the average collection interface to start. 

-Auto Store After Average: After it’s turned on, click OK to do the average collection. When the 

number of smoothing reaches the set number, it will automatically exit the average interface and save 

points. Users can also click OK to end the average collection in advance. 
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-Store Average Points: Choose whether to save average data automatically. 

-Allow the Same PtName: Choose whether users can collect points with the same name. 

-Tilt Survey: Tilt survey can be done after turning on, and there will be tilt correction during data 

processing to get coordinates of points to be measured (only for specific models, and users can only 

start the tilt correction after completing calibration steps). 

-Bubble Precision (<2.0000): Set the electronic bubble acquisition accuracy. The acceptable range of 

tilt distance when acquiring coordinates is recommended to be within 30 degrees. 

-HRMS Tolerance: The horizontal RMSE of points, users can enter the maximum RMSE limit. When 

collecting points, there will be a prompt if it exceeds the limit value. 

-VRMS Tolerance: The vertical RMSE of points; users can enter the maximum RMSE limit. When 

collecting points, there will be a prompt if it exceeds the limit value. 

-Stake Tolerance: The precision limitation of stakeout points. Within the limit, the software will indicate 

that it has reached the accuracy range of the stakeout. If the sound prompt is enabled, an audio 

prompt will be given. 

-Stake Prompt in: Set the prompt range of the stakeout. When the stakeout point is within the range, 

the range line will change color. If the sound prompt is enabled, an audio prompt will be given. 

-Mileage Tolerance: Set the maximum error limit for real-time mileage. 

-PtName Increasing by: The accumulation number value of the point name suffix. The default value is 

1. 

-No Fixed Prompt in (s): Voice prompt interval when the fixed solution is reached. The default value is 

60s. 

 

Notice: The default value of data collection accuracy of the fixed solution in the 

software is the value (m) shown in the figure below 

 

 

Figure 5-8-14 Data Configure 
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Notice:  

1. Tilt Survey is only visible when connecting a receiver that supports tilt 

measurement (V90 plus/iRTK5). 

2. If Tilt Survey is not turned on when the receiver is not level, the collection point 

and the saved point is the actual GPS location in the figure, not the point needs to 

be measured, so when Tilt Survey is not opened, please keep the receiver strictly 

level to collect the coordinates. 

3. If Tilt Survey is turned on, when the receiver is not level, the software can 

automatically calculate the actual GPS location to the point that needs to be 

measured. At this time, the collection point and the saved point is the point to be 

measured.  

 

Figure 5-8-15 Tilt Survey 

4. Tilt survey data processing, please refer to Raw Data → Process. 

 

5.8.3 Stake 

The stake configuration contains the Road Survey Config and General Survey Config. 

-Road Survey Config: Includes Real-time Mileage HT Diff, Road Stake Guide Type. 

-General Survey Config: Includes Point Stake Guide Type, Line stake Guide Type, Stake Order, 

Mileage interval stake, Show Offset on Map, Check Move Direction, Map North Direction, Repeat 

Stake, StkName as PtName, Named by Station, Named by Real-time Station, Save Mileage and Save 

Real-time Mileage, Previous/Next Point Floating Button. 
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Figure 5-8-16 Stake Configure1        Figure 5-8-17 Stake Configure2             Figure 5-8-18 Stake Configure3 

-Real-time Mileage HT Diff: After turning on, the height difference in the information bar of the Stake 

Road interface is the height difference between the current point projection on the line and the current 

point (make sure there is a road profile). 

-Road Stake Guide Type: Select the stake guide type, including Front-Back and North-South.  

-Line selection method ： Includes Polyline and Line Section, the default is Polyline. 

When selecting Polyline, all the line section on the polyline will be selected when Stake Points → 

Choose node online or Stake Line → Map; when selecting Line Section, only the nearest line section 

will be selected.  

-Point Stake Guide Type: Select the point stake guide type, and it contains Front-Back and North-

South. In addition, when you use Front-Back, the software will open the Reference Direction option, 

and it contains Sun Azimuth, Base Azimuth, and Custom Azimuth. 

-Line Stake Guide Type: Select the stake guide type, including Front-Back and North-South.  

-Stake DeltaH Type: Set height difference as DeltaH or Fill Or Cut. 

-Point Stake Order: Select stakeout points with ascending or descending order. 

-Projection Method: It refers to the way in which the software places the receiver position onto the line 

during Stake Line or Stake Road. When the line is a retrograde curve, there may be multiple projection 

points on the line, and different projection positions may result in different real-time mileage and offset 

calculation results. The software set the default mileage projection method is Near Current Pt, and the 

customer can change it according to actual needs. 

-Real-time mileage stake: It is turned off by default, the real-time mileage point is staked out; after turn 

on, it is staked at the specified mileage interval, and the previous mileage/next mileage stakeout is 

supported to freely switch. 

-Show Offset on Map: When turned on, the stakeout prompt will be displayed on the map during the 

point stakeout process. If the Check Move Direction is turned on at the same time, and the distance 

from the current point to the stakeout point is greater than the stakeout distance, the horizontal 
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distance from the current point to the stakeout point will be displayed; otherwise, the front-back or 

south-north prompt will be displayed. 

 

Figure 5-8-19 Offset 

1-In the Front-Back mode, the left arrow indicates left, and the right arrow indicates right. In the North-

South mode, the left arrow indicates the west, and the right arrow indicates the east. 

2-In the Front-Back mode, the upward arrow indicates forward, and the downward arrow indicates 

backward. In the North-South mode, the upward arrow indicates the north, and the downward arrow 

indicates the south. 

3-Heitht difference in Front-Back and North-South mode. 

-Voice Prompt: When Stake Points, Stake Line, and Stake Road, it will give voice prompt according to 

the direction and distance. You can set the Prompt Interval(s). 

-Check Move Direction: After turning on, when the distance from the current point to the stakeout point 

is not within the range of the stakeout distance, a large arrow will be displayed to indicate the 

deflection angle between the moving direction and the direction from the current point to the stakeout 

point. If it’s approaching the stakeout point, it will be displayed in green. If it’s moving away from the 

stakeout point, it will be displayed in red. If the moving direction is almost perpendicular to the 

direction from the current point to the stakeout point, it will be displayed in yellow. 

 

 

3 

2 
1 
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Figure 5-8-20 Moving Direction 

-Map North Direction: Select the map direction, including the Map North or Forward. 

-Repeat Stake: When turned on, it supports the repeat stake. Users can choose whether to skip the 

collected stakeout points automatically. 

-StkName as PtName: Select whether to set the stakeout point name as the default point name. 

-Named by Station: Select whether to set the station as the default point name. 

-Named by Real-time Station: Select whether to set the real-time station as the default point name. 

This option can’t be opened simultaneously with the Named by Station. 

 

Notice: When turning on the Named by Station or Named by Real-time Station 

option, users need to select the Allow Same PtName option in the Configure → 

Data interface. 
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-Save Mileage: When collecting points, the mileage will be automatically filled as the staked point 

mileage. 

-Save Real-time Mileage: When collecting points, the mileage will be automatically filled as the real-

time projection mileage (the Save Mileage and Save Real-time Mileage must and can only be selected 

one at a time).  

-Previous/Next Point Floating Button: When it is turned on, the Previous/Next icon will be displayed 

directly on the Staking interface, which is convenient for clicking and selecting the staking point. 

 

Figure 5-8-21 Previous/Next Point 
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Chapter 6 
COGO 

This chapter contains:  

- Angle  

- Distancen 

- Coordinate 

- Area  

- Dist and Azi 

- Intersection 

- Angle Calculation 

- Volume 

- Point and Line 

- Calculator 

- Share 

- FTP 

- Compass 
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6.1 Angle 

Support Radian, Degree, DMS, Gon, Mil angle units transforming mutually. After you input a value to 

any item, click Compute: other several values will be calculated. 

 

Figure 6-1-1 Angle Conversion 

6.2 Distance 

 

Figure 6-2-1 Distance Conversion 

Support km, m, cm, mile, nautical mile, yard, foot, inch distance units transforming mutually. After 

inputting a value to any item, click Compute: other several values will be calculated. 

6.3 Coordinate 

Coordinate conversion supports tow conversion methods including Point and File. 
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6.3.1 Point 

The data includes source ellipsoid and local ellipsoid. After inputting point information, you can switch 

between BLH, XYZ or NEZ. Click To Local or To Source to complete conversion between source 

ellipsoid and local ellipsoid. The coordinate of points can be selected from the real-time collection, 

coordinate library or map. 

        

Figure 6-3-1 Coordinate Conversion   Figure 6-3-2 Receiver Collection 

     

Figure 6-3-3 Point Library Selection   Figure 6-3-4 Select Point from Map 

6.3.2 File 

The coordinate conversion operations of multi-point data by importing files, the conversion results of 

To Local or To Source will display in the interface. 
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Figure 6-3-5 File  

6.4 Area  

Used for calculating area, circumference and some other parameters of graph. The area is indicated 

by sq.m or mu and circumference is indicated by m. The coordinate of point participated in calculation 

can be added manually, or real-time collected from the receiver or selected from a coordinate library 

or map. 

 

 

 

Notice: In the Map interface of Area, the Select Point  is not the same as the 

Map selection  in the List interface of Area. In the former, the points on the map 

are selected by clicking on the point, and the latter by the way of selecting points 

in the circle and selecting the node on line. 

 

The difference of map selection between Area and the other interface is: click  to enter map 

selection mode. Frame select point on the map when the icon is in the state  , when frame select 

multiple points, press  but only one point in the box can be selected, click  again to exit the map 

selection mode; Among them, when the icon is in the status  , you can select multiple points in the 

box, click  or  again to exit the map selection mode, click OK to complete. Return to the list to view 

the selected points. 
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Figure 6-4-1 Area Calculation    Figure 6-4-2 Select Point     Figure 6-4-3 Multiple Select 

- Add: The points can be added to the list by the way of real-time collection, point library, and graph 

selection. 

- Compute: Calculates the area, mu, and length of the current point in order, and can view graphics 

and calculations in the result interface. 

The results of the graphical will be displayed at the bottom left of the interface, which is divided into 

maximum area results and vector area results. The maximum area results will be displayed in green 

font, and the vector area results will be displayed in red font. 

 

Figure 6-4-4 Results 

6.5 Dist and Azi 

Used for calculating distance and azimuth between two points. The coordinate of A and B points can 

be manually input, or read from receiver, coordinate library or map. After reading successfully, click 

Compute to calculate Azimuth, Bank Angle, 2D-Distance, 3D-Distance, and H-Distance. 
 



    
Hi-Survey Road User Manual 

 

205 

     

 Figure 6-5-1 Distance and Azimuth            Figure 6-5-2 Result 

6.6 Intersection 

In the case of a point needing measurement, but observation conditions are not ideal, calculate the 

needed point coordinate by measuring a nearby point. Click every icon to enter the corresponding 

measurement mode. The software supports nine measurement modes (4Pt, 2Pt2L, 2Pt1L, 2Pt2A, 

2Pt1A1L, Azimuth, 2C, 1L1C, 1RPt). 

         

Figure 6-6-1 4Pt Interface       Figure 6-6-2 2Pt2L Interface     Figure 6-6-3 2Pt1L Interface   



    
Hi-Survey Road User Manual 

 

206 

       

      Figure 6-6-4 2Pt2A Interface     Figure 6-6-5 2Pt1A1L Interface      Figure 6-6-6 Azimuth Interface 

       

Figure 6-6-7 2C Interface     Figure 6-6-8 1L1C Interface      Figure 6-6-9 1RPt Interface   

There are two positions of P according to the theory of 2Pt2L; 2Pt2A, 2Pt1A1L. If you input the 

coordinate of A first and then the coordinates of B, the position of P will be located above the AB line. 

Conversely, if you input the coordinate of B first, the position of P will be located under the AB line. 

In the above intersection measurement methods, select known point ID, input the coordinate of the 

intersection measurement point (manual input, or read from receiver, coordinate library, map), input 

other known keys (such as L1, L2, etc..), click Compute, calculate the coordinate of unknown point P, 

click Save, input name, description and so on to save into the coordinate library. 

In the Intersection, when you click GPS collection, prompting precision information (accuracy setting is 

performed in the Configuration) is easy for an understanding of real-time accuracy. 

6.7 Angle Calculation 

Used for calculating the angle of the three-point line. 
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Figure 6-7-1 Angle Calculation   Figure 6-7-2 Interior and Exterior 

6.8 Volume 

      

Figure 6-8-1 COGO interface   Figure 6-8-2 Volume interface 

Calculate the volume, 2D perimeter, 3D perimeter, and DTM area of two DTM surfaces, or between a 

DTM surface and a predetermined elevation. 

- Select surface: Click extend icon  , Select an actual surface from the List Surface. 

- Input the reference elevation: Check it, the reference elevation and the surface are used for volume 

calculation. Click extend icon  , input the target height needed to fill/dig. 

- Select the reference point: Check it, the reference point and the surface are used for volume 

calculation. Click extend icon , Select a point as a reference point from the Point Library. 

- Define range: Check it, calculate the volume inside boundary; conversely, without checking it, it will 

calculate the volume in the public area. Click extend icon  , you can select the range points on the 

Define range interface, and add, edit, delete, load, and save the range points. 
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Figure 6-8-3 Checked Boundaries Figure 6-8-4 Define Range          Figure 6-8-5 Boundary Point 

- Add: Add a range point by manual input, real-time collection, point library selection or map selection, 

Define Range requires at least three points. 

- Edit: Select the range point you want to edit: you can edit the coordinates of the point. 

- Delete: Select a range point, click Delete to delete directly, no prompt. 

- Load: Load an existing boundary file (*.waa), the load path is: ZHD\ Project\ ROAD\ Project Name\ 

dtm folder. 

- Save: Save the re-add/edit volume boundary file: the save path and file format is consistent with that 

in Load. When the saved file name already exists, it cannot be saved, but check Cover to save the 

modified file. Also, click OK will also save re-add / edit volume boundary file. 

  

Figure 6-8-6 Save Directory 

After selecting different calculation methods, click Compute and view the volume calculation, 

measurement surface, digging area, and fill area product information on the Results interface. 
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Figure 6-8-7 Two Surfaces Figure    6-8-8 Surface and Point     Figure 6-8-9 Surface and Elevation 

    

Figure 6-8-10 Result Above   Figure 6-8-11 Result Below 

    

Figure 6-8-12 Elevation Result   Figure 6-8-13 Point Result 
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- Area (2D: m2): The area projected onto the horizontal plane. 

- Area (3D: m2): The area projected onto the slanted reference plane. 

- Perimeter (2D: m): The length of the polygon from the start point to the current measurement point in 

surface (2D). 

- Perimeter (3D: m): The length of the polygon from the start point to the current measurement point in 

surface (3D). 

6.9 Point and Line 

Used for calculating the relationship between points and lines. 

    

Figure 6-9-1 Point and line       Figure 6-9-2 Point and line  

6.10 Transition curve 

Click the Transition curve icon in COGO interface, it supports to calculate the parameters of Curve, 

Start Radius, and End Radius. 

         

Figure 6-10-1 Curve          6-10-2 Start Radius           6-10-3 End Radius 
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6.11 Calculator 

Used for simple mathematical calculations. 

     

Figure 6-11-1 Calculator   Figure 6-11-2 Calculator 

6.12 Share 

File transferring. The user clicks Share to enter the sharing interface, and the software displays the 

directory/storage/sdcard0/zhd/out by default.  

- Select the file to be shared, click the Share button, and the software pop-up box will display the 

optional sharing method.  

- Click the icon and jump to the corresponding software for file transfer. 

         

Figure 6-12-1 Calculator           Figure 6-12-2 Calculator             Figure 6-12-3 Calculator 
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6.13 FTP 

For the FTP file transferring function, click FTP to enter the transmission function. The software will 

then display the default target path (/storage/simulated/0/zhd). 

- Users need to enter the username, password, and port when the software does not check 

"password-free transmission".  

- Check "password-free transmission". The software does not display the username and password 

input box, and the user only needs to configure the port.  

When the device has connected to the Wi-Fi, the software automatically fills in the IP parameters and 

the port number defaults to 2121. After the user has configured all the parameters, click Start. 

According to the prompts, the user can input the corresponding path into the computer to download 

the FTP file. 

     

Figure 6-13-1 Calculator       Figure 6-13-2 Calculator 

6.14 Compass 

Click Compass to enter the compass function. 

 

 

Notice: When the manual compass is turned on, the visual angle orientation 

function will be turned off. 

 

When you open the compass for the first time you will enter the calibration interface, and can confirm 

whether calibration is needed. If the calibration is successful, it will enter the calibration interface again 

after a period of 7 days. 
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Figure 6-14-1 Calculator       Figure 6-14-2 Calculator 
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Chapter 7 
Tilt Survey 

This chapter contains:  

 

- Tilt Correction 

- Tilt Survey 2.0 

- Tilt Survey with Calibration-free 
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7.1Tilt Correction 

The Tilt correction mainly includes three parts: electronic bubble calibration, Tilt Calibration and 

Verification, and Calibration verification.  

7.1.1 Electronic Bubble Calibration 

1. Connect to the receiver with the tilt survey function. In Additional Settings, click Electronic Bubble 

Calibration to enter the program. 

    

Figure 7-1-1 Additional Settings Figure 7-1-2 Receiver Settings 

2. When the device had been perfectly leveled up, click Start for calibration, then click OK.  

         

Figure 7-1-3 Bubble Center                  Figure 7-1-4 Warning 

 

3. When success is prompted, the electronic bubble and horizontal bubble of the base will be centered 

at the same time. 
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Figure 7-1-5 Calibrating       Figure 7-1-6 Calibration Success 

4. Calibration is finished. Notice: It is recommended to calibrate the device every 30 days, but the 

calibration cycle can be adjusted. 

 

5. Auto collection. When the auto mode is set as Bubble Is centered the software will collect the points 

automatically when the electronic bubble is centered. 

 

Figure 7-1-7 Auto Collection 

Notice: When using the Bubble Is Centered for automatic collection, first set 

bubble precision. Connect a receiver with tilt measurement function, enter main 

interface → Survey → Surveying Configure → Data (or: enter survey interface → 

click Configure at the top right corner→ Data), the Bubble Precision can set when 

tilt Survey is off. 
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Figure 7-1-8 Tilt Survey And Bubble Precision 

7.1.2 Tilt Calibration and Verification 

Tilt Calibration  

The whole tilt calibration has three steps: 

1. Orientation sensor calibration; 

2. Electronic bubble calibration; 

3. Magnetic calibration. 

The order of 1 and 2 steps can be reversed but must be performed before step 3. 

 

Notice:  

1. The calibration should be done in a low magnetic interference area or an open 

field. Don’t do calibration on the roof or top of a high building. 

2. Calibration should be done in external station mode, don’t use the internal UHF 

link to avoid magnetic interference. 

3. Don’t change battery and power off during all the calibration steps. 

 

Here are the detailed operations below: 

1. Orientation Sensor Calibration 

Additional Settings → click Orientation sensor calibration to enter calibration interface. 
 



    
Hi-Survey Road User Manual 

 

218 

    

Figure 7-1-9 Sensor Calibration       Figure 7-1-10 Start Calibration 

Click Start to begin calibration, the calibration of the orientation sensor needs to be calibrated 

according to the demo. 
 

    

         Figure 7-1-11 Warning            Figure 7-1-12 Rotate The Device 

Rotate at an average speed, approximately 7 seconds for a cycle. 

 

Figure 7-1-13 Rotary Axis 

Rotary axis 
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Clockwise rotate about 45 degrees, repeat step a, you need a total of 8 cycles at least. 

 

 

 

Figure 7-1-14 Clockwise Rotate 

After the calibration is completed in each direction, the second Ding-Dong sound indicates Success 

from the device, which means calibration is finished. Conversely, prompting failure - do calibration 

again.  

   

Figure 7-1-15 Calibration      Figure 7-1-16 Calibration Success 

2. Electronic Bubble Calibration 

Please refer to Electronic Bubble Calibration. 

3. Magnetic Calibration 

This step can be done only after the calibration of the electronic bubble and orientation. 

Additional Settings → click Magnetic calibration to enter calibration interface. 

Rotary axis 
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Figure 7-1-17 Start Calibration 

Click Start to start calibration, magnetic calibration needs calibration in horizontal position. 
 

      

Figure 7-1-18 Warning             Figure 7-1-19 Calibrating 

Keep the device on horizontal and rotate it clockwise a week, slowly and evenly around the vertical 

axis. Rotation speed is recommended to be less than 20 degrees per second, ith slow uniform rotation 

and no pause during rotation. 
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Figure 7-1-20 Horizontal Rotation  

When horizontal calibration is complete, the second Ding-Dong sound from the device indicates 

Success. Conversely, prompting failure - do calibration again.  

      

  Figure 7-1-21 Failure            Figure 7-1-22 Successful 

7.1.3 Calibration Verification 

In order to make sure accuracy is not strongly interfered with by the environment and procedure, 

verification is necessary before starting the tilt survey.  

Put the device at 30-degree tilt approximately, on the pole, and rotate it slowly clockwise for a week. 

View the azimuth changes, if the differences between maximum and minimum values are less than 5 

degrees, it means the sensors are working well and you can do a tilt survey directly, otherwise module 

verification will be required.  

 

 

Rotary axis 
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Notice:  

1. The pole shouldn’t be moved.  

2. Rotation speed should be 2 degrees per second and it takes about 3 minutes to 

rotate one week. 

 

 

Figure 7-1-23 Calibration Verification 

 

Notice:  

1. When replacing a new measurement area, or the terrain complex environment of 

the measurement area changes greatly, module verification is required before 

measurement. 

2. When the new device first uses tilt measurement, it must be calibrated. 

3. After the new battery is replaced, the device must be calibrated. 

 

7.1.4 Tilt Correction Procedure 

After electronic bubble calibration, orientation sensor calibration, magnetic calibration, and verification 

are successful, you can start a tilt surveying. If the device has not undergone calibration, users will be 

prompted when Tilt Survey is opened: you must complete all calibrations before you can open the Tilt 

Survey. Tilt Survey conditions are limited to static, within 20 degrees of tilt. 

1. Tilt Survey must be opened when you start a tilt surveying, click Surveying Configure→Data→Tilt 

Survey. 

 
Unscrew the knob 

and hold the pole to 

rotate device 

clockwise slowly 

around pole. 
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Figure 7-1-24 Tilt Survey      Figure 7-1-25 Slope Method 

2. When Tilt Survey is not opened，the software will not do a tilt survey, the software survey interface 

displays and records the coordinates of the tilt point to the point library. Conversely, when Tilt Survey 

is opened, the interface displays and records coordinate points to the point library: this coordinates 

point is the calculated ground coordinate point. 

3. Collect Point 

Enter survey interface to collect points, it supports two survey modes: Corner Slope and Normal Slope. 

The corner slope mode is accurate and reliable; the normal slope mode is simple to operate. 

 

Figure 7-1-26Collection Point 

Corner Slope 

This mode is more precise, but it takes a little longer in the field. Orientation and magnetic calibration 

recommendations are prompted when interference is found by the device. 

1. Please keep the receiver tilted and static, then click the collection icon. The best tilt angle is 10 
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degrees ~ 20 degrees: follow the prompts to operate. 
 

 

Figure 7-1-27 Step One 

2. Tilt in the other direction, with an azimuth span angle of 30 degrees to 120 degrees (Azimuth Span 

Angle: the angle formed by the vertical projection of the pole in two directions), and keep it static. 

There will be a sound prompts ‘Di’ indicating that collection is complete. 

     

        Figure 7-1-28 Step Two           Figure 7-1-29 Step Three 

3. In the Save Point interface, you can see the tilt angle and tilt azimuth of the point. 
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Figure 7-1-30 Save Point 

Normal Slope 

This method is much simpler, the receiver will collect points when it is still (function available in 

firmware version after v5.1 for V90 Plus and v1.1 for iRTK5). Orientation and magnetic calibration 

recommendations are prompted when interference is found by the device. 

1. Enter process interface Raw Data → More → Process. 

 

       

Figure 7-1-31 Raw Data          Figure 7-1-32 More            Figure 7-1-33 Process 

2. Data Transfer is a raw data custom export. It supports export not an increase in plane coordinates 

for tilt correction (tilt N, tilt E, tilt Z is not tilted correction of plane coordinates). Select the export path 

and input the export file name and after completing the custom format settings, click OK to export. 
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Figure 7-1-34 Save Raw Data    Figure 7-1-35 Custom Format 

Abnormal prompt 

1. When you have finished following the prompts, if the prompt Corner Slope fails appears, the current 

point is not saved. 

 

Figure 7-1-36 Prompt 

2. When it prompts The current low precision, whether to save data, click OK to save the calibration 

ground point coordinates, click Cancel to not save the coordinate data. 

3. When the collection point prompts Magnetic is change, so it is not collecting points and you need to 

do the three steps of tilt calibration. 

7.2 Slope Method 2.0 

7.2.1 Slope Method 2.0 
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When the Hi-Survey Road finishes connecting the device, open the "Slope method 2.0" switch in the 

Configuration - Data interface of the software, and then start the tilt survey. 

 

Figure 7-2-1 Slope method 2.0 

In this mode, click the collection button in the Detail survey interface, and the software will prompt you 

to shake the device to start the measurement. Then shake the device at a constant speed and wait 

until the progress bar reaches 100% and finish collecting the point. 

 

Figure 7-2-2 Shake  

7.2.2 Prompt 

If the "Slope method 2.0 fail" is prompted, the current point will not be saved. 
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Figure 7-2-3 Prompt 

7.3 Tilt Survey with Calibration-free 

7.3.1 Measuring Method 

After connecting the receiver, open the Tilt Survey switch in the Surveying configure-data interface of 

the software, and after the receiver reaches RTK-Fix, the Tilt Survey can be initialized (click the Tilt 

Survey icon to view the initialization prompt).  

 

Keeping the device in a static state 

Keep the device in a static state for 1-3s when the device is in RTK-Fix. 

 

Shaking 

After the Tilt Survey initialization has finished, the receiver will be shaken back (once every second) 

for heading initialization.  
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Figure 7-3-1 Tilt survey      Figure 7-3-2 Initialization interface 

When all the initialization items have been ticked, the receiver voice will broadcast "enter tilt 

measurement", and the Tilt Survey icon will light up. After the initialization of the Tilt Survey, the Tilt 

Survey operation can be performed on the device. 

Notice:  

1. The Tilt Survey must achieve the requirements of the RTK-Fix solution, attitude 

initialization and heading initialization before it can be used. Otherwise, it will 

prompt to complete the initialization operation. 

2. The Uncorrected Tilt Survey function is only supported by the New iRTK5 

GNSS RTK receiver. 

3. When on the calibration-free tilt survey model, click on the tilt survey icon in the 

lower right corner of the interface to switch the current mode to the normal survey 

or tilt survey. 

4. When on the calibration-free tilt survey model, the tilt azimuth, vertical 

inclination, and no tilt correction coordinates information can be viewed in the 

button box of the detail survey interface. 
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Chapter 8 
Quasi-dynamic Survey 

This chapter contains:  

 

- Function Introduction 

- Operation Procedure 
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8.1 Function Introduction 

Quasi Dynamic RTK Survey was invented by Hi-Target, a new way to survey in tough areas where 

there is strong multi-path interference, signal blocking like standing beside big trees; the reliability is 

much better than the normal RTK survey in those conditions. It can offer precise coordinates in 20 – 

40 seconds, with better fixing rate, accuracy, and reliability. 

 

8.2 Operation Procedure 

1. Activate the function. 

Additional Settings → Receiver Settings → Quasi Dynamic RTK → Set. 

    

Figure 8-2-1 Receiver Settings   Figure 8-2-2 Quasi dynamic RTK 

 

2. After the RTK correction from the base receiver or CORS service had been received for more than 

30 seconds, the quasi dynamic RTK survey is ready to work.  

 

3. Go to Detail Survey interface, click  button on the screen to start. If you get the feedback 

QuasiDynamic engine is under preparation, then please make sure the receiver is getting corrections. 
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Figure 8-2-3 Button (1)     Figure 8-2-4 Button (2)      Figure 8-2-5 Prompt 

4. It should take 20 – 40 seconds to finish collection, during the procedure please keep the receiver as 

steady as possible, rotating and shaking is not allowed. 

 

Figure 8-2-6 Prompt 

5. After the dingdong sound is tweeted, the collection is done and the point is saved. In this mode, the 

normal detail survey RTK point collection is still available.
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Chapter 9 
iHand30 Controller 

This chapter contains:  

- Introduction 

 -  Appearance 

 -  Controller accessories 

 -  Operation 

 -  Download 

 -  USB upgrading 

-  APN setting 
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9.1 Introduction 

9.1.1 Foreword 

The iHand30 controller is a professional data collector, based on the Android system. Using 

a combination of physical buttons and touch screen to operate, the default input languages 

are Chinese and English, and it supports multiple languages. The industrial-standard 

design can withstand 1.2 meters drop to a cement floor, is IP67 waterproof and dustproof 

standard to adapt to a complex operating environment. At the same time, the super 

capacity lithium battery can handle all weather requirements. 

The iHand30 controller configures 3.7 inches 640 * 480 highlighted LCD; 1.5GHZ, quad-

core 64-bit CPU; and 16GB ROM +2 GB RAM memory. It has a built-in Micro SD card slot, 

and maximum support 128GB expansion card (it only supports FAT32 format SD card, the 

NTFS format SD card cannot be supported); dual card dual standby, and supports the 

entire 4G network. With the Android 6.0 operating system, the interface is optimized and 

easy to use. 

9.1.2 Features  

1. Industrial-standard design, with IP67 it can withstand a 1.2 meters drop to a cement floor 

and adapt to a complex operating environment. 

2. Highlighted LCD, the LCD screen is normally readable under strong sunlight. 

3. Supports Bluetooth, Wi-Fi and 4G，which is convenient to carry out a variety of wireless 

data transmissions with the receiver. Wi-Fi and 4G can be used at the same time. Refer to 

the Hi-Survey Road Software User's Guide for more details. 

4. Internal 8-million-pixel camera: for field collection of image information. 

5. Internal removable large capacity lithium battery for more than 15 hours of work. 

6. The internal NFC chip supports NFC data transmission for a rapid connection between 

the RTK and handheld controller. 

7. Fast charge technology: for a rapid battery charge. 

8. Full keyboard input method. 

9. Local online upgrade to facilitate quick changes. 
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9.1.3 Caution 

Although the iHand30 handheld controller is made with chemical and impact-resistant 

materials, it needs to be carefully used and maintained and should be kept in a dry 

environment. In order to improve the stability and usage cycle of the iHand30 handheld 

controller, please avoid exposing it to extreme environments, such as humidity, high 

temperatures, low temperatures, corrosive liquids or gases, etc.  

 

Notice: The iHand30 handheld controller must be used within the temperature 

range from -20℃ to 55℃ 

 

9.2 Appearance 

9.2.1 Front of The Controller 

The front of the iHand30 controller includes a touch screen, keyboard microphone, and 

indicator light. 

 

Figure 9-2-1 iHand30 controller 

2 

1 

1- Indictor lights 2- Microphone   3- Touch screen   4- Keyboard 

 

 

3 

4 
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- Touch screen: multipoint capacitive touch screen with touch pen (open the touch pen 

function: Settings - Accessibility - Handwriting pen), which supports Chinese and English 

input. 

- Keyboard: direction control, switch between Chinese and English, data collection, volume 

control, power on, power off and other functions. 

- Microphone: the internal microphone can be used for field collection of voice messages. 

- Indicator lights: from left to right: signal lamp, state lamp, power indicator. 

9.2.2 Reverse Side of The Controller 

There is a camera, battery cover, belt, NFC, trumpet, etc.. on the reverse of the controller.  

 

Figure 9-2-2 the backside of the iHand30 

- Camera: used for field collection of images. 

- Battery cover: with an internal removable lithium battery. 

- Belt hole: connect the belt to prevent it from sliding down. 

2 

1 

3

 

4

 

5

 

1- Camera   2- Battery cover   3- Trumpet   4- NFC   5- Belt hole 
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- Trumpet: conduct real-time voice broadcasts for instrument operation and status. 

- NFC: supports NFC data transmission to achieve a rapid connection between RTK and 

the handheld controller.  

9.2.3 Side of The Controller 

       

Figure 9-2-3 the port of iHand30 

- USB port: for connecting the USB data line and the controller. 

- Audio port: for connecting the headphone cable and the controller. 

 

Notice: When not using the audio port or Mini USB, please close the rubber cover 

to make it waterproof and dustproof. 

 

1- Waterproof and dustproof rubber cover     2- Audio port     3- USB port 

 

 

1 

2 

3 
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9.3 Controller Accessories 

9.3.1 Charger 

 

Figure 9-3-1 Charger 

Charger: 5V--3A/9V--2.7A/12V--2A  

Type: A824A-120200U-CN2 

 

9.3.2 Battery 

   

Figure 9-3-2 Battery 

Lithium battery: 3.7V /5200mAh 
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9.3.3 Data Cable 

 

 

Figure 9-3-3 Data cable 

USB data cable: connect to the USB port of a computer, for download of data; connect to 

the USB port of the charger for charging the controller. 

9.3.4 Touch Pen 

 

Figure 9-3-4 Touch pen 

Touch pen: located on the strap of the controller. 

 

9.4 Operation 

9.4.1 Keyboard 

Most settings and operations of the iHand30 handheld controller can be completed by the 

touch pen, and commonly used operations can be completed on the keyboard. The 

appearance and functions of the keyboard are as follows. 

iHand30 keyboard includes: Back, OK, Power, APP, Fn, Collect, etc..  
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Figure 9-4-1 Keyboard 

 

- Back: cancel or exit the operation of the current window. 

- OK: confirmation. 

- Power: press it for over 3secs to power on/off. Press it for 1sec to turn off /on the screen 

backlight in the power-on status. 

- APP: quick start of the APP. The default is Hi-Survey Road software. 

- Fn: when inputting, short press this key to cycle the input method (Chinese Pinyin/ English 

letter abc/ English association en/ number 123). In any interface long press this button to 

pop-up the selection box to switch the system input method. 

- Collect button: collect data by manual operation. 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

1- Home     2- Menu     3- APP     4- Fn        5- Power      6- Back  

7- Collect    8- OK       9- Delete    10- Space    11- Enter      12- Shift 

 

 

11 

12 
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- Shift: switch key of the input function. 

- Fn + direction up/ down key: volume increase/ decrease. 

- Screenshot function: pull down the screen at the top menu, select the screenshot options, 

and the screen capture will be kept in the folder of Mobile phone storage→Pictures→ 

Screenshots. (note: iHand30 does not set the shortcuts screenshot function). 

 

Notice: When the iHand30 handheld controller is not used, please turn off the 

backlight to save electricity and prolong working time. 

 

9.4.2 Battery Installation and Dis-assembly 

1. Installation and disassembly of the battery 

Installation: 

Step1: the metal contact parts of the battery are placed upwards in the cell tank. 

 

Figure 9-4-2 Installation of Battery 

Step2: press the bottom of the battery. 
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Figure 9-4-3 Installation of the battery 

Dis-assembly: pull up the bottom of battery 

 

Figure 9-4-4 Dis-assembly of the battery 

2. Installation and disassembly of the battery cover 

Installation: 

Step1: insert the two raised tabs of the battery cover into the corresponding slots. 
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Figure 9-4-5 Battery cover 

Step2: press the battery cover tightly, press the black button. 

 

Figure 9-4-6 Lock the battery cover 

Dis-assembly: push up the black button of the battery cover, and pull up the battery cover. 

                   

Figure 9-4-7 Battery cover   Figure 9-4-8 Lock the battery cover 

9.4.3 Power System 

1. The battery and charger model of the iHand30 handheld controller 
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Table 9-4-1 the battery and charger model 

Name Model 
Lithium battery BLP-5200S 

Charger A824A-120200U-CN2 

2. Charge 

The special charger should be within a certain temperature range when charging, and 

certain charge time is required. Specific use methods and requirements: use the special 

charger of the controller to charge in the temperature range of 10℃-40℃. There is a certain 

amount of electricity in the battery on first use, let the power completely run out from the 

first charge, then the first three times you will need to charge for 3 hours. After that, the 

iHand30 supports fast charging with the original charger and the charge time is then less 

than 3 hours. If the battery is not used often, it must be charged once every two months. 

 

 

 

 

 

 

9.4.4 SIM Card Setting 

The iHand30 handheld controller supports DSDS, the default card is SIM1. Both SIM1 and 

SIM2 support full network 4G. 

1. Installation of the SIM card 

Step1: remove the battery cover, remove the battery, and expose the SIM card slot. Slot 1: 

Micro SIM card; slot 2: standard SIM card. 

Step2: put the SIM card into the slot with the front side (metal contact side) down. 

Notice:  

1. Please use the configured battery and charger, do not put the battery 

into fire or metal short circuit electrode. 

2. If the battery is hot, deformed, leaks, has an odor or any other 

abnormalities during use, charging or storage, please replace it 

3. If the using time is obviously shortened, please stop using the battery. 

Please replace with a new battery 
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Figure 9-4-9 Installation of SIM card 

2. Network: Settings → Data usage. 

           

  Figure 9-4-10 Data usage           Figure 9-4-11 Overview of data       Figure 9-4-12 Cellular data network 

9.4.5 Installation of The Micro SD Card 

The Micro SD card can save collected data and program files.  

 



    
Hi-Survey Road User Manual 

 

246 

Notice: Micro SD card（TF card）is an external storage card, usually used 

in mobile phones and PDAs. If you buy this, please note the difference to 

ordinary SD cards. The volume of the ordinary SD card is larger than the 

Micro SD card and is not suitable for the iHand30 handheld controller. 

 

Step1: remove the battery cover, remove the battery, and expose the Micro SD card slot. 

Step2: push down the metal sheet and open it.  

 

Figure 9-4-13 Micro SD slot 

Step3: Put Micro SD card into the slot (metal contact side down). 

 

Figure 9-4-14 Installation of Micro SD card 

Step4: push down the metal sheet and close it. 
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Figure 9-4-15 Installation of Micro SD card 

9.4.6 Power On / Off 

In the off state, Long press the power button for 3 seconds, it will power on. 

 

Figure 9-4-16 The interface of the iHand30 screen 

In the power-on state, Long press the power button for 3 seconds, it will prompt to shut 

down and to confirm, click Power off. 
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Figure 9-4-17 Power off 

9.5 Download 

1. Connect the controller to the computer via the USB data cable. 

2. Transfer files: pull down the notice column and click USB for charging. 

                   

Figure 9-5-1 USB connected             Figure 9-5-2 Charging        Figure 9-5-3 File transfers 

3. Connect the PC version mobile phone assistant: open the handheld controller, click 

Setting → Developer options → USB debugging. 
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  Figure 9-5-4 Settings     Figure 9-5-5 Developer options   Figure 9-5-6 USB debugging 

9.6 USB Upgrading 

iHand30 controller supports two methods for upgrading, local upgrade, and wireless 

upgrade. 

1. Local upgrade of the iHand30 controller (download the firmware from the Hi-Target 

official website first). 

Step1: Copy the upgrade firmware to the SD directory. 

 

Figure 9-6-1 Upgrade patch 

Step2: Choose the Wireless Update App.  
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Figure 9-6-2 Update App 

Step3: Open the Wireless Update App, as shown below. 

 

Figure 9-6-3 Interface of the update 

Step4: Click the top-right menu selection in the interface, and choose Local updates. 

 

Figure 9-6-4 Local updates 

Step5: Enter the interface. 
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Figure 9-6-5 Local updates 

Step6: Select the Internal storage file, then select the update firmware. 

 

Figure 9-6-6 Choose the firmware 

Step7: After selecting the upgrade firmware, click Install Now. 

 

Figure 9-6-7 Install 

Step8: The system will restart and begin to update. 
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Figure 9-6-8 Interface of upgrade 

2. Wireless update 

Step1: Select the Wireless Update App.  

 

Figure 9-6-9 Update App 

Step2: After entering the Wireless Update App, if there is a new version, the interface will 

show it and display the update. The complete update content will appear if you draw up the 

screen. 

Step3: Click Download, the firmware update patch will be downloaded. 

Step4: When the system upgrade package is downloaded, come out of the prompt window, 

and click Confirm. Special attention should be paid here. After clicking, it’s forbidden to 

operate of the device. 
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Step5: After completing step 4, the device will enter the upgrade interface, waiting for the 

progress bar to reach the full grid that completes the system wireless upgrade. 

Step6: when the upgrade is completed, the device will restart automatically, repeat steps 1 

and 2 to check whether the update is complete, then finish it. 

9.7 APN Setting 

Please check whether the APN parameter is set correctly when the iHand 30 cannot access the 

Internet through the mobile network. In cases where the iHand 30 is not connected to Wi-Fi, the 

SIM card must be installed in the iHand 30 in order to set the APN. 

 

The steps for the APN parameter setting of the iHand 30 system: Open System Settings > 

More > Mobile network > Access point name (APN) of the iHand 30, enter the iHand 30 SIM 

card network access point name (APN) selection and then set the APN related parameters. 

 

         

    Figure 9-7-1 More interface           Figure 9-7-2 Mobile networks settings 

When the data link mode of the Hi-Survey Road software is "Data Collector Internet", the APN 

parameters will be the iHand 30 system settings.  

If the mobile card is a private network card provided by the CORS service provider, you need to 

set the APN parameter as a private network APN parameter in order to connect to the Internet. 

Follow the steps above to connect to the private network. After setting the name, APN, 

username, and password of the private card, login to the server to confirm the network 

connection. 

 

Notice:  

The "Data Collector Internet" is recommended for the software data link. This can 
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save the receiver's power, extend the operation time, and make the Mobile 

network more compatible with local networks. 

The username and password of the private network card’s APN parameter setting 

are of the private network rather than CORS. 
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Chapter 10 
Appendix 

This chapter contains:  

 

- Technical Terms 

- Troubleshooting 

- File Formats 
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10.1 Technical Terms 

1. Global navigation satellite system（GNSS） 

Global navigation satellite system (GNSS), is the standard generic term satellite navigation system, 

it provides global coverage of geographic spatial orientation, including the US GPS, Russian 

GLONASS, Chinese BDS, and the European Union's Galileo. 

2. GPS time 

The time measurement used by the NAVSTAR GPS system. 

3. UTC 

Universal Time Coordinated。 Time standard for local daylight hours based on Greenwich 

meridian。See GPS time. 

4. Multipath 

Interference (similar to the heavy shadow on a television screen). GNSS signals arrive at multiple 

paths before they reach the antenna through different paths. 

5. Degree of ambiguity 

The number of weeks in the carrier phase pseudo space between GNSS satellite and GNSS 

receiver. 

6. Ephemeris 

Current satellite position prediction. It is transmitted in the data. 

7. Epoch 

Measurement interval of GNSS receiver. Variations of the calendar element with measurement type: 

- For real-time measurement, it is set to one second. 

- For post-processing measurements, set to one second and one minute. 

8. Antenna height 

The height of the receiver phase center to the center of the station. 

9. Reference station（base station） 

In a certain period of time, and if one or several receivers, on one or a few test sites, keep tracking 

an observation satellite, with the receiver in a certain range, the fixed station is called a reference 

station. 

10. Mobile station  

In a certain period of time, and if one or several receivers, on one or a few test sites, keep tracking 

an observation satellite, and the receiver is within a certain range, the fixed station is called a 

reference station。 

11. Single reference station RTK measurement. 
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Only one base station is used, and the carrier phase difference correction parameter is measured by 

the data communication technology receiving base station. 

12. Network RTK (CORS/VRS) 

Refers to multiple reference stations in an area, network coverage to the region composition, and 

continuous tracking observation, through the sites of GPS observation network, covering the region 

and the time period for RTK correction parameters, in the region for RTK line RTK real-time 

correction way of positioning. 

13. Cut-off height angle 

In order to shield the effect of occluded objects (such as buildings, trees, etc..) and the multipath 

effect, the value of the angle threshold is lower than that of the satellite in the field of view,  

which is usually set to 10 degrees. 

14. Fixed solution 

This indicates that the ambiguity has been solved and the measurement has been initialized. It is the 

most accurate type of solution. 

15. Floating solution 

This indicates that the ambiguity has been solved and the measurement has not been initialized. 

16. DOP (dilution of precision) 

Position Dilution of Precision (Dilution of Precision) is GNSS quality marks. It takes into account the 

position of each of the satellites, relative to the other satellites in the constellation, and their 

geometric position relative to the GNSS receiver. The smaller the DOP value, the higher the 

accuracy reliability. Standards applied by GNSS DOP value are: - the PDOP - position (3d 

coordinate) - RDOP relative (position), average time - HDOP - level (two-dimensional horizontal 

coordinates) - VDOP - vertical (only height) - TDOP - time (the clock offset only). 

17. Spatial position dilution of precision (PDOP) 

A unit number that represents the relationship between user position error and satellite position error. 

The factors reflecting the attenuation of positioning accuracy are related to the spatial geometric 

distribution of the measured satellite, and the larger the spatial distribution range, the smaller the 

PDOP value and the higher the positioning accuracy; conversely, the larger the PDOP value, the 

lower the positioning accuracy. 

18. PDOP limit 

The highest PDOP value for the receiver's computed position. 

19. PPM 

The measurement of the slanting distance of one-millionth is corrected for the impact of the earth's 

atmosphere. PPM is determined by the observed pressure and temperature as well as the specific 

instrument constants. 

20. The RMS 

The Root Mean Square is used to indicate the measurement accuracy of the point. It is the error 

circle radius at about 70% of the fixed point. 
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21. SNR 

（Signal-to-Noise Ratio）。It is a measure of the strength of satellite signals. SNR ranges from 0 

(no signal) to 99, of which 99 is the best, and 0 means the satellite is not available. The typical good 

value is 40. Normally, when SNR is above 25, GNSS systems begin to use satellites. 

22. Weighted index 

The weighted index is used in the neighborhood adjustment calculation. The calculated distance 

from each new point to the control point, in the station establishment, will be weighted according to 

the weighted index when the coordinate adjustment applied to the new point is calculated. 

23. Pile distance/station distance. 

The distance or interval along a line, arc, or path. 

24. Projection 

Projection is used to produce a plane map that represents the surface of the earth, or that part of the 

surface. 

25. The ellipsoid 

The earth's mathematical model of the rotation of an ellipse around a short axis. 

26. Geodetic datum 

A mathematical model designed to fit some or all of the geoid surface (physical earth surface). 

27. Earth level 

It's very close to the universal gravitation of the sea’s surface. 

10.2 Troubleshooting 

1. The receiver keeps tracking but failed to give coordinates.  

Please try the possible solutions below:  

(1) Set up the receiver again in another place with much less electromagnetic wave interference (like 

a power station, radar station, etc..)  

(2) Set the working mode of the receiver to static, then collect static data for 3 – 5 min, then switch it 

back to the original model (base or rover) 

(3) Long press function button to reset motherboard, or restart the device.  

2. The base station failed to send correction signal. 

Please try the possible solutions below: 

(1) Replace the battery in case the battery power is too low (power LED will flash red)  

(2) Abnormal LED display in base mode 

a. Satellite LED flashing, means the receiver failed to track the satellites and the coordinates cannot 

be provided: 

The place where the base was set might be blocked by buildings or shelters and the useful  
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Satellites were less than 4. Find a better place to set up the station again.  

Coordinates provided by the base station are far from the actual coordinates; in this case, a re-

averaging of base coordinates is required.  

b. Satellite LED keeps on but the signal LED does not flash: this means the base does not transmit 

the correction signal. Please reset up the base.  

(3) Central meridian might be set with a mistake, double-check this parameter.  

(4) Reset motherboard, restart the device.  

3. Rover cannot receive signals even if it is very close to the external radio of the base station: 

(1) If the signal LED is not flashing, please refer to problem 2 (previous problem). 

(2) Transmitting LED RX/TX does not flash (flashes once every second in normal conditions)  

a. Check if the cable is connected firmly. 

b. Check if the cable is broken, try to replace the cable.  

c. Replace the power if the battery is too low.  

(3) Everything is alright with the base part but the rover signal LED does not flash. 

a. Make sure the radio channel and link rate are the same as the settings in the base.  

b. Internal radio module in rover is abnormal, try to replace it, or grade the firmware or restart the 

device.  

(4) Rover signal LED flashed but in the software, there is no common satellite number showing.  

a. Make sure the message types between base and rover are the same.  

b. Rover is severely interfered with and the common satellites‘ number is less than 4, so the number 

is not showing. On this occasion please go to an open-air area to set the rover.  

4. Short-range radio communication in external radio base mode. 

These are three possible reasons: 

(1) External battery power is too low to supply enough power to transmit the signal. Replace the 

battery. 

(2) The transmission method is not set to be external radio on the base station. 

(3) External radio abnormal. 

a. Power is set too low. 

b. The transmission antenna is not installed properly. 

c. The cable is not connected firmly.  

d. The antenna on the rover is not installed firmly or broken.  

(4) Strong interference in the base area. Try to change the channel or change the place to set up 

base 

5. Failed to connect to internet in internal GSM mode. 
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How to solve:  

(1) Cellular internet antenna is not installed or not installed firmly. 

(2) Internet setting incorrect (check the IP address, port, telecom operator, APN, CORS ID, and 

password, etc..)  

(3) SIM card problems 

a. Not installed properly, or the position is not matched to the pins, either too shallow or too deep. 

b. No balance in the SIM account.  

c. The band of the SIM card is not matching the band in the cellular modem. Try to use another SIM 

card from other telecom operators. 

(4) Cellular signal is weak in the region.  

(5) CORS server is not working properly. Try to use another device to test it.  

(6) Reset the device.  

6. ZHD Server connection failed. 

How to solve:  

(1) Check the IP, port, Area ID, Group ID, the message type is the same between base and rover.  

(2) Account or Group ID and Area ID occupied by other users. First come, first served.  

(3) Server abnormal. Please contact CORS service center for help.  

7. Rover failed to get signal from CORS. 

How to solve:  

(1) Signal LED flashing green, but failed to connect to server: 

a. SIM card issues (no balance, SIM card slot lose, band incompatible)； 

b. CORS parameters issues (IP, port, mount point, account ID and password, etc..)  

c. Contact the CORS service center for help if the above are checked and are ok. 

d. Internal cellular modem problem, try to reset or restart the device. 

(2) Signal LED stays green but failed to receive a correction signal.  

a. Check IP, port. 

b. Contact the CORS service center for help if the things above are checked.  

(3) Signal LED is green and flashes yellow every second, but no common satellites’ number shows.  

a. Check if the message type is correct 

b. Check if the GNSS signal is severely blocked or interfered.  

8. Bluetooth connection failed between controller and receiver  

How to solve： 
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(1) Check if the working mode of receiver is static; if yes, switch it back to  

base or rover mode; check if the 8-pin port of receiver is occupied or not. 

(2) Clear the Bluetooth search result list, search again and connect the device.  

(3) Either switch off and switch on the Bluetooth function or restart the device or controller.  

(4) Update the firmware of controller, or the firmware of receiver.  

9. Android controller cannot connect to PC (windows). 

How to solve: 

(1) Check if the driver was successfully installed or windows updated to the latest version. 

(2) Check if the anti-virus software blocks the connection due to its security. 

(3) Check if the USB debug function is activated. 

(4) Check the USB cable is not broken. 

10. Big coordinates difference after the Localization work (coordinate system parameters calculated)  

Possible reasons: 

(1) Accuracy is not good during the data sampling in the control point survey. 

(2) The control point is not distributed properly in the restion③Abnormal control point coordinates. 

How to solve: 

(1) Check the parameters result, if the scale is far from 1, then the control points might not be 

correctly input.  

(2) Check the distribution of the control points, they should not be so close to each other.  

(3) Try to delete the points whose RMS are bigger, if there are more than 3 control points. 

10.3 File Formats 

10.3.1 Road File 

[*. Dam] : parameter file. 

[*.prj] : engineering documents. 

[*.raw] : raw database file. 

[maincst.cst] : cross-section point library file. 

[*.mcp] : the graph root data file. 

[*.bak] : the back-up file will be automatically generated by the new project software if there is no 

external SD card. 

[ParamComputer] : apply the dot to the file. 

[*.rsp] : PPK time file. 

[*.ppk] : PPK post-processing file. 

[*.txt] : custom TXT file. 

[*.csv] : custom CSV file. 

[*.dxf] : DXF file. 

[*.shp] : SHP file. 

[*.csv] : Excel file. 

[*.dat] : Cass7.0, Scsg2000, and PREGEO data files. 

[*.stl] : Hi-RTK record point library file. 
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[*.line] : line library file. 

[*.sec] : line meta files. 

[*.PHI] : intersection file. 

[*.xy] : iron courtyard. 

[*.csv] : five pile files. 

[*.icd] : Elcad format. 

[*.zline] : coordinate method file. 

[*.pvi] : change the slope point file. 

[*.tpl] : cross section design line file. 

10.3.2 File Format Specification 

1. Intersection of road plane design line [*.PHI] 

PHI: Point of Horizontal Intersection. 

PHI file is stored in a text format, separated by a comma, and the first line is the format description 

[when the program reads it], starting from the second line, and behavior of the internode information; 

the storage format is: 

Intersection number, coordinate N, coordinate E, starting range, curve radius, forward detente curve, 

then detente curve 

※The sample: 

Intersection number, coordinate N, coordinate E, starting range, curve radius, forward detente curve, 

and then detente curve. 

1, 3361410.701, 524798.9388, 200000, 0, 0, 0 

2, 3361729.719, 516179.2477, 207750.218, 7000, 400, 400 

3, 3362156.214, 514352.2852, 209804.108, 7000, 400, 400 

4, 3363142.054, 511810.6419, 212590.856, 7000, 400, 400 

5, 3365587.828, 502113.9878, 222784.866, 10000, 270, 270 

2. Road plane line element file. [*.Sec] 

Sec: short for Section. 

Sec files are stored in text format, separated by commas. 

The first line is: the starting information format specification [skip] when the program is read. 

The second line is: the starting point of the line, including the starting point, starting distance, and 

starting point angle. 
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The third line is the line element format specification. 

The fourth line is: the beginning line is a line element information. 

Its storage format is: type, starting radius, end radius, line element length, deflection direction. 

Note: *. Type: straight line, arc, detente curve 

*. Radius: -1 represents infinity. 

*. Deflection direction: left L; Turn right R 

※The sample: 

X0, Y0, S0, Azi0 

3829469.058, 494798.067, 0, 1.67595677755068 

[Type{L, A, S}, R1, R2{-1=infinity}, Length, Direction{L，R}] 

L, -1, -1, 334.315, L 

S, -1, 300, 145, R 

A, 300, 300, 60, R 

S, 300, 90, 60, R 

A, 90, 90, 75, R 

3. Road longitudinal section changes the slope point file [*.PVI] 

PVI: short for Point of Vertical Intersection. 

PVI files are stored in text format, separated by commas. 

The first line is the format specification [skip] when the program is read. 

From the second row, the row is a slope point information; its storage format is: 

The slope of the slope is S, the elevation of the slope is H, the first slope is higher than i1, the 

second slope is i2, and the circle radius is R. 

※The sample 

S, H, i1, i2, R 

19653.349, 794.963, 0, 0.049, 0 

20070, 815.379, 0.049, 0.007, 12000 

22180, 830.155, 0.007, -0.025, 30000 
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23880, 787.655, -0.025, -0.014, 17000 

23974.007, 786.339, -0.014, 0, 0 

4. Road cross-section design line document [*.tpl] 

TPL: short for Template. 

The TPL files are stored in text format, separated by commas. 

The first line is the format specification [skip] when the program is read. 

The second behavior left design line. 

Third behavior right design line. 

Its storage format is: the left design line [distance, slope ratio]\r right design line [distance, slope 

ratio]. 

※The sample: 

Left design line [distance, slope ratio]\r right design line [distance, slope ratio] 

10, -0.1, 1, 0, 10, 1, 1, 0, 10, 1 

10, -0.1, 1, 0, 10, 1, 1, 0, 10, 1 

The cross-section point library (*.cst) can be opened directly with notepad, and the coordinate points 

of data exchange module can be exported *.csv, sample points, control points can be exported or 

imported *.txt format, which facilitates data exchange with the computer. 

(1) Export Excel file (*.csv) 

Roll call, N, E, Z, describe information 

4, 20.9919, 7.8963, -0.0147, Test 

(2) Sample library import/export Txt file (*.txt) 

Roll call, N, E, Z, description, set point range, whether it has been lifted (0: no, 1: yes) 

1, 2542604.5095, 434458.4638, 47.5900, Lk pile 1, 10.0000, 0 

22, 2542604.5062, 434458.4614, 45.4771, Street lamp, 30.0000, 1 

(3) Control point library import/export Txt file. (*.txt)  

Roll call, N, E, Z, description, coordinate type（0:blh，1:xyh）, B, L, H 

t, 2542604.2867, 434459.2702, 47.9231, control points A, 1, 22:58:52.51358, 113:21:38.93873, 

47.9231 
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uu, 2542604.5062, 434458.4614, 45.4771, Test, 1, 22:58:52.5206, 113:21:38.91030, 45.4771 

(4) Cross section point library format（*.cst） 

CrossSec points[Ver:1] 

E, N roll call, north coordinates, east coordinates, elevation plane Z, WGS84 latitude raw 

measurement data, B WGS84 longitude L raw measurement data, WGS84 raw measurement data 

height H, high target, high target type, the antenna type [manufacturer: type], north coordinate RMS 

values, East coordinates the RMS value, surface elevation RMS value, type, number of smooth, 

recording time, satellite altitude Angle, visible satellite number, Shared satellite number, PDOP value 

difference ages, set over, mileage (cross-sectional defined mileage), by collecting the real-time 

mileage by inverse calculation of coordinate, defined when mileage in the section of the pile point 

collection N coordinates, acquisition defined when mileage in the section of the pile point 

coordinates, E acquisition defined when the tangent of the transverse section is in the center of the 

road. 

pt0, 321.83562359172527, 75.99595486273756, -0.7214999980390115, 00:00:10.445790N, 

109:30:49.422520E, 0.0, 0.6096000000000044, 0, Hi-Target: V30, 0.014002636, 0.011343374, 

0.016180737, Single-point positioning, 1, 2013-10-08 15:07:16, 0, 19, 0, 1.7887421, 1.0, 

6.263659450178594E-5, 30.0, 31.30462646484375, 321.0, 75.0, 0.8726646259971647. 
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